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Module 1:
Introduction

Participant Information

As a user of the OCFS data warehouse, you will be responsible for interacting with various program and
system staff to implement and support desktop ad hoc reporting for your local district or agency. Your
responsibilities may include the following:

Working with agency or district staff to define data needs for ad hoc reporting;
Initiating and coordinating local efforts regarding data quality and data validation;
Implementing and utilizing the Cognos reporting tools — Impromptu and PowerPlay;

Generating predefined reports, modifying existing reports, and generating new reports from
the OCFS data warehouse;

Coordinating local efforts to schedule report generation;

Coordinating local efforts to distribute reports, including identifying appropriate personnel to
receive reports and physical distribution logistics;

Coordinating orientation and training of appropriate staff to generate reports and access the
OCFS data warehouse, where necessary;

Sharing results and issues with other report specialists across jurisdictions as part of a users’
group.

This guide provides basic step-by-step instructions for generating, modifying and creating reports from
the OCFS data warehouse.

OCFS Data Warehouse Reporting Page 11-1
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What is Cognos?

Cognos is the name of a software development company based in Canada. It is widely acknowledged to
be the leading provider of business intelligence applications. Business intelligence is the term given to a
category of applications and technologies for gathering, storing, sharing, analyzing, reporting and

providing access to data to help users make better decisions.

The Cognos suite of data query and analysis tools was selected to meet the specific reporting needs of
the local districts and voluntary agencies of the Office of Children and Family Services (OCFS). Cognos
was chosen because it provides flexibility and ease of use for non-technical users to generate, modify,
and create reports to support planning and operational needs. Cognos offers the same, or similar,
functions as the Microsoft Office suite of products, and so offers familiarity to computer users. It also
allows multiple users to access the same data source simultaneously. This allows flexibility for the local
districts and agencies to retrieve data when they need it. These user-friendly, flexible tools allow report
specialists to easily develop customized reports to meet the specific needs of their end users. Cognos
software runs on Citrix servers, requiring an extra login procedure and some preparation prior to

accessing the Data Warehouse.

Cognos

~

Impromptu PowerPlay
Catalogs (*.cat) PowerCubes (*.mdc)
h 4 ¥
Predefined User Reports {".imr) Predefined User Reports {".ppr)

What is the OCFS data warehouse?

The OCFS data warehouse is a collection of data retrieved from the
Connections and CCRS systems that users can access independently
of those production systems. The data from these two diverse
databases is organized and stored in the data warehouse. Data in the
OCFS Data Warehouse is available in a current point-in-time
snapshot. Trend or historical views are also available.

The OCFS data warehouse is refreshed, or updated, on a weekly
basis. Thus, every Monday the data reflects the state of the
Connections and CCRS systems as of the previous week. Any
changes made in either production system during the week will not be

The OCFS data warehouse is
a “read-only” file, which
means that users who access
the data cannot change the
data. The data can only be
read. Users can query and
analyze the data using the
Cognos tools, but they cannot
change the data in any way.

reflected in the data warehouse until the following week, after the regularly scheduled update. A
“Connections Data As Of Date” and a “CCRS Data As Of Date” have been made available in the data
warehouse that reflect the dates of the last update so that users can readily see the age of the data.

The OCFS data warehouse has been organized into four separate data marts. These data marts are
subsets of the larger data warehouse. The data marts are focused on a particular subject, as shown

below:
Page 11-2 OCFS Data Warehouse Reporting
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o The Investigations and Allegations data marts contain

information on Child Protective Services; More information on the data
warehouse can be found in
the manuals located in the
Public Folders in Microsoft

Outlook. Instructions for
accessing the Public Folders
relating to the data
warehouse can be found in
this guide.

o The Foster and Adoptive Home (FAD) data mart contains
information pertinent to certification dates and
demographics of the individuals in the homes; and

e The In Care data mart contains foster care and adoption
data on children who are in foster care, or have been
admitted or discharged from foster care.

The purpose of the data marts is to continue the structuring and organization of the data in ways that are
meaningful to users and to extract more efficiently data for analysis. The data marts are the data sources
for all catalogs that, in turn, are used for all cubes and predefined report creation.

The Content of This Guide

This step-by-step guide covers ad hoc reporting from the OCFS data warehouse using Cognos
Impromptu. A separate step-by-step guide covers ad hoc reporting from the OCFS data warehouse using
Cognos PowerPlay. It is expected that users will have basic computer skills, including Windows point-
and-click, navigation, scrolling, etc. Major objectives addressed include accessing, modifying, and
managing predefined PowerPlay and Impromptu reports, as well as creating new reports in Impromptu.
The material presented in the step-by-step guide reflects data in the OCFS data warehouse. Overviews of
the OCFS data warehouse and Cognos, as well as a discussion of where to go for additional help, are
also presented.

There are three appendices (Appendix A, B, and C) to this guide that contain more detailed information
about the various reports, cubes and catalogs that have been made available to you. These appendices
describe in more detail the New York State data you will be using. References to these appendices will be
made in the appropriate modules of the guide. A glossary of OCFS data warehouse and Cognos terms is
also a feature of this guide and can be found in Appendix C. Please refer to this glossary when you need
a more complete definition of any terms used in this guide.

The OCFS Training Database

It is not feasible to use the real OCFS Data Warehouse for training purposes, since that would breach
confidentiality standards. However, it is very beneficial for potential users to learn the Cognos tools using
data that is familiar to them. For this purpose, the OCFS Data Warehouse Team has designed a training
data warehouse that represents the same kind of data you will see in the real OCFS data warehouse.

The training database is available on a Citrix network server on the Z: Drive for you to practice your skills
and to try out new reporting techniques. You must login to Citrix to access the Training Database, just as
you would access the production Data Warehouse database. The Training Database can be accessed
with the Cognos User ID “train01” and the Password “train01.”

The material presented in the OCFS Class Manual is based on data in the OCFS Training Database.

Logging into Citrix

Instructions for logging in to Citrix to access the Cognos tools are as follows:

a1
1 Double click the Internet Explorer icon on your desktop.
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Click the Favorites button on the Internet Explorer menu bar. | E7 vl

Select “Data Warehouse Login” from the drop down-list and continue to step 10.

If “Data Warehouse Login” is not listed on the drop-down list, continue with step 5.

a ~h WO DN

In the Address line at the top of the Internet Explorer screen, type
http://OCEFSDATAWAREHOUSE.

| Address | hitp://OCFSDATAWAREHOUSE

@GD

6 Click the Go button to the right of the Address box and wait for the page to load.

7 Click the Favorites button on the Internet Explorer menu bar and select Add to favorites
from the drop-down list.

8 In the Add Favorite dialog box, type “Data Warehouse Login” in the Name field.

Add Favarite i 2 x|
= Inbeinet E il acd thi [ Fervenbes ksl
5 I et Enplocer wil & 5 pane o wour Favos
[~ Make available offine I | Carced I

MName: ||:| ha waehouse Logn Craabe in > I

9 Click OK on the Add Favorite dialog box.

10 Enter your NT Username, Password, and Domain in the OCFS Data Warehouse login
dialog box.

OCFS Data Warehouse - Please enter your NT password

Username ||

Passwurdl

Domain [HSEN

11 Click the Logon button at the bottom of the dialog box.

12 Click OK on the Confidential Warning screen.
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4 W AR NING #4#

WWarning: Thiz spstem and all data accessed through it are confidential and
proprietary to the State of Mew York,access is limited to autharized employess
and legally designated agents and only for authorized purpozes. Alzothese
systems access data maintained by other government groups, access thereto
must also be authorized. Unauthorized access to or releasze of State of Mew Yark
systems/data or other government data may result in civil iability and/or criminal
progecution. Any use of thiz spstem may be acceszed.read copied.and uzed for
any purpose the State of Mew York deems proper - users have no expectation of
privacy. Use of the syztem,whether authorized or not,constitutes express consent
far the State of Mew Yark to intercept,copy,and reuse any material entered oh this
terminal. This naotice zhall not be interpreted to compramize the rights of nonuser
data zubjects.

13 The OCFS Data Warehouse welcome screen is displayed. To the left of the screen are icons
for PowerPlay, Impromptu, Cognos Cubes, and Training Database.

iffistart H =

14 Double click either the PowerPlay or the Impromptu icon to launch the application.

Cognos Common Logon

The Cognos Common Logon dialog box appears the first time you open any Cognos application
(Impromptu or PowerPlay). It requires you to enter a Cognos User ID and Password. When working in the
OCFS data warehouse, you will use the Cognos User ID and Password assigned to you by the OCFS
Data Warehouse Team. When working in the training database, you will use ‘train01’ for both the User ID
and Password. After inserting the appropriate User ID and Password and clicking the Log On button, a
key will be displayed in the lower right corner of your PC screen, signifying that you are logged into

Cognos. I

OCFS Data Warehouse Reporting Page 11-5
Impromptu Step-by-Step Guide rev 08/2004



It is not necessary to log off the Cognos Common Logon when you exit a Cognos application. You will be
automatically logged off when you exit the Citrix session. However, if you log on to the Training Database
using the ‘train01’ User ID and Password, you will remain logged on as such until you exit from Cognos
Common Logon and will only have access to training data. If you want to access your own “live” data, you
will need to exit Cognos Common Logon as “train01’ and log in with your own Cognos User ID and
Password.

1 Exit from any Cognos application that you may have open (Impromptu or PowerPlay).

2 Right click on the key in the lower right corner of your PC. =

3 Select Log Out from the drop-down list.

The next time you open a Cognos application (either Impromptu or PowerPlay), you will be prompted to
log into Cognos Common Logon. You can now enter your regular Cognos User ID and Password to
access your own “live” data.

Mapping Your T: Drive

If you wish to save any reports or files generated in the Citrix environment, you must save to the T: Drive.
In Citrix, the T: Drive is automatically mapped for you. In order to access the T: Drive from your local
Desktop, you must manually map to it. Since the location of the T: Drive can vary for different users, you
will be provided with the location of the T: Drive in Citrix (where it has already been mapped) that
corresponds to the login you are using. You must then map your PC to this location. This process must
be done once on each computer you will use to access Citrix.

Instructions for mapping your PC to the T: Drive are as follows:

1 In Citrix, hold down the Ctrl and Esc keys on your keyboard simultaneously to display the local
desktop Start bar.

F;
2 Click the Show Desktop button at the bottom of your PC to display your local desktop. hﬁ
Right click the My Computer icon on your desktop.

Select Map Network Drive... from the drop-down list.

5 In the Map Network Drive box, select the T: drive by clicking the drop-down arrow ﬂ to the right
of the Drive box. If the T: drive is already mapped elsewhere, leave the default selection in the
Drive: selection box.

Map Network Drive x|
Siindows can help you connect ko a shared network Folder

and assign a drive letter to the connection so that you can
\\ﬂ access the folder using My Computer,
]
et |

Specify the drive letter for the connection and the Folder
that ywou want ko conneck ko:

Drive: IT: j
Folder: | fnpcfsdalaavishare 3lan =|  Browse... |

Example: Yiserverishare

V¥ Reconnect at logon

Connect using a different user name.
Create a shorkcut ko & Web Folder or FTP site,

< Back I Finish I Cancel
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6 In the Path or Folder field, enter the path to your T: Drive that has been provided for you
(e.g., \fnpcfsOataavishare XX\userid)

7 Ensure that the Reconnect at Logon option in the middle of the Map Network Drive box is
selected.

8 Click Finish at the bottom of the Map Network Drive box.
9 Close the path directory widow by clicking the ‘X’ in the upper right corner of the box.

10 Close the My Computer window by clicking the ‘x’ in the upper right corner of the box.

Again, you only have to complete the above task one time. Once your PC is mapped to the T: Drive, you
will not have to map it again. If you move to another PC, you will have to repeat this process.
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Module 2:
Getting Started in Impromptu

What is Cognos Impromptu?

Impromptu is a user-friendly data query tool that allows the user easy access to a database while
shielding him/her from technical database terminology, connections, and structures. The user has the
ability to retrieve data directly from the database without needing to know how to program. The Microsoft
point-and-click methodology is the primary utility for creating Impromptu reports. Impromptu also offers
Microsoft-style formatting capabilities that enable the user to create presentation-style reports.

Access to data through Impromptu is achieved by the creation of catalogs. The catalog also presents data
to the user in language he/she can easily understand, instead of the technical terms used by the technical
database creators. Catalogs provide access to the entire Data Warehouse or data mart, rather than to a
selection of the data in summary form, such as in PowerPlay cubes.

Impromptu catalogs are comprised of folders, which relate to tables in a subject-specific data mart. The
brief descriptions to the right of each folder give an indication as to what kind of data each folder contains.
To view the contents of a folder, click the [+ to the left of it. Generally speaking, you will see FACT folders
and DIMENSION folders in each catalog. The FACT folders will contain actual facts or occurrences—CPS
reports, allegations, resources, etc. The DIMENSION folders contain descriptive data about the facts. For
example, the Foster Home Fact folder contains many codes and ID numbers, such as Worker ID, County
Code, Agency ID, and Race Code. The DIMENSION folders contain descriptive data that describe the
codes (e.g., Worker ID from the Fact folder, plus Worker Name from the Worker Dimension folder,

provide the Worker's Name). So, you will always want to start from the FACT folder and retrieve
descriptive data from the DIMENSION folders.

Each folder will contain data items that have been arranged in a logical order for your reporting needs.
For example, the Allegation catalog contains a folder entitled “Child Dimension®. This folder contains all
the data fields related to alleged victims of child abuse, such as, Child Person ID, Victim Age in Years,
Gender Code, Birth Date, First Name, etc. There are also folders containing information on actual
allegation facts, subjects, workers and geography, all of which relate to Allegations.

Impromptu and PowerPlay differ in several respects. Impromptu is a query tool that retrieves data directly
from a catalog based on the user’s specific requests. PowerPlay is a data analysis tool that allows the
user to explore data that has already been predefined and summarized in a cube. Impromptu catalogs
allow access to all of the data while PowerPlay cubes present specific data in a summarized format.

The OCFS Data Warehouse Team has created several catalogs for your use. These catalogs are
described and more specifically defined in Appendix A.
Accessing Impromptu

Impromptu software runs on a Citrix server. Mapping your PC to the T: Drive and logging into the server
are the only steps necessary to begin. Once you have successfully logged into Citrix, you can open the
Impromptu application.

If you are logged into Citrix

for 30 minutes without any

activity, you will be logged

out and work you have not
saved will be lost. Any

keystroke or movement of the
mouse will reset the 30-
minute timer.

P |
1 Double click the Internet Explorer icon on your desktop.

2 Click the Favorites button on the Internet Browser toolbar and
select “Data Warehouse Login“ from the drop-down listing.

Note: If “Data Warehouse Login” does not appear on the
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Favorites listing, do the following:

e Type the following in the Address line: “http://OCFSDATAWAREHOUSE".

J.ﬁ.ddress I https fiocFsdatawarehouse

e
e  Click the “Go” button and wait for the Login page to Ioad.M

e Click the Favorites button on the toolbar.

o Select “Add to Favorites” from the drop-down menu.

o Type “Data Warehouse Login” in the “Name:” field of the Add to Favorites dialog box.

e Click OK.
Add Favorite it B>
;E I Inteimet Explover will add bhis page la your Favoebes ki,
[T Make available offine Ushormize | Cancel I

Mame: |Da,a wanshouse Logn Craghe in »» I

3 Enter your NT User ID, Password and Domain in the OCFS Data Warehouse login dialog box.

QCF$S Data Warehouse - Please enter your NT password

Username||

Paswurdl

Domain [HSEN

5 Click Logon.
6 Click OK on the Confidential Warning Screen.

7 Double click the Impromptu Icon to launch the application.
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Module 3:
Using Predefined Impromptu Reports

While the Impromptu tool offers you the ability to create presentation-quality ad hoc reports, several
standard reports have already been created for your use. The Management Reporting Workgroup defined
these reports as reports that would be helpful at both a management and supervisor/worker level. As
noted previously, these reports will display only the data that is applicable to you; i.e., for your local
district or agency. These reports are available to you in the Data Warehouse folders on the Data
Warehouse Network Server, as illustrated below:

Desktop
OCFS Datawarehouse
DataWarehouse
Pre-defined User Reports

Each of these reports is described in detail in Appendix B at the end of this manual.

Opening Predefined Reports

Once you have reviewed the available report descriptions and have determined which ones you will need
to see on a regular basis, you can open the report from the Data Warehouse folder on the Data
Warehouse Network Server.

1 Login to Citrix. See Module 1 for detailed instructions on the login process.

2 Double click the Impromptu icon on the left-hand side of the Citrix screen. Imor

Click File > Open on the menu bar OR click the Open button on the toolbar. H

4 In the Open dialog box, open the file directory listing by clicking the =] arrow to the right of the
Look in box.

5 Navigate to the Pre-defined User Reports folder as follows:
& Desktop
& OCFS Datawarehouse
& DataWarehouse

& Pre-defined User Reports

6 Open any of the folders ending in “Impromptu” by double clicking on it.
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Open [ 2]

& [E £ B2 £dd to FastFind |

Laoak in: Ia Pre-defined User Reports

[:I Adoption PIP - Impromphu AD- Inpromptu FastFind |
|1 Allegations- Power Play [C3 trvestigations-Power Play

D B18 Conversion Clean Up - Impromplu D Security - Impromptu ¥/ Preview

[:I CCRS Reports - Imprampky D Yacancy Contral - Inpromptu

DCFSR Program Improvement Plan
|_1 Cansolidated Investigations

1] | i
File name: I Open I
Filez of type: I Reparts [*.IMR] j Cancel |

= Filter by catalog
I Open Scheduler

v
7 Select a report from the listing and double click on it to open it.
Open E
Look i Ia Fre-Defined Uzer Reports j =] fj( v Add to FastFind |
50 1Closed Facilty Report,imr EastFind |
5 Facility Detail Report.imr
5 Facility Summary List Report.imr V' Preview
',ﬂ Foster Home Reauthorization Coming Due.imr
File name: | Open I
Files of type: | Reports [*IMR) =] Cancel |
I | Filter by zatalog
™ Open Scheduler
v

8 A message screen will pop up notifying you that this report is read-only and that a copy will be
made. This is a security measure to prevent users from changing the user reports. Click OK.

Impromptu

@ This repart is locked by another user or is read only, A copy will be made,

9 The Cognos Common Logon box will appear if you have not previously logged into a Cognos
application. Enter your Cognos User ID and Password in the boxes provided. Click the Log On
button.
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Cognos Common Logon: default

Enler & uger ID snd passweed thal i valid for Cogros products,

Liges ID:

Pazzweard:

Log On Canced

In most cases, the requested report will not display immediately on your screen. Depending on the
complexity of the report, it can take several minutes to run. You will see, at the bottom of the report

screen in the status bar, a fish );' that appears to be swimming back and forth. This indicates that
Impromptu is working on your report and is retrieving the data you requested.

Completing Prompts

Some Impromptu reports have been designed to run based on user-specific parameters. In other words,
you decide what information you want to see in the report. Most of the prompted reports ask for date
ranges within which to select information. For example, the Foster Home Reauthorization Coming Due
report asks users to enter a date. The report then retieves data on foster homes that are up for
reauthorization based on that datePrompts have the effect of customizing the report to user
specifications.

1 Login to Impromptu if you have not already done so.

2 Open a predefined Impromptu report with prompts (i.e., Foster Home Reauthorization Coming
Due, In Care Summary Report).

Click OK on the “This report is read-only” message.

4 If the Cognos Common Logon dialog box displays, enter your Cognos User ID and Password in
the Cognos Common Logon dialog box.

5 A Prompt dialog box is displayed. The dialog box contains requests for information and text
boxes for you to enter the information. In most cases, these requests are for dates in a specific
format. Your cursor is placed inside the first text box. Enter the information in the same format as
displayed in the entry window (e.g., m/dd/yy, yyyy-mm-dd), and then click OK.

Prompts ﬂ E

Enter the end date of the period for which pou want this report 0K I
2 | Cancel |

6 The report, filtered according to the date(s) you entered, is displayed on the screen. The prompt
information that you entered should appear in the title of the report.
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7 If you wish to see the report run based on another date, run the prompt again by selecting the

Prompt buttonﬁl from the Impromptu toolbar. The Prompt dialog box will appear again. You can
enter new dates and click OK to run the report on different parameters.

The Impromptu Report Screen

Menu Bar

As you familiarize yourself with the Impromptu environment, it is important to note the basic components
of the interface screen. The Cognos Impromptu menu bar is located near the top of the screen, and
contains the familiar options of a Windows application (File, Edit, etc.). Additionally, there are other menu
options unique to Impromptu, such as Report and Catalog, which we will explain in more depth as we
explore modifying and creating reports in later modules.

E File Edit “iew Inseit Format Beport Catalog Tool: 'Window Help
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Toolbar

Immediately beneath the menu bar is a toolbar that provides quicker access to the available options.
These toolbar buttons are briefly explained below:

Standard Toolbar

(3

&

|

New — Creates a new report.

Open — Opens an existing report.

Close — Closes the active report.

Save — Saves the active report.

Print — Will print the displayed report. It
is not recommended that reports be
printed directly from Impromptu.

Print Preview — Displays the current
report as it will appear on the printed
page. It is not recommended that
reports be printed directly from
Impromptu.

Cut — Cuts the current selection and
saves it to the clipboard for pasting.

Copy — Copies the current selection to
the clipboard for pasting.

Paste — Pastes the selection from the
clipboard to the position of the cursor.

Undo — Clears the most recent action.

Data — Inserts a data field into the report
by bringing up the Query Dialog box.

Query Data — Brings up the Query
Dialog box.

Sort Ascending — Sorts the selected
column in ascending order.

B H

G = e

i

@

8

I
1

=

@

|

Total — Applies a total to the selected
column.

Count — Applies a count summary on
selected data elements, excluding null
values.

Rank — Ranks the selected column
and assigns a rank order number.

Prompt — Calls the prompt, if
available, on the report.

Header — Inserts a header in the
selected Group.

Footer — Inserts a footer in the
selected Group.

Thumbnail — Creates a thumbnail, or
a temporary copy of a limited number
of rows from the report.

Snapshot — Creates a snapshot, or a
permanent copy of the data stored as
a part of the report.

Screen Help — Special point-and-click
help feature.

Filter — Filters the report based on the
chosen criteria, or if nothing is
selected, will remove all filters from
the report.

Drill-Through — Where applicable,
drills through to another Impromptu
report.

Create PowerPlay PowerCube —
Opens PowerPlay Transformer for
PowerCube Creation (PowerPlay
functionality).

Group — Groups the selected column
by its unique values, or if nothing is
selected, will remove all grouping from
the report.
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Format Toolbar

| B Arial j Font — Drop-down box for font style on the selected values in the
report.
10 Font Size — Drop-down box for font size on the selected values in
the report.
[ ] vI Font Color — Drop-down box for font color on the selected values
in the report.
llilg Bold, Italic and Underline — Formatting options for the selected

values in the report.

=== Left, Center and Right Justification — Formatting options for the
selected values in the report.

EI Currency — Formats the selected numerical values to standard
currency format.
Borders — Adds a single-line border around the selected report

EI objects, or if nothing is selected, removes the border from the
report.

!I Pattern — Applies a pattern to the selected reports objects, or if

nothing is selected, removes the pattern from the report.

glg Zoom In and Out — On-screen viewing options for the report,
zooming in and out in 25% increments.

EI@I Whole Page and Page Width - Enlarges or reduces the view of
the report in the report window.

Status Bar

The status bar appears at the bottom of the Impromptu interface screen and delivers information about
the catalog the report is attached to. The status bar also displays information about a command or toolbar
button. In the case below, the user has the In Care Detail Catalog open. This is also where the fish will
swim as he retrieves data for your report, to let you know that the report is running.

|In Care Detail Catalog @

Getting Around in Impromptu Reports

Scrolling

Some predefined Impromptu reports cannot be fully displayed on a single screen. To view the report in its
entirety, you will need to scroll up, down, left and right. The vertical scrollbar is located at the far right of
the screen. The horizontal scrollbar is located at the bottom of the screen. There is also a set of “Next

Page” buttons at the top and/or bottom of the vertical EI |#] scrollbar and at the far right and/or left of the
horizontal scrollbar. Clicking these will advance you to the next page of the report.

Layout Views

Two different views are available in an Impromptu report. Screen Layout view should be used when you
are inserting graphics or comments, or for viewing screen-only reports. Page Layout view will reduce the
display of the report so that you will see the edges of the report, title, page numbers, and page headers
and footers. Page Layout will display the report, as it will look when printed. You can toggle between
these views by selecting View > Page Layout, or View > Screen Layout on the menu bar.
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Drilling Through to Other Reports

Some Impromptu reports have a feature called Drill-Through that allows you to drill through to another
Impromptu report to retrieve different information. For instance, the Facility Detail Report drills through to
the Facility Summary List Report, which provides summarized information on home members and
relationships. Drill through reports are linked to their “parent” report through one of the data items on the
parent report. These linking data items are highlighted in color on the parent report. The Facility Detail
Report is linked to the Facility Summary List Report via Agency Code. Agency Code is highlighted in blue
on the Facility Detail Report. When you drill through to another report, you will see information for only the
specific data item that you drilled-through on (e.g., if you drill through on Agency Code 700, you will see
details on only Agency 700).

To quickly see if the current report has a drill-through report linked to it, follow these steps:

1
2

Press Esc to clear any selections in the report.

Click and hold the Drill-Through button El on the toolbar. If there are drill-through links in the
report, the linking data item will be highlighted. After you release the Drill-Through button, the
highlights will disappear.

If there are no drill-throughs on the report, a Drill-Through Properties dialog box will appear.
Click Cancel at the bottom of the box.

Drill Through Properties 2 x|
Report nare:
IHeportS
Dirill through link:
3 PReport Columnz - Add... |
] Max Male Age Month Mumber - |
] Min Female Age Year Mumber - | Edit |
] Masimun Female Age Month Nu
o [ Max Femnale Age ear Mumber - Fiemove |
[ Max Female Age- Month Numb,
[ Unavailable Number - Home Fac
- [ Capacity Murnber - Home Fact
[ Home Authorized To D ate
- [] Cument Period Certification Date
[ Lewvel Of Care Test - Home Fact ¥
< | »
Cancel

To Drill-Through in the report

1

Select a value that was highlighted in Step 2 above or select a value that is already highlighted on
the report (e.g.,, Agency Code on the Facility Detail Report). You must select the specific item
that you want to see. In other words, if you select Agency Code 700, you will drill through to the
details for Agency 700. You will get details for no other Agency Code.

Click the Drill-Through button on the toolbar OR double click on the selected data item. The
Drill-Through report will appear, with its information filtered based on the selection in the parent
report.

Closing Reports and Exiting Impromptu

1

On the menu bar at the top of the screen, click File > Close.

2 A dialog box appears asking if you want to save changes to the report. Click No.
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3 The report closes.

Note: If you are intending to open other predefined Impromptu reports, you must also close the catalog
that was opened with your original predefined report. Otherwise, Impromptu will try to run the second
requested report against the catalog opened for the first requested report. You will get query execution
errors if you attempt to run a report against the wrong catalog.

To Close an Impromptu Catalog

4 On the menu bar, click Catalog.
5 Select Close from the drop-down list.

Now you can open other predefined Impromptu reports. Impromptu will automatically open the catalog to
which the report is linked.

To Close Impromptu
6 Click File > Exit from the menu bar.
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Module 4:
Modifying Impromptu Predefined Reports

Within predefined reports, you may want to make certain modifications to customize the report to fit your
needs. Although the official predefined reports cannot be changed in any way, the same reports exist in
the Predefined User Reports folder. The predefined reports are built against shared catalogs, which allow
users to make modifications to them.

Some of the modifications that can be achieved are sorting and grouping data differently, filtering out
unnecessary information, or changing titles. We will be using buttons on the toolbar as well as the Report
Query dialog box to modify the predefined reports. The Report Query contains all of the information used
to retrieve, sort, group, calculate, and filter data for a report.

Opening Impromptu Predefined Reports

1 Login to Citrix. See Module 1 for detailed instructions on the login process.

3\

Double click the Impromptu icon on the Citrix desktop to open the application. impne

Click the Open button on the toolbar E OR select File > Open on the menu bar.
In the Open dialog box, click the arrow v|to the right of the Look in window
Select Desktop from the drop-down listing.

Double click OCFS Datawarehouse in the directory window.

Double click DataWarehouse in the directory window.

0 N 6o g A~ W DN

Open the Pre-defined User Reports folder.

9 Open any of the folders ending in “Impromptu” by double clicking on it

Open [ 2]

Laoak in: Ia Pre-defined Uzer Reports j <= |‘=ji Ef- Add to FastFind |
T O —————— 5. Impromptu] easig

Irnprompku

| Allegations- Power Play = Investigations-Power Play
D B18 Conversion Clean Up - Impromplu D Security - Impromptu ¥/ Preview
[:I CCRS Reports - Imprampky [:I Yacancy Contral - Inpromptu

DCFSR Program Improvement Plan
|_1 cansolidated Investigations

| | ol

File narne; | Open I
Files of type: IHeports [*.IMR] j Cancel |

= Filter by catalog
I Open Scheduler

2|

10 Open a report from the report listing by selecting it and clicking the Open button.
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Open HE

Look i Ia Pre-Defined User Reparts j B ﬁ Ef- Jecitte Festhind |
i [Clnsed Padiity Report, imr; EastFind |
15 Facilicy Detail Report.imr

',ﬂ Faciliy Summary Lisk Report.imr I Breview
',ﬂ Foster Home Reauthorization Coming Due.imr

File: name: I Dpen I
Files of vpe: IHeports [*IMR] j Cancel |

™| Filter by catalog
™ Open Scheduler

2

11 Click OK at the message notifying you that the file is read-only and that a copy will be made.
Impromptu

@ This repart is locked by another user ar is read only, A copy will be made.

Adding and Deleting Data
Additional data items can be inserted to a predefined report and irrelevant data can be removed.

To add data to a predefined report:
1 Select Insert = Data on the menu bar.

b
2 Your cursor now appears as E . Place your cursor on the report where you want the new
data item to appear. If you want the new data item to appear as a column, place it in between two
existing columns. When a double dotted vertical line (::) appears between the two columns, click
your mouse button. If you want the new data item to appear in a title or header frame, place your
cursor inside the frame. When a small quote mark (‘) appears in the frame where you want the
data item placed, click your mouse button.

3 The Query Data dialog box appears. You can select any data item in any of the folders appearing
in the Catalog listing on the left-hand side of the screen.

e Open a folder by clicking the [+| to the left of the folder.

e Add the data item by double clicking on it, OR highlighting it and clicking the

:button in the center of the dialog box, OR clicking and dragging it to the Query
data listing on the right-hand side of the box.

4 Click OK at the bottom of the Query dialog box.

To delete data from a predefined report:
1 Select any value on the report you wish to delete.

2 Press the Delete key on your keyboard.

Deleting an item from a report does not delete it from the query. The data item remains in the Query
dialog box until you remove it. Thus, the data item will be retrieved every time the query is run (or the
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report is executed), it just won'’t be reported. This could extend your processing time, so to be more
efficient, the data items which you do not want in your report should be removed from the query.

To remove data from a query:

1 Retrieve the Query dialog box by selecting Report = Query on Note:
the menu bar OR clicking the Query Data button on the toolbar. .
il | If at any time a command

does not appear to have
executed (adding/deleting
data, grouping/ungrouping
data, sorting/unsorting data,

Press the Delete key on your keyboard. filters, etc.), select Report >
Retrieve on the menu bar.

2 Highlight the data item you wish to remove in the Query data
listing on the right side of the dialog box.

Click the OK button at the bottom of the Query dialog box.

Sorting Data

Data in Impromptu is organized into folders. The brief descriptions to the right of each folder give an
indication as to what kind of data each folder contains. To view the contents of a folder, click the [+ to the
left of it. Generally speaking, you will see FACT folders and DIMENSION folders in each catalog. The
FACT folders will contain actual facts or occurrences—CPS reports, allegations, resources, etc. The
DIMENSION folders contain descriptive data about the facts. For example, the Foster Home Fact folder
contains many codes and ID numbers, such as Worker ID, County Code, Agency ID, and Race Code.
The DIMENSION folders contain descriptive data that describe the codes (e.g.,, Worker ID from the Fact
folder, plus Worker Name from the Worker Dimension folder, provide the Worker's Name).

Sorting data in the report is limited to either an ascending or descending display of numeric or text data in
the report. Most predefined Impromptu reports have already been sorted based on the most logical data
items. You may wish to change the sort order in some reports to better suit your needs. There is a Sort
button on the toolbar and a Sort tab in the Query dialog box to facilitate this process.

To sort data in the report
1 Open an Impromptu predefined report.

2 From the menu at the top of the screen, select Report > Query. The Query Dialog box will
appear, opened to the Data tab.

Query (2]}
Data |Sort I Groupl Filter I Accessl Profilel CIient.-"ServerI
Luery data:
ERGRE - i Horne . R o B UnitCd N
D Foster Home Race & Ethnicity Falder | i B worker Nm
{:I Faoster Home Agency Folder ﬂ ----- ] Resource Id
D Foster Home Sub Agency Folder = | i 3 Home Nm
{:I Home Member Folder g count [ Resource |d | [for Agency Code
D Home Mermber Racial Folder & | i B Member Nm
@1 Foster Child Folder | T | e B Role Tat
D Child Placement Agency Folder | i 3 Relation Tt
- Worker Folder g ----- B Status Tt
D “Worker Agency Folder 1 —— | i 3 Card Sent Dt
{:I Geography Folder | i 0 Card Recwd Dt
B0 DatadsOfFalder | B Cent Dt
ﬂ ----- 0 Auth Ta Dt
P o e DETIE hd
| | a
Bt [YEfimitio.. |
Data zource:
IEatang vl Brawse.. Build Crosstab | Ik fanlhsertian |
ITI Cancel |
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3 Click the Sort tab. The Sort Order box displays all the data items in the report in their sort order.
The first item on the list will have the highest sort priority; the second item will have the next
highest priority, and so on.

Query [2]x]
Data  Sort |Gr0up| Filker I Accessl F‘rofilel CIient.-"ServerI

(7]
[=]}

= & =

=

& Agency Code - Worker Dimension

E  Agency Hm

& 0Office Mame

& UnitCd

B worker Nm

E FResourceld

& Setting - Foster Home

& Status Tst

& HomeNm

& CetDt —

E AuthToDt

= Raole Tst

& CardSent Dt
Relation Txt

E nnnnn t [ Pesnores 141 LI
[ St Lzeending Descending |

(] I Cancel

4 Select one or more data items from the Sort Order box.

Click the Ascending or Descending buttons to specify the sort order. A small ascending & or
descending = icon appears inside the data icon of the item you have sorted.

6 Click the Don’t Sort button to remove the sort from a data item. Note: Impromptu sorts
grouped data by default (see Grouping Data). You must remove grouping before you can
remove sorting.

7 You can change the sort order of the data items in the Sort Order box by selecting an item, and
dragging it above where you wish it to reside in the sort order.

8 Click OK to close the Query Dialog box and resort the report.

To quickly sort the report on a data item using the toolbar
1 Inthe report, select an item in the column you wish to sort.

2 Click the Sort ﬂl button from the toolbar.

3 The report will add an ascending sort on the column you selected.

To quickly remove the sorts on a report
1 Inthe report, press the Esc key on your keyboard to clear any selections.

2 Click the Sort button from the toolbar. ﬂl
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3 A message box displays warning that “All sort items will be deleted.” Click Yes, and the sorts will
be removed. Note: Impromptu sorts grouped data by default (see Grouping Data). You must
remove grouping before you can remove sorting.

Grouping Data

Grouping data in Impromptu serves to bring all like data together on the report. You can choose to group
your data on any data item in your report. For example, if you have a list of CPS reports and want to see
them by worker, you can group them by Worker ID. The report will then be reformatted where the Worker
ID would be displayed only once, with all the CPS report records related to it displayed next to the Worker
ID. A line, or break, would appear before the next Worker ID and his/her CPS report records. There is a
Group button on the toolbar and a Group tab in the Query dialog box to facilitate this process. Most
predefined Impromptu reports have been grouped based on the most logical data items. However, you
can change the grouping if you think it necessary.

To change grouping
Open an Impromptu predefined report. (Follow the steps in Module 3 for Opening Predefined
Reports.)

2 From the Report menu, click Query. The Query Dialog box will appear. Select the Group tab.

3 The Group Order box displays all the data items in the report in their group order. The first data
item on the list will be the one with the highest group priority; the second item will have the next
highest priority, and so on. Select one or more data items you want to group.

4 Click the Group button. A black bar B will appear at the top of the data icon indicating those
data elements that are grouped.

5 Click the Ungroup button to remove the grouping on a data item.

6 You can change the group order of the data items in the Group Order box by selecting an item,
and dragging it above where you wish it to reside in the group order.

7 Click OK to close the Query Dialog box and display the report.

To quickly group the report using the toolbar
1 Select a data item from one or more columns (it is not necessary to select more than one data
item from a single column). The order in which you select the data item will determine the group
order.

2 Click the Group EI button on the toolbar.

3 The report will display the selected column(s) grouped in the order you selected them.

To quickly remove grouping from a report
1 Inthe report, press the Esc key on your keyboard to clear any selections.

2 Click the Group button from the toolbar.ﬂl
3 A message box will display the words “All grouped data will be ungrouped.” Click Yes, and all
grouping will be removed.
Associating Data

You can associate a data item to a grouped data item to eliminate duplicate information in the report as
long as it has a one-to-one relationship with the grouped data item. “Associating” data means linking it to
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a grouped data item. When you group data, the values for the grouped item are displayed only once. The
records associated to the grouped item follow. Other data items, however, may repeat in the listing
because they are related one-to-one to the grouped item. As in the above example, if you have Worker 1D
and Worker Name in your report and you grouped by Worker ID, Worker Name would be repeated for
every CPS report record. To eliminate this repetition, you can associate Worker Name with Worker ID.

To associate data
1 From the menu at the top of the screen, select Report >

Query. The Query dialog box appears. Note:
. It should be noted that
lick the Gr: . . .
Click the G oup tab Impromptu Issues no warning
Select the data element you want to associate to a grouped if the d?ta item an_d tI'!e.
data element grouped item to which it is
associated do not share a
Query 7] %] true one-to-one relationship.
Data I Sart Group |Filter I Accessl F'mfilel CIientJServelI In the event that a One-tO-One
I Autooroup relationship does not exist,
Group grder: data will be missing from the
[ Agency Code - worker = repOrt.
[ Agency Code-Foster Home
[  Agency Code - worker Dimension
1 count [ Resource Id ) [for Agency Code - Wworker Dimension]
[ Agency Mm
[ Office Name
0O Unitcd
[ worker Nm
[ Resource Id
[ Setting - Foster Home |
[ Status Tut
[ HomeNm
[ CerDt
[ AuthToDt
[t =rber Mrn j
Group Agsociate
oea|

4 Click the Associate button. A black-and-white bar £ appears inside the data icon of the
selected data element.

5 Click OK to close the Query dialog box and associate data in the report.
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Changing Report Filters

A filter is a method of narrowing the results of a report to only that information that is relevant to you.
“Filter” is Impromptu’s term for the parameter or scope of your report. A filter specifies the conditions that
must be met for data to be included in the report. By limiting information to a subset of the available data,
a filter emphasizes the information that is important to you. Filters serve to focus a report and to minimize
processing time by excluding any data that is irrelevant to the report. For example, you can filter a report
on Foster Homes to show only those that have been accepted and are active. Filters can be done directly
on the report workspace by using the Filter button on the toolbar. There is also a Filter tab on the Query
dialog box that can be used to build more complex filters. All predefined Impromptu reports have been
filtered, but you can filter, or focus, them further if required.

To filter data in the report using the toolbar button
1 Select one or more values in the report you wish to filter on.

2 Click the Filter ?I button on the toolbar.

3 The report displays filtered data, based on the values you selected.

To quickly filter using the drop-down filter menu
1 Select one or more values in a column.

2 Click the drop-down arrow next to the Filter button on the toolbar. ilj A drop-down menu
appears.

|z [-FA-|®

Mat in

3
3
Bebween 3
3

Mok betwesn

<= 4 String. ..
) oy Select Walues. ..
Filter Definition. ..

3 Select an operator from the drop-down menu. The operators available are as follows:

In — Retrieves records with values equal to any value in an entered list of values.
Not In — Retrieves records with values not included in an entered list of values.
Between — Retrieves records with values inside a range of entered values.

Not Between — Retrieves records with values outside a range of entered values.
= (Equals) — Retrieves records with the same value as the entered value.

<> (Not Equal to) — Retrieves records with any value except the entered value.
< (Less than) — Retrieves records with values less than the entered value.

<= (Less than or equal to) — Retrieves records with values less than or equal to the entered
value.

> (Greater than) — Retrieves records with values greater than the entered value.

>= (Greater than or equal to) - Retrieves records with values greater than or equal to the
entered value.
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4 Point to the arrow that appears to the right of the operator to display a fly-out menu. From this fly-
out menu, select one of the following based on your filter preferences:

Selection — To filter on the value or values you have selected in the report. The report will
automatically be displayed.

Number - To enter one or more numbers on which to filter. The Enter Values dialog box will
appear.

String — To enter a text string on which to filter. The Enter Values dialog box will appear.

o Date — To enter a date expression on which to filter. The Enter Values dialog box will
appear.

e Time — To enter a time expression on which to filter. The Enter Values dialog box will
appear.

o Date-Time — To enter a date-time expression on which to filter. The Enter Values dialog box
will appear.

o Interval — To enter an interval on which to filter. The Enter Values dialog box will appear.
Entes Valoes _________________________KE|

[Gutieg Tat v
Emder ore o mode dhiegs, ach on & sepaale e

+ To complete the Enter Values dialog box, enter the value or values you wish to use
as your filter in the exact format as they appear in the database (e.g.,, if a value is in
all caps in the database, it must be entered here in all caps). Click OK when you have
completed entering values.

Select Values — To filter on your choice of a list of values that appear in the selected column in
the report. A Select Values dialog box appears.

Select Values HE

[emraTam
Sedect ore ol moes vakes Wik pelechad
Frester Home: = |

Juniqua vakaas [of Setting T 1 walues selacied,
All walues have been setrieved

e | [Tk ]  coma |
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+ To complete the Select Values dialog, select the value or values you wish to use as
your filter from the Select one or more values listing on the left side of the dialog box.
The value(s) that you highlight will appear in the Values selected window on the right
side of the dialog box. Click OK when you have completed making your selections.

Other methods of filtering are available from the Report > Query - Filter tab. These methods are
covered in Module 6: Using the Impromptu Report Query of this guide.

Changing Report and Column Titles

To change the titles that appear in the report:

1
2

3
4
5

Right-click on the column or report title.

Select Edit from the pop-up menu that appears.
Delete the existing title.

Type in the new title you wish to appear.

When you are finished, press the Esc key on your keyboard to take the focus off the title.

Saving Modified Reports

1
2

© 00 N o a0 ~ W

On the menu bar at the top of the screen, click File > Save As.

The Save As dialog box appears. Since you cannot save your modified report over the original
predefined report, you will need to save the report to your T: Drive (My Home Drive (T:)). Open

the directory listing by clicking the arrow | to the right of the Save in window.
Select Desktop from the directory listing.

Select T:\ Drive from the directory listing.

Select My Home Drive (T:) from the directory listing and open an appropriate folder.
Click the Save button. You are returned to the report.

Select File > Close on the menu bar to close the Impromptu report.

Select Catalog - Close on the menu bar to close the Impromptu catalog.

To exit Impromptu and return to the Citrix desktop, select File = Exit on the menu bar.

OCFS Data Warehouse Reporting Page 14-9
Impromptu Step-by-Step Guide rev 08/2004






Module 5:
Using the Impromptu Report Wizard

The Impromptu Report Wizard is a tool that facilitates the creation of simple list reports. It walks you
through each step of creating reports, from entering a title to filtering the data. There are some limitations
in using the Report Wizard; for example, you cannot filter the report using any other data than what you
have selected for your report. This module provides step-by-step instructions for creating a report using
the Report Wizard. Module 6 provides detailed instructions for creating reports using the Report Query
dialog box, which provides more flexibility and allows users to generate more complex reports.

Impromptu Catalogs

Before creating a new report or ad hoc query in Impromptu, you must first determine which catalog you
will need to access. As discussed previously, a catalog represents your gateway to the database in
Impromptu. Please refer to Module 2: Getting Started in Impromptu for more discussion on catalogs.

For security reasons, OCFS has chosen to use shared catalog types. Shared catalogs allow users to
create new reports and modify existing reports. Users are not able to modify the catalog itself. Shared
OCFS Catalogs are found in the Report Catalogs folder in the Data Warehouse.

Opening Catalogs

Double click on the Impromptu icon on the Citrix desktop to open the application. tnpronpty

2 Select Catalog > Open on the menu bar.

3 In the Open Catalog dialog box, click on the down arrow | to the right of the Look in box to
open the directory selection list.

4 Select Desktop from the directory listing.

Open Catalog HE
Laok jr: | 2 T:\ Drive j = cF E3-

A Drive
ty Home Drive (T3]

Jr T THETIETT E_l FEPOTTTIOrar

[ ADOPTION 53 security

4 E18 Canversion Clean Up @Training Database

4] CFSR PIP E:I Yacancy Control

File name: | Open I
Files of type: IEatangs [*.CAT) ﬂ Cancel |
FastFind | fddtoFastFind |

&

5 Double click the OCFS Datawarehouse directory.
6 Open the DataWarehouse folder by double clicking it.

7 Open the Report Catalogs folder.

OCFS Data Warehouse Reporting Page 15-1
Impromptu Step-by-Step Guide rev 08/2004



Open Catalog HBE
Lok, jri Ia Repart Catalogs j & ck B

HEtcmissions Discharges| [Hlinvestigations Catalog

i Allegations Catalog [#l5econdary Assignments Catalog
5 AMS PIP [#0 Security

i Foster Home [l acancy Control History

il In Care Detail [ acancy Control

il In Care Summary

File narne; | Opeh I
Files of type: IEatangs[".Cﬂ.T] j Cancel |

FastFind | fddtoFastFind |
7

8 Select a catalog in the selection pane.
9 Click the Open button in the lower right corner of the Open Catalog dialog box.

10 If the Cognos Common Logon entry window appears, enter your Cognos User ID and
Password and click the Log On button

Cognos Common Logon: delaull [ =]

Erbes aueser ID and passwaord that is valid fior Cogros products.

User ID:
|

PBassword:

[logon ]| _ camcsl |

Creating a New Report

Once you’ve indicated that you want to create a new report and have opened a catalog, the Report
Wizard dialog box opens on your computer. If Impromptu has already been opened without the Report
Wizard, there are two ways to invoke the Report Wizard.

e You can click the New button on the toolbar O . The Open Catalog box will appear, and you
must select a catalog from which to create your report. If the Open Catalog box does not
appear, then you already have a report catalog open and ready to use.
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Open Catalog

HE

Laak jr: I 3 Report Catalogs

=i+ & ek E-

il Foster Home:

File name: | Open I
Files of type: ICalaIDgs [*.CAT) j Cancel
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In Care Detail
HilIn Care Summary

fiEadmissions Discharges [#illInvestigations Catalog
il Allegations Catalog [#ll5econdary Assignments Catalog
il AMS PIP [#l5ecurity

[#lvacancy Control History
[#lvacancy Contral

e You can select File > New on the menu bar, highlight the Simple List icon, and click the
Wizard button at the bottom right of the dialog box.

New [7]=]
FastFind |
[eo EE
=3
@ @ @ @ I |
Crasstab Form Letter Grouped  Grouped List Sel as Difault I
Crosstab
@ @ [V Preview
Mailing Labels Stored Blank
Procedure
i~ Create new
' Beport
 Template
Browse...
]
Cor | cofl | e
N

1 The Impromptu Report Wizard dialog box appears. The first task is to enter a title for your report.

This report title will appear in bold letters in a title text box at the top of your report.

e Enter a brief but descriptive report title, e.g., “FAD Test Report”.

e Click the Next button at the bottom right hand side of the dialog box.
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Impromptu Report Wizard ﬂ B |

Tupe the title of the repart.

< Type here to cug

Cancel | % Bach | Mext > I Eirirsty |

2 The second Report Wizard screen asks what kind of report you want to create. The default is a
List report, which means that a simple report format, with columns across the top and rows
along the sides, will be used. We will be confining our instructions in this module to the simple list
style reports. Make sure the List Report radio button is selected and click the Next button at the
bottom of the dialog box.

Impromptu Report Wizard ﬂ B |

What kind of report would vou like to create?

" Crogstab report

For a crosstab report, you need either a
crogstab template or a list termplate

Cancel | < Back | Mext » I Eirrsty |

3 The next Report Wizard screen is used to select the data for your report. There are brief
instructions at the top of the dialog box. On the left side of the box is a listing of all the folders in
the catalog headed Catalog. On the right side of the box is a blank pane headed Report
columns. In the middle of the screen are two buttons — |[Add 2| and Remove]. To select data for
your report:
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Impromptu Report Wizard

Double-click a catalog folder to open it. Select a column and click the Add button to add it to the report.

Catalog:

{:l Faster Home Fact

[ Foster Home gency Folder

{23 Foster Home Sub Agency Folder
{Z31 Home Member Folder

{231 Home Member R acial Folder
{21 Faster Child Falder

{231 Child Placement &gency Falder
[ “Worker Folder

[ Worker &gency Folder

] Geography Folder

- Data&s OF Folder

[ Foster Home Riace & Ethniciy Folder

Loy |
Eemayve |

Fiepoart calumns:

Cancel

| < Back I

[ |

Eirish |

Double click any catalog folder to open it or click the plus sign ( [+ ) next to any folder to

expand its contents.

Select a data item from the folder listing.

Click the button or double-click the data item.

The selected data item now appears in the Report columns listing. Repeat the above process
until you have completed your data selection. When you have finished selecting data, click

the Next button.

Impromptu Report Wizard

Double-click a catalog folder to open it. Select & column and click the Add button to add it to the report.

Catalog:

-9 Faster Home Fact o
..... ELE 2 |D-Foster Hame

----- 3 Facility ID-Foster Horne

----- 1 Home Mame - Foster Home

----- 3 Statuz of Horne - Foster Horme

----- 3 Setting - Foster Home

----- 3 Level OF Care - Foster Homme

----- [ Subigency Code - Foster Hame

----- 3 *waorker ID-Foster Home

----- 3 Home Stage ID-Foster Home

----- 3 Home Autharized To Date-Foste

----- 3 Current Periad Certification D ate-

----- [ Home Closed Date-Foster Home

----- [ Original Certification D ate-Faster | o
i — il

Report columns:

Add-»

Bemave

3 warker ID-Foster Horme

Cancel

< Back | Mext > I

Finizh
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4 The fourth Report Wizard screen is the Group selection
screen. Grouping data in an Impromptu report serves to bring
all like data together on the report. You can choose to group
your data on any data item in your report. For example, if you
have a list of CPS reports and want to see them by worker,
you can group them by Worker ID. The report will then be
reformatted where the Worker ID would be displayed only
once, with all the CPS report records related to it displayed
next to the Worker ID. A line, or break, would appear before
the next Worker ID and his/her CPS report records.

To select a column for grouping:

e Click in the box to the left of the column. A check
mark appears in the box. [

e Click the Next button.

Impromptu Report Wizard

' ear

Procuct

Sales

a4

Sunblock
Terts

a0
240

93

+

Sunblock
Terts

114
240

|
grouped
column

Note:

Beneath the Report columns
window of the group selection
Wizard screen is an option to
automatically generate totals.
The default for this option is
“On” (i.e., the box is checked).
If this option is left on,
Impromptu will automatically
total all numeric columns,
including ID columns (e.g.,
Resource ID, Worker ID). ltis
recommended that this option
be turned off.

Select each column vou want to group.

Grouping sorts data in the column and eliminates duplicates.

Beport columns:

K E

(vl arker ID-Foster Home

[ 1Reszource ID-Foster Home
[ 1Home Capacity Murnber-Fozter Home:
[ 1Unavailable Murnber-Fozter Home:

W Automatically generate totals

Cancel | < Back | Mext » I Finizh |

5 The filter Report Wizard screen appears. “Filter” is Impromptu’s term for the parameter or scope
of your report. By limiting information to a subset of the available data, a filter emphasizes the
information that is important to you. When constructed correctly, filters serve to focus a report and
to minimize processing time by excluding any data that are irrelevant to the report. For example,
you can filter a report based on specific Worker ID’s to show only those records related to those
workers. The purpose of the filter screen in the Report Wizard is to build a filter statement (or
definition) that specifies the conditions that must be met before data is included in your report.
This example specifies that the Worker ID must be either 140 or 197 in order for any data to be
included in the report. To build your filter definition:
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Impromptu Report Wizard
Select a report column, an operator, and one or more values to define a filker.
Filtering narrows wour report to the data vou require.

Ayailable components: Filter definition:
& and warker ID-Foster Home in [ 140,197 )l ;I

[

LClear |
Cancel | < Back | et | Finizh I

6 Select one of the Report Columns appearing on the left side of the screen (under Available
components) that you want to use to filter your report. For example, if you only wanted to see
records related to specific workers, you would be using the data item Worker ID in your filter.

7 Click the [2| button in the center of the screen to move the selected data item to the Filter
definition box. You can also double click the item to move it to the Filter definition box.

8 Now you need to select an appropriate operator for your filter. A filter operator specifies what
happens to the values on either side of the operator. In other words, how do you want to compare
values for the data item?

In — include records where this data item has any value in a given list of values (e.g.,
“Worker ID in (1234, 6789)” would retrieve records associated to both Worker 1234 and
Worker 6789).

Between — include records where this data item has a value in a given range (e.g., “Cert To
Date between 9-01-2001 and 9-30-2001” would retrieve records were the Certification To
Date was between September 1 and September 30, 2001).

Contains — include records where this data item has a value containing specific data (e.g.,,
“Last Name contains ‘SMI’” would retrieve all records where the data item Last Name
contained the letters SMI, such as SMITH).

= Equals - include records that have the same value as the given value (e.g., “Case ID =
SD1234562” would retrieve just that one case record).

<> Not equal to - include all records except those with the given value (e.g., Region <> ‘6’
would retrieve records for all regions except New York City).

< Less than —include all records where the data item has a value that is less than the given
value (e.g., “Intake Start Date < 1/01/2001” would retrieve all records that occurred prior to
January 1, 2001).

<= Less than or equal to — include all records where the data item has a value that is less
than or equal to the given value (e.g., “Min Female Yr Number <= 6” would retrieve records
of Foster Care facilities that would accept a female age 6 or younger).
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e > Greater than — include all records where the data item has a value that is greater than the
given value (e.g., “Investigation Close Date > 8/31/01”would retrieve CPS Reports with
close dates later than August 31, 2001).

o >= Greater than or equal to — include all records where the data item has a value that is
greater than or equal to the given value (e.g., “Max Male Yr Number >= 16” would retrieve
records of Foster Care facilities that would accept a male age 16 or older).

9 Select an appropriate filter operator from the list of Available components and click the
button in the middle of the Report Wizard screen. It now appears next to your data item in the
Filter definition box.

10 After you have selected your filter data item and filter operator, you can enter the value(s) for your
filter data item or select from a list of available values. Warning: The Select Values list will
contain a maximum of 100 values, which in most cases will not be all the values. We will
confine our discussion here to entering values.

e To enter the value, click number, string, date, or value in the Available components listing.
The purpose of selecting “number”, “string”, etc., is to properly format the values you enter.
String data items will be enclosed in quotes (e.g., ‘Smith’), number data items will be in
numeric format; date data items will be formatted in yyyy-mm-dd format. Note: Only the data
format appropriate for the data item you selected will appear in blue in the Available
components listing. In other words, if you have selected a numeric data item, the word
“number” will be listed. If you have selected an alphanumeric data item, the word

“string” will be listed. If you have selected a date item, the word “date” will be listed.

¢ An Enter Value dialog box appears. Enter the exact value(s) you want to use as a filter in the
space provided. Values must be entered in the exact format as they are found in the
database (e.g., all caps, mm/dd/yy).

¢ Click the OK button on the Enter Value dialog box.

12 You can enter more than one condition or filter to your report by using the “and” or “or”
connections. Be careful with these because there is a big difference. “And” will simply add
another condition to our filter. All conditions joined by “and” must be met in order for data to be
returned on our report. “Or” adds another condition to our filter, but either condition must be met
before data is returned. For example: a filter which states “Sex Cd = ‘M’ and Birth Dt >
01/01/60...” will result in records for all male individuals born after January 1, 1960 returned on
the report. Change that filter to read “Sex Cd = ‘M’ or Birth Dt > 01/01/60...” and you will get
records for all male individuals, regardless of their birth dates, plus all male and female
individuals born after January 1, 1960. If you want to add another statement to your filter
definition, you can do so by clicking “and” in the Available components listing and adding it to the
existing filter. Then repeat the above steps to complete another filter statement.

13 When you have finished your complete filter definition, click Finish at the bottom of the Report
Wizard screen.

The report appears on your screen.
e The title you entered in the first Report Wizard screen is at the top of the report.
e The current date appears in the upper right corner.
e The data items you selected for your report appear as columns in the report.

o The records relating to the filter definition you entered appear as rows in the report.
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Module 6:
Using the Impromptu Report Query

Now that you have accessed the predefined user reports in Impromptu, you may have realized a need to
design your own queries and reports to meet the specialized needs of your agency. This module will
guide you through opening catalogs, and creating, saving and managing your own ad hoc Impromptu
reports.

The Impromptu Screen

The menu bar at the top of the Impromptu screen has many of the same functions you are used to seeing
in MS Windows applications—File, View, Tools, Help, etc. A new option is Catalog, which allows you to
open and close catalogs. As discussed previously, a catalog is your gateway to the database. There are
currently a number of OCFS Data Warehouse catalogs available for your use, each of which connects
you to the appropriate data mart. Descriptions of these catalogs can be found in Appendix A of this guide.

E File Edit “iew Inseit Format Beport Catalog Tool: Window Help

The toolbar directly beneath the menu bar offers shortcuts to many of the Impromptu functions. The
functions of these buttons will be discussed in more detail throughout this guide.

Disls|E] SR $lel=lo] RmaE slole] | 00l ole] kv -F

The format toolbar, beneath the Impromptu toolbar, allows you to change fonts, font styles and sizes,
colors, and justification. There are additional options for currency formatting and borders.

[ Arial S o o] e »lz|u| === s R Q06

At the bottom of the screen is a status bar, which provides information on the catalog and database you
are connected to, as well as the number of records recovered in your current query. When you first open
Impromptu, there will be a red ‘X’ through the database symbols, indicating that you are not connected to
a database.

Alegation Distibuted Catakg @ | Repot D Widih 061, Height 079, Drigin: (056, 0.24] in.

Impromptu Catalogs

Before creating a new report or ad hoc query in Impromptu, you must first determine which catalog you
will need to access. As discussed previously, a catalog represents your gateway to the database in
Impromptu. Please refer to Module 5 — Using the Impromptu Report Wizard for more discussion on
catalogs.

For security reasons, OCFS has chosen to use shared catalog types. Shared catalogs allow users to
create new reports and modify existing reports. Users are not able to modify the catalog itself. Shared
OCFS catalogs are found in the Report Catalogs folder in the Data Warehouse.
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Opening Catalogs

Cognos

1 Double click on the Impromptu icon on the Citrix desktop to open the application. WIS

On the menu bar at the top of the Impromptu screen, select Catalog—> Open.

In the Open Catalog dialog box, open the directory selection list by clicking the down arrow | to
the right of the Look in box.

4 Select Desktop from the directory listing.

Open Catalog [ 2] x]
Look jn: @ T:4 D

E5 T4 Drive

=2 My Home Drive (T3]
Jr T THETIETT E_I FEPOTTTIOrar

[ ADOPTION 53 security

4 E18 Canversion Clean Up @Training Database

1 CFSR PIF E:I Yacancy Control

File name: | Open I

Files of type: IEatangs [*.CAT) ﬂ Cancel |
FastFind | fddtoFastFind |

&

5 Double click on the OCFS Datawarehouse directory.
6 Open the DataWarehouse folder by double clicking on it.
7 Open the Report Catalogs folder.

Open Catalog 7]
Loak in: Ia Repart Catalogs j &= &% E2-

Hadmissions Discharges: [linvestigations Catalog

i Allegations Catalog [#l5econdary Assignments Catalog
] AMS PIP [#l5ecurity

M| Foster Home [#&]acancy Contral Histary

il In Care Detail [#lacancy Control
il In Care Summary

File name: I

Open I
Files of bwpe: IEatangs [*.CAT) j Cancel |
FastFind | AddioFastFindl |

A

8 Select a catalog in the selection pane.

9 Click the Open button in the lower right corner of the Open Catalog window.

10 If the Cognos Common Logon entry window appears, enter your Cognos User ID and
Password and click the Log On button.
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Cognos Common Logon: dell ault m

Erber auser ID and passwaond that ig walid for Copros products.

User I

Passwond:

LagOn Carcel |

If you have successfully attached to the catalog, the red x that displayed at the bottom of the screen will
be replaced with a disk icon and the name of the catalog.

Starting a New Report

Once you’ve opened a catalog and are connected to a database, you can start a new Impromptu report
by clicking the New button on the toolbar. This brings up the Impromptu Report Wizard, which is a guide
that walks you through each step of creating a report, starting with the title of the report. The Report
Wizard has been covered in Module 5 of this guide. In this module, we will learn how to create new
reports from scratch, without using the Report Wizard.

Turning off the Report Wizard
This process must be repeated for each Citrix session, as changes are not saved to the server.

1 Double click on the Impromptu icon on the Citrix desktop to open the application. &

2 On the menu bar, click Tools.
Select Options from the drop-down list.

4 In the General tab of the Options box, click off the Use the Report Wizard to create standard
reports option.

5 Click OK.

Now we can create an Impromptu report the old-fashioned way:

Selecting Data

Data in Impromptu is organized into folders. The brief descriptions to the right of each folder give an
indication as to what kind of data each folder contains. To view the contents of a folder, click the [+ to the
left of it. Generally speaking, you will see FACT folders and DIMENSION folders in each catalog. The
FACT folders will contain actual facts or occurrences—CPS reports, allegations, resources, etc. The
DIMENSION folders contain descriptive data about the facts. For example, the Foster Home Fact folder
contains many codes and ID numbers, such as Worker ID, County Code, Agency ID, and Race Code.
The DIMENSION folders contain descriptive data that describe the codes (e.g., Worker ID from the Fact
folder, plus Worker Name from the Worker Dimension folder, provide the Worker's Name). So, you will
always want to start from the FACT folder and retrieve descriptive data from the DIMENSION folders.

When you start a new report in Impromptu, you will be working with the Query dialog box. You will note
that the left pane of the box is headed Catalog and the right pane is headed Query data. The right pane,
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or Query data side, is empty when we first open the dialog box, indicating that there is no data in the
query—a blank report. Data needs to be selected from the Catalog, or left, side of the box and placed on
the Query, or right, side of the box. Impromptu provides three distinct methods for selecting data, all of
which will be discussed.

1 Once you have opened an Impromptu catalog and turned off the Report Wizard, select File 2>
New from the menu bar.

o The New dialog box will display, requesting you to select a report template style.

e The template defaults to Simple List, which is the only template style we will cover in this
module.

New [2]x]

FastFind |

@ @ @ @ I |
Crasstab Form Letter Grouped  Grouped List Sel as Difault I

Crosstab

@ @ ¥ Preview

Stored Elank
Procedure

Mailing Labels

- Create new
& Report
 Template

Browse...
0K | Carcel | Wemd. |

e Make sure Simple List is highlighted, and click the OK button at the bottom of the New
dialog box.

3 The Query dialog box will display.

Query HE
Data | Sont | Group | Fiker | Accsss | Profie | Chiert/Server |

Catalog Querny data
-] Geography Dimersion

-0 Allegation Facts

-0 All Races & Ethnicity

-1 Fiole Dimension

-1 Subject Dimension

-1 Urit Dimension

B0 Child Dimension

- Worker Dimension

- Allegation Dimension

-1 Rieporter Relation Dimension
- Datahs Of Dates

-1 Subject Stags Person

-] Child Stage Person Dimension

HNENC T

Edit [Tefitiititr I
Data source:
Catalog - Browsen. B Erasstats e forl Frsertiar I

Cancel

4 In the Query Data dialog box, open a FACT folder on the left side of the dialog box (Catalog
pane) by clicking on the to the left of it.

5 Select a data item from the folder contents by clicking on it once to highlight it.
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6 Add it to the Query data pane using one of the following methods:

e Click the arrow button :Iin the center of the window (between the Catalog and Query data
panes); OR

e Double click on the data item and it is automatically added to the Query data side; OR

e Place your cursor on the data item, hold your mouse button down, drag it to the Query data
pane, and release your mouse button.

7 Repeat Steps 5 and 6 for all data items you want in your report.
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Query Data Order

The order in which the data items appear in the Query data box is not necessarily the order in which you
will see them on your report, horizontally from left to right. You should take a moment to review the order
and make any changes before you run the report. The order of your query data can be rearranged by
clicking and dragging the items up and down in the Query data pane.

1 Click on a data item in the Query data pane.

Note:
2 Hold your mouse button down and drag the data item up or Data items can also be moved
down the pane. on the report workspace. The

Query data order dictates the
order in which the data is
retrieved from the database.

3 Release your mouse button when your data item is in the new
location.

4 Repeat the process until you are satisfied with the order of
the data items.

Running Your Query

Once you have all of the data items you want to see, in the order in which you want to see them; you can
run your query. Note: Impromptu will run a query with a minimum of one data item selected.
However, it is recommended that any required sorts, groupings, or filters be added to the query
before it is run to minimize processing time.

1 Click the L d button in the lower right side of the Query Data box.

Report Views

The default view in Impromptu is the Page Layout format. So, when your report first appears, you will see
it as it will look on the printed page. Unfortunately, you won'’t be able to see all of your data in most cases,
and will need to use the Next Page buttons on the scrollbars to view all of the data. It is recommended
that, while you continue to develop your report, you use the Screen Layout view. Use the Page Layout
view when you have finished developing and are ready to format your report.

1 On the menu bar, click View = Screen Layout to switch to a screen layout view of the report.
(To switch back to page layout view, select View - Page Layout from the menu bar.

Status Check

100+ [@ When you run a report, you will notice a number in the lower right corner of your screen on
the status bar. This section of the status bar indicates the number of records that have been retrieved for
your report. Since Impromptu retrieves only 100 records from the database at a time, a 100+ indicates
that there are more than 100 records for this query. To see how many total records there are in your
query (while in Screen Layout):

1 Use the vertical scrollbar and scroll all the way down to the end of the report; OR
2 Press the End key on your keyboard; OR

3 Press the Page Down key repeatedly until you reach the end of the report.

The number in the lower right corner of the status bar now indicates the total number of records in your
query. To return to the top of your report, press the Home key on your keyboard.
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Organizing Data

You have created a basic report and are now ready to organize your data to fit your requirements. There
are a number of different things you can do to rearrange and organize the report, including:

e Ordering columns e Grouping data
e Setting column widths e Associating data
e Sorting data e Creating headers and footers

Ordering columns
Once you’ve seen your executed query, you may wish to move columns around on the report so that it
makes more sense. You can change the order in which your columns appear on the report in the

following manner:

Note:
1 Click on any value in a column to highlight it. ote

Make sure you keep your
cursor just below the Column
Header line of your report.

2 Holding your mouse button down, drag the column to another
location on the report.

3 When you see two vertical dotted lines appear to the right of
the column next to which you want to insert the moved column, release your mouse button.

Felationship Homme Worker Office [Tt Worker
Matne Matne Code Mame

Child Peters, IWelwina Hudson County Dss 001 |Zitrner, Marilyn
spencer,Lorte Hudszon County Dizs 001 [Coverdale, Clandia
mpencer,Lorte Hudson County Dss 001  [Cowerdale, Clandia
spencer,Lorte Hudson County Dizs 001  [Coverdale,Clandia

Draughter/Son Evans Michelle Hudson County Dss 001 [Zitrner,Marilyn
Ewansz Michelle Hudszon County Dizs 001 [Eitruner Barilyn

Lawrence, Donna  |Hudson County Des 001 |Zitrner, Marilyn

Foster Parent Barnharn Diebra Hudszon County Dizs 001 [Eitrwner Barilyn
Barnharn Debra Hudson County Dss 001 |Zirener,Marilyn

Barnharn Williarn  |Hudson County Diss 001  [Zitrwner Barilyn

verdale, Fozanne [Hudson County Drss 001 [Zitrrner, Marilyn

Me Hudson County Diss 001 [Eitrwner Marilyn

Reposition lines for

. . Home Name field
Setting column widths

Impromptu defaults the width of a column to the greater of the data item name or the longest data item in
the first 20 records retrieved. Since later records may have data items longer than the default, you may
have to widen some columns.

1 Highlight the header record of the column you want to widen.

2 Move your cursor to the right until it is on the line between this column and the next. Your cursor
will turn into two arrows facing left and right (€->).

3 Click on the line and, holding your mouse button down, drag the line to the right until the column
is the desired width.

You can shorten column widths by using the same method, dragging the line to the left instead of to the
right. There is another technique that can be used to shorten column widths when the data is wider than
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the columns. It is called “Multi-line with word wrap” and is covered in the Formatting section at the end of
this module.

Sorting data

Impromptu retrieves data as it finds it in the database. So, it may appear on your report in no particular
order. This will necessitate sorting the records in some fashion to make your report user-friendlier.
Impromptu provides a Sort button on the toolbar and a Sort tab in the Query dialog box. The Sort button
provides only an ascending sort, while the Sort tab of the Query dialog box allows you to un-sort, sort
ascending, and sort descending.

To sort in ascending order using the Sort button:

1 On your report, select any value in the column you want to sort.

2 Click the Sort button on your toolbar. ﬂl This button sorts in Ascending order only, so your
data will be sorted from lowest to highest value.

Sort in descending order using the Sort tab of the Query dialog box:

3 Click the Data Query fffﬂ| button on your toolbar OR select Report = Query on the menu bar to
bring up the Query dialog box again.

Das 5o | Groug | Film |

S oit ancer

i

—T——

Uk

windkosr Blarss

agenry of Aesomme
Serg

Fispuscs W

conml | dridrecd, Aessancs
Horms Hawe

Hormea St

Lo From Ciate

OOO0000000EEEEEE

Licax Wi S LF L0

| _ Do |

-

4 Click the Sort tab on the Query dialog box. All data items in the report are displayed in the Sort
order listing. Those Items being sorted are indicated by the symbols (sorted in ascending
order) or =] (sorted in descending order).

Select another data item to sort by clicking on it once in the Sort order list.
Click the Descending button on the bottom of the Sort order box.

7 Click OK at the bottom of the Query dialog box.
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Remove a sort by using the Sort tab of the Query dialog box

1 Click the Query Data Im]l button on your toolbar OR click Report > Query on the menu bar to
bring up the Query dialog box again.

2 In the Query dialog box, click the Sort tab. Note that the column you had previously sorted is at
the top of the list of data items and the icon to the left of it holds a carat (*) to indicate that it is
being sorted in ascending order. (]

urey HE
Dan 5ot | G | Fib |
Sl ik

[C] Repst D
[ I Sage ID
] Ireeabgalin Stage D

Lty Ciosder

DortZet | | Descendrg |

ak Cancal
3 Select the same data item by clicking once on it in the Sort order list.
4 Click the Don’t Sort button at the bottom of the box.

5 Click the OK button at the bottom of the Query dialog box.

To remove all sorts using the Sort button on the toolbar.
1 On the report workspace, press the Escape key on your keyboard to clear any selections.

2 Click the Sort button on the toolbar. ﬂl

3 A message box will display notifying you that all sort items will be deleted. Click Yes.

Impromptu

@ All sort items will be deleted.
] wo |

Grouping Data

Grouping data in an Impromptu report serves to bring all like data together on the report. You can choose
to group your data on any data item in your report. For example, if you have a list of CPS reports and
want to see them by worker, you can group them by Worker ID. The report will then be reformatted where
the Worker ID would be displayed only once, with all the CPS report records related to it displayed next to
the Worker ID. A line, or break, would appear before the next Worker ID and his/her CPS report records.
There is a Group button on the toolbar and a Group tab in the Query dialog box to facilitate this process.

Grouping data using the Group button

1 Select a data item on which to group the data in your report. Click on any value in that column or
click on the column header. Note: You can select multiple items to group by holding down
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the Ctrl key on your keyboard and clicking on each item in succession. The items will be
grouped in the order in which you selected them.

2 Click the Group button on the toolbar. EI

There is also a Group tab on the Query dialog box that can be used to group data. This feature is
especially helpful if you need to do multiple grouping on your report. Groupings are executed in the same
order that you invoke them. A second grouping will be within the first grouping, a third within the second
within the first, etc. Grouping can be undone using the Group tab.

Grouping data using the Group tab of the Query dialog box
1 Click the Data Query m| button on the toolbar to bring up the Query dialog box.

2 Click the Group tab.
uery 2=l

Data | Son GIM!FM | Acess | Froie | Clent S erves |

] Coron I - bevomeid Famst

™ Aepot D - Irveest Fack

1 iniske Siages 1D - Imemst Fact

1 Ieweastigatrn Shage 1D - o Facl
1 County Code - Irwesst Fact

[ or ] cwen |

3 Select a data item on which to group the data in your report from the data listing.

4 Click the Group button at the bottom of the Group box. ST I

5 Click OK on the Query dialog box to run the report.

Remove groupings from your report using the Query dialog box
Click the Data Query fffﬂ| button on the toolbar to bring up the Query dialog box.

Click the Group tab.

W N -

Select the grouped data item in the Group order listing.

4 Click the Ungroup button at the bottom of the box.

Remove all groupings from your report using the Group button

5 On the report workspace, press the Escape key on your keyboard to clear any selections you
may have on your report.

6 Click the Group button EI on the toolbar.

7 A message box will display stating, “All grouped data will be ungrouped”. Click Yes.
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Impromptu

@ All grouped data will be ungrouped.

Headers

Another way of grouping in Impromptu is to create a Header. The Header function creates a header frame
in the report, places the “grouped” data item in the header, and places all of the records applicable to that
data item beneath the header record. There is a Header button on the toolbar to facilitate this process.

1 Click View > Screen Layout on the menu bar.

2 Select a data item on which to group your data. Click on any value in that column or click on the
column header.

3 Click the Header button on the toolbar. ﬂl

Notice how the report has changed. The grouped item now appears above a listing of the records
associated with it.

Associating Data

“Associating” data means linking it to a grouped data item. When you group data, the values for the
grouped item are displayed only once. The records associated to the grouped item follow. Other data
items, however, may repeat in the listing because they are related one-to-one to the grouped item. As in
the above example, if you have Worker ID and Worker Name in your report and you grouped by Worker
ID, Worker Name would be repeated for every CPS report record. To eliminate this repetition, you can
associate Worker Name with Worker ID.

Associating data using the Group tab of the Query dialog box

1 Click View > Screen Layout on the menu bar.

2 Open the Query dialog box by clicking the Query Data m| button on the toolbar.
3 Click the Group tab.

4 Select a data item by which to group your report data in the data listing and click the Group

Giroup button at the bottom of the screen. Note that the item you grouped by is

highlighted in the group order list—the top of the box to the left of it is shaded in. -

5 Select the data item you want to associate to the grouped item by clicking on it in the group order
list.
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6 Click the Associate button at the bottom of the box. Note:
Azzociate
It should be noted that
7 Click the OK button at the bottom of the Query dialog box. Impromptu issues no
Note that the item you associated is highlighted in the warning if the data item
Group order listing with black-and-white shading in the and the grouped item to
box to the left of it. T3 which it is associated do
not share a true one-to-
When the report runs, you will note that the item you associated to one relationship. In the
your grouped item now appears only once on the report. event that a one-to-one
o . ] . ] relationship does not
A_ssomatlng data wher_1 you are using a Hee!der is a little different. You exist, data will be missing
will need to use the click-and-drag method in this instance. from the report.

Associating data when using Headers

1 Select a data item on which to group your data. Click on any value in that column or click on the
column header.

Click the Header button on the toolbar.

On the report workspace, select the data item that is to be associated to the Header item. Hold
your mouse button down and drag it up to the Header frame. Drop the associated item next to the
grouped item.

Clearing or “dissociating” data associations

1 Click the Query Data fffﬂ| button on the toolbar to bring up the Query dialog box.
2 Click the Group tab.

3 The “associated” items appear on the listing underneath the grouped items to which they have
been associated. The top of the box next to the associated item is only shaded in halfway. |

4 Select the item you want to dissociate.

Click the Dissociate button at the bottom of the dialog box.

Filtering Reports

“Filter” is Impromptu’s term for the parameter or scope of your report. A filter specifies the conditions that
must be met for data to be included in the report. By limiting information to a subset of the available data,
a filter emphasizes the information that is important to you. Filters serve to focus a report and to minimize
processing time by excluding any data that are irrelevant to the report. For example, you can filter a report
on Foster Homes to show only those that have been accepted and are active. Filters can be done directly
on the report workspace by using the Filter button on the toolbar. There is also a Filter tab on the Query
dialog box that can be used to build more complex filters.

A simple filter consists of three components: A data item, a filter operator, and a value. A data item would
be any column of your report or any data item in the Catalog. For example, if you want a report listing all
CPS Reports assigned to a given worker, the data item of your filter would be Worker ID. A filter operator
specifies what happens to the values on either side of the operator. For example, if you want a report
listing all CPS reports assigned to a single worker, your filter would read “Worker ID =....”, meaning that
the Worker ID on the record must equal a certain number before it is to be included in the report. The
third part of the filter is the value. Again, following the same example as above, your filter would read
“Worker ID = 1234567” to produce a report for a single worker. Values must be entered in the exact
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format as they are found in the database.

You will have several choices for entering the actual value or values by which you want to filter. Values
are entered by a direct selection on the report workspace. In other words, find the value of the data item
you want to use as a filter and highlight it on the report. Values can also be selected from a list of all the
values available for the selected data item. You can also enter the value into a number or text pop-up

box.

Filtering a report using the Filter button

1 On the report workspace, select a data item to use as a filter. Click on any value in the column or
on the column header.

2 Click the drop-down arrow to the right of the Filter ilj button on the toolbar. This brings up a
listing of operators from which to choose.

In

Mat in
Between
Mat betweer

L

v T W W W v ¥ v v W

Filter Definitian...

3 Select one of the operators from the drop-down list:

In — include records where this data item has any value in a given list of values

Not In — excludes records where this data item has any value in a given list of values
Between — include records where this data item has a value in a given range

Not Between — excludes records where this data item has a value in a given range
= Equals - include records that have the same value as the given value

<> Not equal to - include all records except those with the given value

< Less than —include all records where the data item has a value that is less than the given
value

<= Less than or equal to — include all records where the data item has a value that is less
than or equal to the given value

> Greater than — include all records where the data item has a value that is greater than the
given value

>= Greater than or equal to — include all records where the data item has a value that is
greater than or equal to the given value

4 Select the method by which you will choose the value you will use as a filter:

Selection — your filter value will be the value you have highlighted on the report.
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Number/String - a number or text entry box will pop-up and you will enter the exact value in
the space provided. Note: Values must be entered in the same format as they appear in
the database.

Select values — a list of all the values for your filter data item will be displayed and you will
make your selection from that list. Note: Please be aware that there is a limit to the
number of values that will be shown in this list. In most cases, only the first 100 values
will be shown, so you will not be seeing the entire list of available values.

5 Enter or select the value you want to use as a filter.

If you choose Select Values, a Select Values dialog box will display, listing all of the
available values for the data item selected. Select each value you wish to use in the Select
one or more values: listing box and it will then be listed in the Values selected box. When
you have finished making your selections, click the OK button at the bottom of the dialog box.
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If you choose Number/String, an Enter Values dialog box is displayed. Enter the values you
want to use as a filter. The values must be entered in the exact format as they are found in
the database. When you have finished, click the OK button at the bottom of the box.
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6 Your report will be returned with the filter applied.

There is a Filter tab on the Query dialog box that can also be used to construct filter expressions. The
method is much the same as selecting data—you select data items and operators from the Available
components listing on the left side of the screen and place them in the Filter definition box on the right
side of the screen. All of the data items in your report are available for your use in a folder called Report
Columns. In addition, all the items in the catalog are available in a folder called Catalog Columns. So,
you can use a data item that isn’t even in your report to build a filter.

Filtering reports using the Filter tab in the Query dialog box
1 Click the Data Query button on the tool bar to bring up the Query dialog box.

2 Click the Filter tab.

Page 16-14
rev 08/2004

OCFS Data Warehouse Reporting
Impromptu Step-by-Step Guide



Query ﬂ E

Data I Sart I Group  Filter |Access| F'mhlel EIlenUSelvarI
Avvailable compaonents: Filter definitian:
1 Report Columng |i ;I
3 Functions
3 Value
(] Catalog Colurrs B |
1 userlD
[ Piompt Manager =
& i he!
[ esists o | 0, Clear
B lookup
& + r— Filter optian:
& - Filter bype:
G ot IDeIa\I ~| I Suspend the filter
ol
I Eliminate duplicate rows
Tips:
Use the available components to define or add to an exprezzion. ;I

3 Open the Report Columns folder (or the Catalog Columns folder) in the Available
components listing by double clicking it.

4 Select a data item to use in your filter expression by clicking on it once to highlight it. Move it to

the Filter definition box by clicking the arrow button ﬂ between the Available components
window and the Filter definition window. You can also double click it to move it, or click and drag
it over to the Filter definition box.

5 Now the appropriate operators appear in the Available components window of the Query box.
Select an operator and move it to the Filter definition window by double clicking it, clicking the

arrow button ﬂ or clicking and dragging it over.

Query EHE
Data I Sort I Group  Filter |

Awailable components: Filter definition:

& in Statuz Tt [l |« |

M between

& ke

M contain: = |

8 starts with

B iz missing =

8 is not missing -

X i

o -

& <« — Filter option:

H « Filter twpe:

% <= IDetaiI j ™ Suspend the filter

*
[ := V| Eliminate duplicate rows
& not
Tips:
=
e
()8 I Cancel |

6 Now you have to indicate what kind of value you will be entering. The blue text in the Available
components listing indicates the type of value that is appropriate for the data item you've
chosen. It will be a number, string, or date value. Double click on the blue value-type item to
move it to the Filter definition box. The purpose of selecting a value type is to format the value
correctly in the Filter definition box.
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7 Now you can enter the value you want to use as your filter. If the data item is an alphanumeric
field, you will have chosen the value type of “string” and two single quotation marks will appear
in the Filter definition box. Your cursor will be flashing between the two quote marks, so just
type your value in there. If the data item is a date field, today’s date will automatically appear in
the Filter definition box in yyyy-mm-dd format. Type over that date field. If the data item is a
number field, a zero will appear in the Filter definition box. Just type the numeric value you want
over the zero.

Status Tut in [ 1. Haome Capacity Murnber-Foster Home Fact = E—‘ Cert Ot = EI02-06-18 .

“string” “number” “date”

8 When you have completed your filter expression, click the OK button at the bottom of the Query
dialog box. Your report will now re-run with the filter applied.

Complex Filters

Complex filters consist of more than one simple expression; e.g., “Worker ID = XXXXX and Intake Start
Date between yyyy-mm-dd and yyyy-mm-dd”. Complex filters are built in the same way as simple filters
with the addition of “and” or “or” between the filter expressions. Complex filters can be built on the report
workspace, using the Filter button and drop-down box, or they can be built manually in the Filter tab of the
Query dialog box.

Again you are cautioned to note the difference between the “and” and “or” connectors. “And” will simply
add another condition to your filter. All conditions joined by “and” must be met in order for data to be
returned on our report. “Or” adds another condition to our filter, but only one condition must be met before
data is returned. For example: a filter which states “Sex Code = ‘M’ and Birth Date > 01/01/80...” will
result in records for all male individuals born after January 1, 1980 returned on the report. Change that
filter to read “Sex Code = ‘M’ or Birth Date > 01/01/80...” and you will get records for all male individuals,
regardless of their birth dates, plus all male and female individuals born after January 1, 1980.

Building a complex filter using the Filter button

1 Select the data column you want to use to build the first part of your filter by clicking on any data
item in the column or by clicking the column header on the report.

2 Click the drop-down arrow to the right of the Filter button on the toolbar. ilj

3 Select a filter operator from the drop-down list.
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8
9

Select the method by which you will choose a value for your filter expression from the drop-down
list.

Select or enter the value you will use to filter your report.

To build the second part of your expression, select the data column you want to use by clicking
on any data item in the column or by clicking the column header on the report.

Click the drop-down arrow to the right of the Filter button on the toolbar. ilj
Select a filter operator from the drop-down list.

Select the method by which you will choose a value for the second filter expression.

10 Select or enter the value you will use in the second filter expression.

Building a complex filter using the Filter tab of the Query dialog box

1
2

Click the Data Query button on the toolbar to bring up the Query dialog box. ﬁﬂl
Click the Filter tab.

In the Available components listing (left side of the Filter box), open Report Folders or Catalog
Folders by double clicking it.

Select the data item you will use for the first part of your filter expression and move it to the Filter

definition window by double clicking on it, or by using the arrow button :l in the center of the
dialog box.

Select a filter operator from the Available components listing and add it to your expression (via

double-clicking, click and drag, or ﬂ).

Select the data type (string, number, date) in blue text from the Available components listing
and add it to your filter expression.

Enter the value(s) you will use in your filter in the Filter definition box.
In the Available components listing, select ‘and’ and add it to your Filter expression.

Open the Report Folders or Catalog Folders in the Available components listing and select
the data item you will use in the second part of your filter expression.

10 Add the data item to your filter expression by double-clicking, using the arrow button :I or

clicking and dragging it to the Filter definition box.

11 Select a filter operator from the Available components listing and add it to your filter expression.

12 Select the data type from the Available components listing and add it to your filter expression

(e.g., string, date, number).

13 Enter the value you will use in the second part of your filter expression.

14 Click OK at the bottom of the Filter dialog box to run the report.
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Adding Calculations to Your Report

Totals and Counts

Totals and counts can be added to your report directly on the report workspace. There are Total and
Count buttons on the toolbar to facilitate this process. The Total button provides a sum of a selected
column. If the report data has been grouped, subtotals will be provided automatically for each group. The
Count button will provide a count of the number of items in a selected column. This feature is useful if you
need the number of CPS reports or the number of allegations per report.

Totaling a column

1 Select a column for which you need a total by placing your cursor above the column header.
When your cursor turns into an arrowﬂ, click once to highlight the entire column.

2 Click the Total button on the toolbar. ﬂ

Footer records have been placed in the report with subtotals for each grouping. At the bottom of the
report is a footer record with the grand total for the report.

Adding counts to your report

When performing a count calculation on your report, remember to select a “unique” identifier to count.
For example, when performing a count on children, you should select the unique CIN ID rather than Child
Name, since two children could have the same name, but would not have the same CIN ID.

1 Select any value in the column for which you need a count (i.e., the number of items in the
column) by placing your cursor above the column header. When your cursor turns into an arrow
click once to highlight the entire column.

2 Click the Count button the toolbar. 2!

Footer records have been placed in the report containing subtotals of the count for each group. There is a
footer record at the bottom of the report with the total count for the report.

Summaries

EThere is a Summary icon in the center of the Query Data dialog box that can be used to add various
summary calculations to your report in the data selection stage. You must first select the data item for
which you require a summary in the Catalog data box, and then click the Summary button. A summary
dialog box is displayed and you can select from six different types of summaries, as described below:

o Total will sum up all of the data items and return a total for all of them.
e  Minimum will return the minimum value of the selected data items.
e  Maximum will return the maximum value of the selected data items.

e Average will return the average number value of all the data records selected by totaling the
values and dividing by the number of records.

e Count will return the total number of items selected, disregarding the number values.
o Percentage will return the percentage of the total value for each of the selected data items.

The difference between the Summary dialog box and the Total and Count buttons is that the Summary
option adds an entirely new column to your report, with the requested summary calculation for each
record in your report. This may not make sense for total calculations, but is logical for percentage
calculations.
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1 Open the Query dialog box, and select a data item for which you want to provide a Summary
calculation in the Catalog data listing by clicking on it once to highlight it.

2 Click the Summary button in the center of the Query dialog box. E

3 The Summary dialog box appears. Type a title for your summary calculation in the Label box.
This will be the column header for your new column. It defaults to the data item name, but you
can delete that and add your own title.

4 Select from Total, Minimum, Maximum, Minimum, Average, Count and Percentage by
clicking on the appropriate button.
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Cancel |
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Click the OK button in the upper right hand corner of the dialog box.

Group your report by a specific data item using the Group tab.

N O O

Place a filter on your report, if required, using the Filter tab.

8 Click the OK button in the Query dialog box to run the report.
A separate column containing the summary calculation you requested has been added to the report.

Column Calculations

ou can create new columns by performing calculations on the columns of your report. A Calculation
Definition dialog box is provided for your use in creating calculations. The box can be called up from the
Query dialog box using the Calculate button in the center of the box, or from the report workspace using
the Insert - Calculation command on the menu bar. The Calculation Definition box is virtually the
same as the Filter definition box in that components are provided on the left side and a definition box is
provided on the right side. You move components from the left to the right by double-clicking them, or by

using the arrow button ﬂ in the middle. Add, subtract, multiply, and divide are the operators you will be
using most. Both Report Folders and Catalog Folders are available for your use in selecting data items
for your calculation.
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Creating a calculated column using the Insert command
1 On the menu bar, click Insert = Calculation on the menu bar.

2 Your cursor turns into an downward arrow. Place the arrow in between the two columns where
you want your calculated column to appear and click your mouse button.

3 The Calculation Definition dialog box is displayed. Enter a name for your calculation in the
Name box. If you do not enter a name, the title will default to the calculation expression itself.
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4 Open the Report Folders or Catalog Folders in the Available components listing by double
clicking on it.

5 Select a data item to start your calculation expression. Double click on it to add it to the
Expression window or use the arrow button ﬂ in the center of the window.

6 The Available components window now displays operators (+, -, *, /) for adding, subtracting,
multiplying, and dividing. Select one of these and add it to the Expression window by double

clicking on it or by using the arrow button ﬂ in the center.

Note:
7 If you are using another data item to complete your expression .

(i.e., adding one column to another, subtracting one column The Tips box beneath the
from another column, multiplying one column by another Exp_ressmn YVlr]dow gives
column, or dividing one column by another column), then open a brief description of what
the Report Folders or Catalog Folders by double-clicking on the operator selected will
it. Then select the data item you need from the listing and add do. Just click on any
it to the Expression window by double-clicking it or by using operator and read the

:l _ description of it in the
the arrow button in the center. Tips box.

8 You can also use a static number to complete your
expression; e.g., to develop an average monthly CPS reports processed number, take the total
number of CPS reports processed and divide by 12. In this instance, select Value in the
Available components listing, and then add number to the Expression box.

9 When you have completed your expression, click OK at the bottom of the Calculation Definition
dialog box.
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Another method of adding calculations to your report is from the Query dialog box. There is a Calculate

button in the center of the dialog box, between the Catalog data listing and the Query data listing.
While selecting data for your report, you can click the Calculate button. The Calculation Definition
dialog box will appear. You can build your calculation expression using the steps described above.

Functions

Functions are predefined formulas that you can use to reformat or manipulate data items. Functions are
considered calculations in Impromptu; in other words, you will use them in building expressions in the
Calculation Definition dialog box. There is a folder called Functions in the Available components
window of the Calculation Definition dialog box. To open the folder, you double click on it. A listing of
available functions is displayed. In order to learn what a function does, click on it and a brief description
will appear in the Tips box in the lower right corner of the window. Some examples of functions are:

o Age — Calculates an age by subtracting a specified date from today’s date (i.e., today — date
of birth = age of child)

o Datetime-to-Date — Returns the system datetime (in yyyymmdd format) in more legible date
format (yyyy-mm-dd)

e Today — Returns the current date according to the date set on your computer

The Tips box also provides the syntax, or format, that the calculation must take to work properly. For
example, the age function syntax is age (date_exp), which means it should read age (Date of Birth) if you
are calculating the age of a child.

Functions are also available to you in the Filter dialog box and you can use them in building filter
definitions. For example, if you want to get a listing of foster homes whose certifications will expire within
the next 90 days, you could insert a filter that read “Cert Date <= Today + 90”.

Using a function to build a calculation
1 Click the Calculate button in the center of the window.

2 In the Calculate Definition dialog box, type a Name for your calculation in the Name box (e.g.,
Age).
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Open the Functions folder in the Available components listing by double-clicking it.

Select a function from the listing. Place your cursor on the function in the listing and look at the
Tips box in the lower right section of the box. The Tips box gives a brief description of what the
function does and also provides the syntax, or format, that the expression must take. If you are
using the age function, you will need to add “age” to your Expression window, then add the date
on which you want to calculate an age, such as the Date of Birth.

Syntax: age [date_exp] ﬂ
Returns age az a month-day-pear interval based on date_exp and
obtained from subtracting date_exp from today's date [a: defined by j

Add the function to the Expression box by double clicking it or by using the arrow button ﬂ in
the center.

Complete the expression following the syntax outlined in the Tips section. If you are calculating
age, you must now add the date to your expression by double clicking on it from the Reports
Folders listing of your Available components box.

When you have finished your calculation expression, click the OK button at the bottom of the
Calculation Definition window.

Click OK on the Query dialog box to run the report.

Using a Function in a Filter

1 Click the Filter tab.

2 In the Available components listing, select the data item you will use in your filter by opening the
Report Columns or Catalog Columns folder and adding the data item to the Filter definition
box.

3 Select an operator from the Available components listing (i.e., =, >, <, >=, <=, <>) and add it to
your Filter definition.

4 Open the Function folder in the Available components listing and select a function from the list.
Add it to your Filter definition. For example, Cert Date <= (Today + 90).

5 Click OK at the bottom of the Filter definition box to run the report.

Formatting Your Report

Impromptu offers many options for formatting your report. You must be in Page Layout view to effect any
formatting changes that you make. Some of the features available are:

e Changing column titles e Using multi-line with word wrap

e Changing fonts, font styles, and font
sizes

Data alignment and sizing

Inserting Titles, Page numbers, etc.
e Changing data formats

e Using page setup to change
margins, page size, etc.
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Changing column titles Please remember that report
If the column header (or data item name) is not user-friendly or is too titles, column titles, and data
long, you can change it by using one of the following methods: items must be formatted
separately.

1 Click into (i.e., double click on) the column header to invoke edit mode and delete the existing
column title. Enter the column name of your choice; OR

2 Right click on the column header. Select Edit from the drop-down menu. Delete the existing
column title and enter a new one.
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Changing fonts, font styles, and font sizes

1 Highlight the column(s) in your report that you want to

change. Changes made to any item in a column will be

carried over to all items in the column. If you want to change Column headers must be
fonts on multiple columns, use your Shift or Ctrl keys to formatted separately from
highlight the columns. report data.

2 Right click and select Format from the drop-down menu. (Note: You can also select Format >
Font from the menu bar to get to the Font tab.)

3 Inthe Font tab, you can change the font, font style and font size.

4 Click OK to close the Format dialog box.

Changing data formats

The default data format in Impromptu is General. You may want to format numeric data with commas and
decimal points, or even as currency. Remember that you only need to reformat one data item in a column
and the change is carried forward to all items in the column.

1 Click on a data item that you want to reformat.

2 Right click and select Format from the drop-down menu. (Note: You can also select Format >
Data from the menu bar to get to the Data tab.)
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In the Data tab, open the selection listing by clicking the arrow to the right of the Positive
window.

4 Select a format from the listing and click OK to close the Format dialog box.

Page setup
As with any Microsoft-style product, you can change your page size and margins in the Page Setup
option from the File menu.

1
2
3
4

5

Select File > Page Setup on the menu bar.

Change margins using the Left, Right, Top, and Bottom windows.

Change the page layout from Portrait to Landscape in the Page orientation section.

There is a “Fit to Page” option at the bottom of the window that can be very useful. However, be
careful with this because Impromptu will attempt to fit all records on one page and you could end

up with some very small print.

When you have finished making your changes, click OK.

Multi-line with word wrap

Sometimes you may have some very long text items that take a lot of space on your report. You can set
this item to wrap around to a second line, and thus save space horizontally across your page. This option
is found in the Text Properties box. Multi-line with word wrap can also be used in column and report

titles.

D W N =

7

Select the data item you want to word-wrap.

Right click and select Properties from the drop-down list.
Select the Layout tab.

Select the Multi-line with word wrap option.

Click OK.

Data alignment and sizing

You can align data items vertically and horizontally in a header or title. You can also specify a size for a
column or set it to be dynamic (it changes to fit the data). These options are also found in the Text
Properties box.

1 Click View = Page Layout on the menu bar.

2 Select the data item you want to align.

3 Right click and select Properties from the drop-down list.

4 Select the Align tab. Use the arrows on the horizontal placement boxes to align your data to the
left, at center, or to the right of any column in the report. Use the arrows on the vertical placement
boxes to align your data to the top, bottom or center of the selected data box.

5 Select the Size tab. Use the arrows on the horizontal placement boxes to adjust the width of any
column in the report. Use the arrows on the vertical placement boxes to adjust the height of any
row in the report.

6 Click OK.
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Inserting Titles
Impromptu reports have a default title bar at the top of each report in Page Layout:

=Type here to customize title>

1 Place your cursor on the default title and right click.
2 Select Edit from the drop-down menu.

3 Your cursor is now placed inside the title bar. You can delete the default title and enter in your
own title text.
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Module 7:
Managing Impromptu Reports

This module will cover all the skills you will need to print, distribute and save your Impromptu reports.
There are a number of options in Impromptu for saving your reports in other file formats such as Excel
files, ASCII files, text files, and PDF files (viewable in Adobe Acrobat). You can also e-mail reports you
have saved to your T: Drive from your local desktop. There are some things to consider when printing
reports, too, since you will not in most cases want to print an entire report and should not print reports
directory from Impromptu in Citrix. All of these options are discussed below.

Saving Impromptu Reports

As has been noted previously, you cannot save modified predefined reports over the original reports in
the Data Warehouse folder. If you make modifications to a report and want to save the modified version,
you can save it to your T: Drive to prevent corrupting the original report. Of course, you will need to save
reports that you create with unique names. Follow the steps below to save modified and new reports.

1 Login to Impromptu and open a catalog.
2 Create a new report or make modifications to a predefined user report.
3 Select File & Save As on the menu bar.

4 A Save As dialog box is displayed on your screen.

Save As B E
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File narme: ID verdue reparts Save I
Save as type: IHeports [=IMR] ﬂ Cancel |

™ Save a snapshat with the report U] e |

EastFind [
Z

Open the list of file directories by clicking the ~| arrow to the right of the Save in window.
Select My Home Drive (T:) and an appropriate folder from the directory selection list.

7 Type a report title in the File name window.

8 Click the Save button in the lower right hand corner. ﬂl

Saving Impromptu Reports as Other File Types

Impromptu offers a variety of file types for your use in managing and distributing reports. If you need to
further manipulate the data, or add more data to it, you can save the report as an Excel file. You can
choose to save as an Excel file with or without format. If you save with format, you retain all fonts,
borders, patterns, and styles that you used in your Impromptu report.
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You can save reports as ASCII files if you need to import it to another application (Excel, Access) or if you
need to send it to a colleague who does not have the Impromptu or Excel applications. If you need to
import the report data into a word document, you can also save it as a text file.

You can also e-mail Impromptu reports from Microsoft Outlook after you have saved them to your T:
Drive. Another means of distributing reports to colleagues who do not have access to Citrix is to publish
them to HTML so that others can view them in Internet Explorer.

There is another option available for saving your report in PDF (Adobe Acrobat) format, which is excellent
for saving reports in presentation format and printing reports, but does not allow for much manipulation.
Since it is not recommended that reports be printed in Citrix, you will need to save your reports to your T:
Drive in PDF format, then print them from Acrobat Reader on your desktop.

All of these options are discussed below:
To save Impromptu reports as Excel files
1 Click File © Save As on the menu bar.
2 In the Save As dialog box, open the directory listing by @

clicking the arrow | to the right of the Save in box.

It is a good idea to filter your

Select My Home Drive (T:) report to retrieve the
minimum amount of data
4 Open an appropriate folder. needed to fit your

requirements. Saving large
amounts of unnecessary

data in Excel format drains
system resources and is

much harder to manipulate.

Save As [2]=]
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Gave a3 bpe: Iﬂaports [~ IMR] j Cancel |
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2

5 Enter a name for your file in the File name box.

6 Open the file type listing by clicking the arrow | to the

right of the Save as type box. It is always helpful to assign
names to files that are easily
Save as lype: recognizable to you.
T emplotes [* IM 1) Remember that file names
[ Save asna EotFiIfnj:l ["[.II\EI)SA]T] can be as long or as short
ata file [* -
dBASE file [~ DEF) as you like.
Defimited A5CI1 [* L5V
Excel file [*¥L5)
Excel with Farmat [*=L5]
Latus 1-2-3 file [* K1)
PDF Farmat [ PDF] jd|

7 Select Excel file [*.XLS] or Excel with Format [*.XLS] from the listing. Excel with Format retains
the same fonts, borders, patterns and styles that you used in your Impromptu report.

8 Click the Save button in the lower right corner of the box. ﬂl
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You can now login to Excel from your local desktop, and open the file you just created.

1

Press the Windows key on your keyboard.
Select Programs > Microsoft Excel from the Start menu.

In Excel, select File > Open on the menu bar.

In the Open dialog box, open the directory listing by clicking the arrow j to the right of the Look
in window.

Navigate to your T: Drive and open the appropriate folder.

Select the Excel file you saved and click the Open button.

To save Impromptu reports as ASCII files

ASCII stands for American Standard Code for Information Interchange. This is the code that makes it
possible for just about every computer to understand the letter “A” (and all the other letters) as a letter “A”.
The ASCII text file, although simple and limited, is understood by virtually all computers.

1
2

N o a0 A~ W

Select File > Save As on the menu bar.

In the Save As dialog box, open the directory listing by clicking the arrow ™ | to the right of the
Save in window.

Select My Home Drive (T:) from the directory listing.

Open an appropriate folder.

Type a name for your file in the File Name box.

Open the file type listing by clicking the arrow v|’[o the right of the Save as type box.
Select Delimited ASCII [*.CSV] from the listing.

Save

Click the Save button in the upper right corner of the Save As dialog box. —I

To save Impromptu reports as PDF files

PDF stands for Portable Document Format, which means that all formatting made to your document will
“travel” with the document. Remember, all Connections computers have the Adobe Acrobat Reader
software required to view and print the PDF files.

1
2

N o0 a0 A~ W

Select File > Save As from the menu bar.

In the Save As dialog box, open the directory listing by clicking the arrow ZI to the right of the
Save in box.

Select My Home Drive (T:) from the drop-down listing.

Open an appropriate folder.

Enter a name for your file in the File name box.

Open the file type listing by clicking the arrow | to the right of the Save as type box.
Select PDF Format [*.PDF] from the listing.
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8 Click the Save button in the upper right corner of the Save As dialog box. ﬂl

You can now login to Acrobat Reader from your local desktop, and open the PDF file you just created:

1 Press the Windows key on your keyboard to return to your desktop.
Select Programs > Acrobat Reader from the Start menu.

In Acrobat Reader, select File > Open on the menu bar.

4 In the Open dialog box, open the directory listing by clicking the arrow ﬂ to the right of the Look
in window.

5 Navigate to your T: Drive and open the appropriate folder.

6 Select the PDF file you just saved and click the Open button.

Saving Impromptu reports as text files
Text files can be opened in Microsoft Word or any other word-processing application. Thus, you can use
the text file for any word-processing operation, such as mail merges.

1 Select File > Save As from the menu bar.

2 Inthe Save As dialog box, open the directory listing by clicking the arrow | to the right of the
Save in box.

Navigate to My Home Drive (T:).
Open an appropriate folder.
Enter a name for your file in the File name box.

Open the file type listing by clicking the arrow v|’[o the right of the Save as type box.

N o g A~ W

Select Text file [*.TXT] from the listing.

8 Click the Save button in the upper right corner of the Save As dialog box. ﬂl

Sending Impromptu Reports via E-mail

You can send an Impromptu report to a colleague using Microsoft Outlook from your local desktop.
Remember that a file saved as an *.imr file type will require your colleague to access the Impromptu
application to open it. Reports must be e-mailed from the local desktop, so must first be saved to the T:
Drive before leaving your Citrix session.

In order to e-mail an Impromptu report, you must be on your local desktop. Your local desktop can be
accessed with a Citrix session open, or after completing a session working with Impromptu. Both *.imr
(Impromptu reports) and other file types can be saved and e-mailed to other users. If you are unsure
whether your intended recipient can access Citrix, the file type recommended is *.PDF (Portable
Document Format). Every Connections computer has Adobe software installed and can open and print
this file type.

Having completed formatting of your report:

1 Select File > Save as.
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oo

10

11
12
13
14

In the Save As dialog box, open the directory listing by clicking the down arrow | to the right of
the Save in window.

Navigate to My Home Drive (T:).

Open an appropriate folder.

Open the file types listing by clicking the down arrow ™ | to the right of the Save as Type window.
Select PDF Format [*.PDF].

Type a name in the Name field.

Click the Save button.ﬂl

Press the Windows key on your keyboard in order to return to NT.

Click Start > Programs > Microsoft Office > Microsoft Office Outlook 2003, or double click
on your email icon if there is a shortcut on your local desktop.

In Outlook, select File > New = Mail Message.
Enter the recipient’s e-mail address in the To: field.
Type an appropriate subject in the Subject field.

Enter a message (e.g., “Here is the report | promised you. Open it with Adobe Acrobat Reader.”).

15 Click Insert - File.

16 In the Insert File dialog box, navigate to your T: Drive.

17
18
19
20

1

Open an appropriate folder.
Select the report you wish to e-mail.
Click Insert. (More than one report can be sent at one time by repeating the Insert command.)

Click the Send button on the Outlook toolbar to send your message and attached report.

Publishing Impromptu Reports to HTML Format

You can save Impromptu reports in HTML Format for viewing inside a web browser, like Internet Explorer.
This format can be used in a local intranet, so that specified users can access the report through typical
browser commands, like links. Presently, OCFS does not support a local intranet for publishing reports,
however this functionality should be noted.

Select File & Publish as HTML... on the menu bar.
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Ed: View Inseit Fomasl Heporl Calslog

Hewe... Cirlel
Open.. Cirk0
LCleog=

Save Cirkes
Save Az,

Fririt Freview

1 TAN Foster Home Detal
2 Statevnde Admizzion by Month [rend]
3 Admizzion Summany Report be Destnct

Exit

2 In the Publish As HTML dialog box, open the directory listing by clicking the drop-down arrow to

the right of the Save in: box.

3 Navigate to My Home Drive (T:) and open an appropriate folder.

4 Enter a name for your report

5 Click Publish.

in the File Prefix box.

The status bar at the bottom of the screen will indicate the report is being published.

|Generating HTML page nurmber : 8 |

6 To view your report in Intern

et Explorer.

»

e Press the Windows key on your keyboard to return to your desktop.

e Select Programs - Internet Explorer from the Start menu.

e Inthe Address line, type in the name of your report, including the directory path

| Address |1 T:40CFS Data Warehouse!Test HTMLHTH

OR find the file in Windows Explorer (choose the Main File only), and double-click.
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Faolders b4

[ oracle ;I

[ Program Files

[ windows Update Setup File
00 WINNT
125 Compact Disc (D1

B
OCFS Data
Warehouse

152 Morehccenture on 'sconnappde
]-52 92365 an 'Sconnappdey 1iUse
]% data on ‘sconnappdevl’ (1)
152 Apps on 'Sconnappdewl’ (30
152 Cdrem on 'Scannappdevl’ (K
-5 Connections on 'sconnappdeyl

This folder is Online.

Test HTML
HTML Cocumnent

Modified: 6/18/2002 9:23 AM

Size: 403 bytes

Attributes: (normal)

352002365 on fpcfelalaavishare 9'

1 Adobe

5] OCFS Data Warehouse  —

-] WINDOWS

Mame ¢ Size
4l cgd7dn 1KB
47 eq47dnd 1KB
47 g4 7 1KB
47 cga7IFd 1KB
47 cgarg 1 KB
4 cqargd 1 KB
4 cg47up 1KB
47 cg47upd 1KB
#1|Goal Repart 34 KB
'@Goal Report 4KE
28| Goal Repart 16 KB
4 left 1KB
TIPoFTest B KB
&]Report13 1 KB
&Report13_toc 2 KB
&]Report13bl 4 KB
&]Report13blb 4 KB
&]Report13n1 1KB
&]Report13nlb 1KB
W right 1KB
£] 1KE
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Printing Impromptu Reports

Due to the limitations of the Citrix environment, reports should not be printed directly from Impromptu.
Printing may not work correctly from the Citrix window, so reports should be saved as a file type that can
be opened and printed on the local desktop. PDF format (Portable Document Format) is recommended
for this purpose. Because an Impromptu report is often larger than what appears on your PC screen, it is
important that you specify exactly what you want to print. It is recommended that you save a copy of a
report you have modified or created, as *.IMR (Impromptu report format) prior to saving as any other file
type, so that you do not lose your original report.

After completing the formatting of your report in Impromptu:

1
2

o g A~ W

Select File > Save As on the menu bar.

In the Save As dialog box, open the directory listing by clicking the arrow | to the right of the
Save in window.

Navigate to your T: Drive.
Open the file types listing by clicking the arrow ™ | to the right of the Save As Type window.
Select PDF Format [*.PDF] from the file types listing.

Type a name in the Name field.

Save As [ 7]

Savein: | 52 My Home Drive [T:] s =

1 Training

I WINDOWS

"1 worD

4] |»]

File name: ID\rerdue reports Save I

Save asbype: [PDF Fomat % FDF) =] Cancel |
Data file [~ DAT) N
dBASE file [* DBF) s

I™ Sz & 518 Delimited ASCI (~.CSV) Opticriss |
Excel file [*#L5] - I
Ewcel with Format [%%L5) FastFind

| otus 1-2-3 file [* WK1 A

Query Definition file [<100]
SOL file *50L)
Teut file [+ TxT)

4]

7 Click the Save button.ﬂl

8 Press the Ctrl and Esc keys on your keyboard simultaneously to return to NT.

9 Click Start > Programs > Adobe Acrobat Reader.

10 In Adobe Acrobat Reader, select File & Open.

11 In the Open dialog box, open the directory listing by clicking the arrow | to the right of the Look

in window.

12 Navigate to your T:Drive and select the PDFcopy of your report.

13 When the report is open in Acrobat Reader, select File = Print on the menu bar.
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14 Enter the page numbers of the report you wish to print in the Print dialog box.
15 Verify your printer selection.

16 Click Print.
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Crosstabs

Module

8:

Advanced Impromptu Features

Impromptu crosstab reports display summary information from a list report in a compact table of columns
and rows. A crosstab shows the value for the combination of each row and column, enabling you to gain
a different perspective of the data and view more information without the need to scroll. For example, if
you needed to track the number of overdue CPS reports by worker by month, a crosstab report can be
easily designed to extract the information. The sample report below displays the months as columns, the
workers as rows, and the number of overdue CPS reports in each cell. Cell is the intersection of a
column and a row that contains a single value.

Worker Mame

14102 12:0040

2102 12:00AM

3102 12:00AM

41102 12:00AM

54102 12:00AM

Total

Barnham Brenda

1]

Barnharm Holly

Barnham Michael

Coverdale Christine

Coverdale Michealle

N =1

—_ | =

Coverdale Robert

O|m(w|—= | =]k

Doe Julie

Doe Patricia

Doe,Ron

Wl [~ O] @ |0 [—=]th

—_

Fletcher Stacia

Grimsby Jana

Harding Andrew

= |l=|aO(m[O|=|wM]|O|D

Ol=Mm| =S|k O] = | &=k

Lo I I e e e O e L e

O [ | e | =

— i [ | | —

= M2
[ L= 5

Crosstab reports can be built using the Report Wizard or the Query dialog box. Both procedures will be

reviewed in this guide so that users can determine which method is more convenient for them.

Building crosstabs using the Report Wizard:
1 Login to Citrix and open the Cognos Impromptu application.

2 Click the New button on the toolbar.g

3 Inthe Open Catalog dialog box, navigate to the OCFS Datawarehouse/DataWarehouse/Report
Catalogs directory.

4 Select a catalog in the selection window.

Click the Open button.
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Open Catalog

Laok, jn:

3 Report Catalogs

=« ® e E-

Desktop

@ T:4 Drive

=2 cognoseubes on 'conncord?’ [+
[ Dataw arehouse

Report Catalogs

=2 My Hame Drive [T:)

ht: Detkail
hE Summary

atalog

Fi Diisskric

File name:

Files of twp

Common Logon dialog

Admissions Discharges

Open I

e IEataIDgs [*.CAT]

FastFind

j Cancel |

| Addto FastFind |

box.

Click the Log On button.

A

Enter your Cognos User ID and Password into the appropriate windows of the Cognos

The first Report Wizard screen appears. Enter a title for your crosstab report in the Type the title

of the report window.

Impromptu Report Wizard

Tvpe the title of the report.

[7]x]

ICrDsstab Example]

9 Click the Next button.

Cancel

< Bank | Mest » I

Fifiiehr

10 Click the Crosstab report option on the second Report Wizard screen.
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Impromptu Report Wizard [ 7]

“whhat kind of report would pou like to create?

£ List report

For a crosstab report, you need either a
crosstab template or a list template

Cancal < Back | Meut > I Eitizh

11 Click the Next button.

12 The third Wizard screen asks you to place the available data (i.e., all of the data items in the
catalog) where you want to see it on the crosstab (i.e., columns, rows, cells).

e Open an appropriate folder in the Available data window by clicking the [+ to the left of the
folder.

e Select the data item you want to see as columns on your report by clicking on it once to
highlight it.

e Click the Column E' button in the center of the screen.

Impromptu Report Wizard ﬂ E

Place the available data where pou want it to appear in the crosstab.

Available data: Columns:
-~ Intake Start Date--AIIeg;I

- Investigation Close Dat

- Report Last Update Da

-~ Last Updated D ate-Alle B Cells

- Report Status Text-Alle
- Investigative Code-dlle
B Irwest Type Code-Alleg

im]
-] Reason Investigation C El
L]
=

- Investigation Classificat )
- Approved Determinatio
S} COMMECTIO 3
-7 Disposition Code--Alleg:
-~ Child Person ID-Allegat

9 Child Gender Code-Alle
-] Child Ethnicity/Race Cc»
KN S — 3 >

Cancel | < Back I TdERt | Fitarsky |

e Select the data item you want to see as rows in your report by clicking on it once to highlight
it.
e Click the Row button EI in the center of the screen.

o Select the data item you want to see as cells in your report by clicking on it once to highlight.

e Click the Cell button in the center of the screen.E
e Click the Next button at the bottom of the screen.

Note: Impromptu automatically summarizes the data item you select as your cell value. In most
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cases, Report Wizard will total the data item. Totals are not appropriate for most OCFS Data
Warehouse data, where unique ID codes should be counted rather than totaled. Unfortunately,
the Report Wizard does not provide an opportunity to change the summarization method. You
can, however, run the report and then change the total to a count.

Impromptu Report Wizard HE

Flace the available data where you want it to appear in the crosstab,
LColumns:

Available data: [-F] CONMECTIONS Aleg
-] CONNECTIONS Alleg

B Allegation Facts ﬂ
-] Case ID-Alegation Fac A I LI
-] Repart |D--&llegation F.
7 Intake Stage 1D-Alleg,
-7 Investigative Stage 1D-
-7 County Code-Allegatio
7 Uriit ID--Allegation Fact
-] Unit Code-&llegation F
- worker ID-Allegation F
-] worker's Role-Allegat
-7 Intake Code-llegatior
-7 Intake Type Code-tlle
-] Intake Start Date-allec

-7 Investigation Close Dat LI—I LI LI—I LI
-] Report Last Update Dz »
ol ’ >

Cancel | ¢ Back I Hewt > | Finish |

Bows: Cells:
- wiorker Name-‘warke R} T otal Repo

V=

It & |3 |5

13 The fourth Wizard screen asks you to define a filter. One of the limitations of the Report Wizard
is that it offers only the Report Columns on which to build a filter. You do not have Catalog
Columns, Functions, or any of the other components normally available in the Query dialog
box.

o |If the Report Columns contain data items that can be used to define a filter, build a filter for
your report (refer to Module 6 of this guide for detailed instructions).

o |f the Report Columns do not contain the data items you need to build a filter, run the report
without a filter. You can then invoke the Query dialog box and add a filter later.

Impromptu Report Wizard ﬂ m

Select a report column, an operator, and one or more values to define a filker.

Filtering namows your report to the data you require.

Available components: Filter definition:
[ worker Mame-wworker Dimensic L] ;I
0 COMMECTIONS Allegation Cody
[
4 | j [ElEar, |

Cancel < Back [ | Finish I

14 Click the Finish button at the bottom of the Wizard screen.

15 If the cell figures do not represent the values you wanted to see (e.g., totals of ID numbers rather
than counts), they can be changed.
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¢ Right click on any cell value on the report.
e Select Data Definition from the drop-down list.

¢ In the Expression window of the Data Definition dialog box, click on the summarization
method (i.e., total) at the beginning of the expression.

Expression:

Bl Feport ID-dllegation Fact | ...

o Press the Delete key on your keyboard.
e Open the Summaries folder in the Available components listing.

¢ Double click the summarization method you need in the report (e.g., count).

Data Definition

Mame:

ITota\ Report 1D--Allegation Fact

Bwailable components: Evpression:

B Summaries B [ Report ID--Allegation Fact .. 1=

total
mminimLm o |
maEximum
average
running-total
TUnhing-minimum
TURRING-MEHImLm
unning-average LI
TUnhing-count
moving-tatal = i iy | Clear
moving-average Tips
quantile Count d
rank Syntax: count [numeric_exp)
percentage LI Feturns the number of selected data LI

I™ Calculate before the summany filter

iz applied
0K I Cancel Help

e Delete the [<column or calculation>] by placing your cursor over each piece of the
Expression and pressing the Delete key on your keyboard.

Expressian:

||:|:-unt [ ey et ¥ E\Taly el | | Fieport |D--Allegation Fact ...

Expression:
| count [ Beport |D--&llegation Fact | ...

e Click the OK button at the bottom of the Query dialog box.

16 If you were not able to filter your report in the Report Wizard, you can do so now in the Query
dialog box

e Click the Query Data button on the toolbar. fﬂ]ﬂ
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e Click the Filter tab.

e You now have all of the components to build a filter, including Catalog Columns. Refer to
Module 6 of this guide for detailed instructions on building a filter.

e Click the OK button at the bottom of the Query dialog box.

Your crosstab report should now contain the data you originally wanted. Even though the Report Wizard
does not provide the ideal opportunities for structuring a crosstab, you can always correct the report using
the Query dialog box.

Date: 712502
Crosstab Example

Worker Marne--Worker Dimension | CDRG [ CHTS |EDNG |EMOT | EXCP |IFCES | INGD | LABYWY |LMED |LSUP [ PDRG [SWDS [ SHAB | ¥OTH | Total
Barnham Brenda 1 3 4
Barnham Holly 3 1 5 1 4 14
Coverdale Christine 1 5] 1 a
Coverdale Michelle 1 1 1 1 a 2 2 2B
Coverdale Robert 1 10 1 1 2 2 1 18
Doe Patricia 12 1 12 3 28
Doe,Raon 2 1 3
Fletcher, Stacia 1 4 1 51
Grimsby Jana 1 16 24 3 12 3l &9
Harding, Andrew 2 2 7 2 1 14

Building crosstabs using the Query dialog box:
1 Login to Citrix and open the Impromptu application.

2 Select Tools = Options on the menu bar.
3 Deselect the Use the Report Wizard to create standard reports option.
4 Click OK on the Options dialog box.

Options ﬂ E

General ] Start-up ] File Locations ] Data Farmat w Obiject Format \| Cvill Thraugh ]

~ Databa:
W Auto-attach to the database when the catalog is opened

¥ Retrieve database tables when ediing catalog tables

~ Grid
¥ Snap to gid Girid interval:
IU.1 1] Inches hd
r~ Upgrade

¥ Shaw the Catalog Upgrade dialog box
¥ Show the Beport Upgrade dislog box

™ ilse the Feport Wizard o create standard reports

™ Show advanced tabs in the Query dialog hox

¥ Always show catalog logon dislog

0K Cancel |

5 Click the New button on the toolbar.g

6 In the Open Catalog dialog box, navigate to the OCFS
Datawarehouse/DataWarehouse/Report Catalogs directory.
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Open Catalog

Look jn: | 3 Report Catalogs j & £ [EE-
: E@QETS.T;?W . ht Detai
% coghozcubes on ‘conncord]’ (%) [t Surnmary
|2 Datawarshouse
ort Catalogs atalog
=2 My Home Drive [T:]
icE Adrmissions Discharges

File name: I Open I
Files of kype: IEatangs [*.CAT] j Cancel |

EastFind | fddtoFastfind |
A

7 Select an appropriate catalog in the selection window.
8 Click the Open button.

9 Enter your Cognos User ID and Password in the appropriate windows of the Cognos Common
Logon dialog box.

10 Click the Log On button.
Coghos Common Logor defout |

Enter a user ID and password that iz valid for Cognos products.

Uszer ID:
|ag2365

Pazsword:

Log On I Cancel

11 Select the data items you want to see in your crosstab:
e Select the data item you want to see as rows first and add it to your Query data.
e Select the data item you want to see as columns second and add it to your Query data.
e Select the data item you want to see as values by clicking on it once.

¢ Click the Sum button in the center of the Query dialog box. Z

e In the Summary dialog box, click the summarization method you want to use (e.g., count).

e Click the OK button on the Summary dialog box.
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Summary of Report ID - Invest Fact

Label: K

ICount Report [0 - Invest Fact

Tatal @ Average

MirirLim
-
EI W awirnuim L Percentage

Cancel

=]
-]
[ x|

Count

. . . . Build Crozztab
12 Click the Build Crosstab button in the lower center of the Query dialog box.

Query HE
Data |Sort | Group | Fiter |

Catalog: Luery data:
F- Irwestigation Fact =] | "B Urit 1D - Irwest Fact
+ {1 Investigation Detail Fact E Meands Reporter Desc
{1 Geography Dimension g Count Report D - Invest Fact [for Mcands Fi
-0 Worker Dimension
{23 Role Dimension
-2 Unit Dimersion
D Approval Dimengion
D Stage Person Dimension
43 Reporter Relation Dimension
-] Reporter Relation Cd
[ Description Txt
[ Mecand: Reporter Cd
[ Mecand: Reporter Desc |

-] Mandated Ind LI 1 | I LI

Editefinition. . |
Data source:
ICatang vl Brawsze,. | Build Crosstab | et fan | reertion |

Cancel |

| v

K3

14

[t

13 If necessary, move data items from columns to rows or vice versa by clicking on the item, holding
your mouse button down and dragging them from the columns window to the rows window, or
vice versa.

14 If you want to see a summary row and/or column on your crosstab:
e Click on the data item in the Cell window.
e Click the Summarize button beneath the cell window,

¢ In the Summarization dialog box,

a. Click the arrow = to the right of the Summary type window.
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= Crozgtab summaries

Surmnmary hpe:

Count j

M ore

Count
b irirniLar
b asirnam
Averade

b. Select the appropriate summary type from the drop-down list.

c. Click the box to the left of Overall in the Column total window to get a summary
column.

d. Click the box to the left of Overall in the Footer total window to get a summary row.

Summatization - Count Report ID - Invest Fact EHE

r— Crogstab summaries

Summary type: LColumn tatal:
[Total =] [#averal
Foater total: -

- 1~ Preview
[Wveral

oK I Cancel |

15. Click the Filter tab. Note that you have all of the components normally available to build a filter,
including Catalog Columns. Refer to Module 6 of this guide for detailed instructions on building

filters.
Query HE
Crosstab I Sot  Filter |
Available components: Filter definition:
B + pear [ Intake Start Date - Invest Fact | = 2004 .. ;I
= -
o]
&/ >
B o _I
B and -
And | Or | Clear |
 Filter optian:
Filter lype:
IDetaiI ~| T Suspend the fiter
™ Eliminate duplicate rows
Tips:
Llze the available companents ta define or add to an expression. ;I

Cancel |

16. Click the OK button on the Query dialog box to run the report.
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Meands Reporter Desc 0221110 | 9225850 | 90952159 | 80954009 | 30554155 | 90955159 | 90955009 | 93950159 | Total
Anonymous or Unknown Reporters 3 1 1 7 B 1 21
Education Personnel 3 1 3 11
Friends and Neighbors 1 1 3
Legal, Law Enforcement or Criminal Justice Personnel 4 1 ]
Medical Personnel 1 =]
3
20
13
12
20
1
2 1B

Mental Health Personnel
Cther

COther Relatives

Parents

P b — [ —

=[5
mm[w |

Social Services Personnel

Substitute Care Providers

ol [ [ N N [ ) ) Y Y R

=
[
pa
[
o
[
-
-

Prompts

A prompt is a dialog box that asks the user to enter information when a report is opened. A report can
contain several prompts, which it uses to filter the report to retrieve only the data you want.

To create prompts, we will be using the Prompt Manager, which is a dialog box used to create, edit, and
store prompts for the currently active report. The Prompt Definition dialog box is what we will use to
actually name and define the prompt. The Prompt Manager is not available in the Impromptu Report
Wizard, so you will be building your report using the Query dialog box.

There are several types of prompts. A Type-in prompt requires the user to type in information. A Picklist
prompt requires the user to select items from a list. A picklist can include data items from the catalog,
from another report, or from a file in delimited ASCII format.

The prompt data are generally used in filters, so we will review how to add a prompt into a report filter.
Type-in prompts:

Type-in Prompts are the easiest prompts to set up. You need only enter a name and a message on the
Prompt Definition dialog box. You may also need to change the data type that is to be entered.
However, the user is required to enter the data, which must be entered in the exact same format as it is

found in the database. If your users are not familiar with the data, type-in prompts may not be the most
effective prompt type to be using.

Type-in prompts are generally used for date prompts, where the user is required to add a date or a range
of dates.

1 Login to Citrix and open the Cognos Impromptu application.
2 Select Tools = Options on the menu bar.

3 In the General tab of the Options dialog box, deselect the Use the Report Wizard to create
standard reports option.

4 Click OK on the Options dialog box.

5 Click the New button on the toolbar.g

6 In the Open Catalog dialog box, navigate to the OCFS
Datawarehouse/DataWarehouse/Report Catalogs directory.
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7 Select an appropriate catalog in the selection window. Refer to Appendix A for complete
descriptions of the OCFS DataWarehouse catalogs.

8 Click the Open button on the Open Catalog dialog box.

9 Enter your Cognos User ID and Password in the appropriate windows of the Cognos Common
Logon dialog box.

10 Click Log On.

11 Select the data items you want to see on the report. Refer to Module 6 of this guide for detailed
instructions on Selecting Data.

12 Click the Group tab and group those data items you want to see grouped in your report. Refer to
Module 6 of this guide for detailed instructions on Grouping Data.

13 Click the Sort tab and sort those data items you want sorted in your report. Refer to Module 6 of
this guide for detailed instructions on Sorting Data.

14 Click the Filter tab and enter a filter for your report. Refer to Module 6 for detailed instructions on
Filtering Data.

15 To insert prompts into your filter:

o Start out with the data item you want to use as the basis for your prompt (e.g., Home
Authorized To Date). Double click the data item to add it to the Filter definition.

e Select an operator from the Available components listing (e.g., between).
e Click Prompt Manager in the Available components listing.

o Type a name for your prompt in the Name window (e.g., “Date From”) of the Prompt
Definition dialog box.

o Type a message for the user in the Message box (e.g., “Please enter a start date”).
o Check the Data type to make sure it's appropriate for the prompt (e.g., date). To change the

data type, click the arrow ﬂ to the right of the Data type window and select the appropriate
type from the drop-down listing.

Drata type:

glring j

Ee= | Ln]
nurnber
date
time
date-time
interyal

e Click OK on the Prompt Definition box.
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Prompt Definition

M amne: Tvpe: lLI
D ate From I Type in [ Cancel |

Message:
Flease enter a starting date in pywyy-nim-dd format:

Data type:

Idate j

Default walue:
|2002-07-25

Advanced »» |

e Select the correct prompt in the Available prompts window of the Prompt Manager dialog
box.

e Click OK on the Prompt Manager dialog box.

Prompt Manager EH

Awailable prompts:

[Fageades. . |

Fieferences:

=] 0K |
- _'|LI Cancel |

o |If the filter is complete, click OK on the Query dialog box.

o |If the filter is not complete, follow the steps above to complete it. You can enter any number
of prompts in a single report, as in the example below, which uses two prompts to define a
date range for the Home Authorized To Date to determine the homes whose certification will
be expiring within a specified range of time.

Filter definition;

Home Authorized To Date-Foster Home Fact between YD ate
From? and 7Date To? W

¢ Click OK on the Query dialog box.
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Complete the Prompt dialog box.

o Note: Date prompts should be completed using the same format as the default dates which
appear in the dialog window. In other words, if the default date is in m/d/yy format, then the
user’s entry should be in m/d/yy format.

Prompks ﬂ E

Fleaze enter a starting date: ok I

[1/1/m2 | Cancel

Flease enter an ending date:

|5;31 /04 |

Catalog Picklist Prompts:

Picklist prompts require a more involved set-up, but are the easiest for users to complete. The user is
presented with a list from which to select data items on which to run the report. Catalog picklists display
all the values for a selected data item from which the user selects one or more values.

1 Login to Citrix and open the Cognos Impromptu application.

2 Select Tools = Options on the menu bar.

3 Inthe General tab of the Options dialog box, deselect the Use the Report Wizard to create
standard reports option.

4 Click OK on the Options dialog box.

Click the New button on the toolbar.g

In the Open Catalog dialog box, navigate to the OCFS

Datawarehouse/DataWarehouse/Report Catalogs directory.

7 Select an appropriate catalog. Refer to Appendix A for detailed descriptions of the OCFS Data

Warehouse catalogs.

Click the Open button on the Open Catalog dialog box.

If the Cognos Common Logon dialog box appears, enter your Cognos User ID and Password

in the appropriate windows.

10 Click the Log On button.

11 Select the data items you want to see on your report. Refer to Module 6 for more detailed
instructions on selecting data.

12 Click the Group tab. Refer to Module 6 for more detailed instructions on grouping data.

13 Click the Sort tab. Refer to Module 6 for more detailed instructions on sorting data.

14 Click the Filter tab and insert prompts into your filter.

e Select the data item you want to use as the basis for your filter. For example, if you want to
develop a report on children in care, but you want to allow the user to run the report based on
the Goal, you would select Goal to start your filter.
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e Select an operator for your filter. As in the above example, if you want to run the report on
only one specific goal, you would add the equal sign (=) to your filter. If you want the user to
be able to run the report on several goals, you would add in to the filter.

o Double click Prompt Manager in the Available components listing.

e Type a name for your prompt in the Name window (e.g., “Goal”).

e Click the arrow ﬂ to the right of the Type window.

e Select Catalog picklist from the drop-down list.

e Enter a message for the user in the Message box (e.g., “Please select Goal(s):”).
e Open an appropriate folder in the Catalog columns window by double clicking it.
e Select a data item from the folder listing.

i. If this data item is the one to be used to compare values in the database, click
the Use button beneath the Catalog columns window. The item is displayed in
the Currently using window.

ii. If you want to use one data item, but display another data item to the user, select
the display item in the folder listing and click the Display button. The item is
displayed in the Currently displaying window.

The Use/Display feature in picklist prompts is especially useful when using code data items. Users may
not know the definitions of the codes. You can use the Code item to retrieve the data, but display the
Description item to the user. Numerical data items are better choices for use, since numerical searches
require less processing time. For example, racial codes are found in Fact folders, but their descriptions
are found in the Ethnicity Dimension folder. You can use the Ethnicity Cd in your prompt, but display
Ethnicity Desc Txt to the user.

ii. If the same data item is to be used and displayed, select the data item in the
Catalog columns window and click the Use button beneath the window. The
data item will appear in both the Currently using and Currently displaying
windows.
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Prompt Definition 7 ||

Mame: Type: | K I
[Gioal Promet [ Catalog pickiis =l Cancel |
Message:

IF'Iease zelect goal(z):

Latalog columnz:
Leqal Status - Detail ﬂ

Agency - Detail

Office - Detai —1 Currently uzing:

Urit - Detail [Current Goal - Detail
Wwéorker - Detail

Current Goal - Detail

Currently displaying:

Emmmmmm

|Eurrent Gioal - Detail

Use | Display | [ Sortvaliies Advanced >>|

e Click OK on the Prompt Definition dialog box.
e Click OK on the Prompt Manager dialog box.

15 Click OK on the Query dialog box.

16 To open the catalog picklist in the Prompt dialog box, click the arrow j to the right of the
prompt window.

Prompts ﬂ E I
Please select goalls): ak. I

|Di

Cancel

Dizcharge to Parentz/Leqgal Guardian
Frevvent Placement
Frevent Return o Placement

o To select more than one value on the picklist, hold your Ctrl key down and click on each
value.

17 Click OK on the Prompt dialog box to execute the query.
Report Picklist Prompts:

Report picklist prompts require a separate Impromptu report to be created first. It is important that the
picklist report be saved in the same directory or folder as the report using the picklist. Report picklists are
especially useful when you need to manipulate the data in some way. For example, if you want to present
the user with a list of Child CIN’s with the child’s name from which to select, you could develop an
Impromptu report with that information and use it as a prompt for a more detailed report.
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1 Login to Citrix and open the Cognos Impromptu application.
2 Select Tools = Options on the menu bar.

3 On the General tab of the Options dialog box, deselect the Use the Report Wizard to create
standard reports option.

4 Click OK on the Options dialog box.

5 Click the New button on the toolbar.g

6 In the Open Catalog dialog box, navigate to the OCFS
Datawarehouse/DataWarehouse/Report Catalogs directory.

7 Select an appropriate catalog in the selection window. Refer to Appendix C of this guide for
detailed descriptions of the OCFS Data Warehouse catalogs.

8 Click the Open button.
9 Select the data items for your report.

10 Define calculated columns for your report:

e Click the Calculate button in the center of the Query dialog box.

e Type a name for your calculation in the Name window of the Calculation Definition dialog
box.

e Build your calculation. For example, if you wanted to present users with a list of Child CIN'’s
and Child Names, you would select Child CIN and Child Name as data items on your report.
The calculation (Child CIN + Child Name would be built as follows:

e Double click Report Columns.
e Double click Child CIN.
e Double click string.

o Enter space — dash — space between the two quote marks in the Expression
window.

e Press the Enter key on your keyboard.
o Double click the plus sign (+).
e Double click Report Columns.
¢ Double click Child Name.
e Click OK in the Calculation Definition dialog box.

11 If you want a specific sort in your report, click the Sort tab and select the data item you want to
sort by, and then click Ascending or Descending. Generally speaking, prompt reports provide
lists from which users select values for use in filtering reports. Such lists can be sorted to make it
easier for users, but they should not be grouped. For example, on the Child CIN-Child Name
example, we could sort numerically by Child CIN.

e Select Child CIN in the Sort order window.
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e Click the Ascending button beneath the Sort order window.

12 Click the Filter tab of the Query dialog box and build a filter for your report, if necessary. Refer to
Module 6 for detailed instructions on building filters.

13 Click OK on the Query dialog box.
14 Click File © Save As on the menu bar.

15 In the Save As dialog box, navigate to an appropriate folder on your T: Drive. You will have to
save the report using this report picklist in the same folder.

16 Type a name for your report in the File name window. Make it easily recognizable as a Report
Picklist report (e.g., “Prompt Report”).

17 Click the Save button.

18 Select File & Close on the menu bar.

19 Click the New button on the toolbar.g

20 Select data for your report. Refer to Module 6 of this guide for detailed instructions on selecting
data.

21 Click the Sort tab. Refer to Module 6 of this guide for detailed instructions on sorting data.
22 Click the Group tab. Refer to Module 6 of this guide for detailed instructions on grouping data.
23 Click the Filter tab.

24 Build a filter using a report picklist prompt. For example, using the Child CIN-Child Name report
picklist:

e Open the Report Columns folder in the Available components listing.

e Select Child CIN and add it to your filter. Note: You can use Catalog Columns to retrieve
data items not appearing on your report.

e Double click the equal sign (=) in the Available components listing.

e Double click Prompt Manager in the Available components listing.

e Type a name for your prompt in the Name window of the Prompt Definition dialog box (e.g.,
“CIN/Name”).

e Click the arrow = to the right of the Type window.

o Select Report picklist from the drop-down list.

o Enter a message for the user in the Message window (e.g., “Please select a child”).

e Click the Browse button to the right of the Report window.

¢ Inthe Open dialog box, navigate to the folder on your T: Drive where you saved your picklist
report.

e Select the picklist report in the selection window.

e Click the Open button.
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e Select Child CIN in the Report data window.

e Click the Use button beneath the Report data window.

e Select Child CIN/Name in the Report data window.

¢ Click the Display button beneath the Report data window.
e Click OK on the Prompt Definition box.

Prompt Definition EH
Mame: Tvpe: —ID K
[crild | Report picklist i Cancel |
tlessage:

IF'Iease zelect a child:

Report;
IT:\EIEFS [ ata " arehouse Prompt Bptimr Browze... |
Report data: o i s
- - urrently uzing:
Child CIM - Detail - -
Child Narme - D etail [Child CIN - Dietai

Currently displaving:
|Chilc| CIM/Mame

¥ | Gortvalies Advanced >» |

¢ Click OK on the Query dialog box.
25 Click OK on the Query dialog box.

26 To open the report picklist, click the arrow = to the right of the prompt window.
27 Select an item from the list (use your Ctrl key to select more than one item, providing in was
used in the filter).
Prompts EHE|

Please select a child: ok I
Cancel |

IGD1 2110 - WARMER LEOMARD
IG.J33E5G - BARMHAM ALESSA E

28 Click OK on the Prompt dialog box.

IfI Then/Else Conditional Statements

If/ Then/Else refers to a conditional statement used to manipulate data. In other words, data is not in the
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format you want to see it in on the report. For example, the OCFS Data Warehouse is full of codes.
Instead of displaying codes on the report, perhaps you’d rather display the descriptions of the codes. You
can manipulate that data using the If/Then/Else conditional statement.

If Then/Else statements are formatted by stating a condition, what happens if the condition is met, and
what happens if the condition is not met. If the condition is true, then one operation is performed; if the
condition is false, then another operation is performed. For example, if the Activity Cd in the Admissions
and Discharges Catalog is ‘M910’, then that denotes an admission. Any other Activity Cd is considered a
discharge. We can convert the Activity Cd to read ‘Admission’ or ‘Discharge’ with the statement:

if (Activity Cd = ‘M910’) then (‘Admission’) else (‘Discharge’)

In other words, if the Activity Code on the record is M910, then print the word “Admission” in the column.
If the Activity Code is anything other than M910, then print the word “Discharge” in the column.

If/Then/Else conditional statements are considered calculations in Impromptu, so you must use the
Calculate feature to build the statement. Also, If/Then/Else statements are not available in the Report
Wizard.

Assuming you have started a new report in Impromptu and now want to add the If/Then/Else referenced
above:

Click the Calculate button in the center of the Query dialog box.

2 Type a name for your calculated column in the Name window of the Calculation Definition
dialog box.

Double click if in the Available components listing.

4 Now build the "true” statement inside the parentheses. Using the above example:

a. Double click Report Columns (Catalog Columns if the data item needed is not on your
report) in the Available components listing.

b. Double click Activity Cd to add it to the Expression.

c. Double click the equal sign (=).

d. Double click string.

e. Type “M910” between the two quote marks in the Expression window.
f. Press the Enter key on your keyboard.

g. Double click the closing parenthesis ) in the Available components listing.

5 Now enter what you want to have happen if the preceding statement is true. As in the above
example, if the Activity Code on a record is M910, we want the word “Admission” to appear in the
column:

a. Open the Value folder in the Available components listing.
b. Double click string to add it to the Expression.

c. Type “Admission” between the two quote marks in the Expression window.
d. Press the Enter key on your keyboard.

e. Double click the closing parenthesis ) in the Available components listing.
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6 Now enter what is to happen if the preceding statement is not true. As in the example, if the
Activity Code is anything but M910, we want the word “Discharge” to appear in the column:

c o

13

Double click string.

d. Press the Enter key on your keyboard.

Double click the opening parenthesis (in the Available components listing).

Type “Discharge” between the two quote marks in the Expression window.

e. Double click the closing parenthesis ) in the Available components listing.

Espressian:

|if Activiy Cd = 'M910 ] then [ 'ladmizsion | elwe [ Discharge
]

7 Click OK on the Calculation Definition dialog box.

8 Click OK on the Query dialog box to execute the query.

You can now use this calculated column like any other column in the report. You can group, sort,
or use it as a header.

Summary Filters

Cin Id Child M Activity Dt Child Status Cd | Age Mbr
Admission
FOHIYS10 [SPEMCER JR RUSSELL J 31T 12:004M oa 19
FOA4BE7N [JESSUP RUTH 1088 120040 |03 17
FHN265T [SPEMCER AMANMDA R 21957 12:0048 |08 15
FHBE720% [KEMMEDY SHAKEETA 122087 12:0040 |04 16
FHE2350G [WARMER JR DARYLJ 4/28/95 12:0048 |05 18
FTES427M [DOE JAMNEL B/19/97 12:0048 |05 16
FZE341EH [OWENS MARGARET J 112197 12:00AM |07 19
FWWBE125L [ALSTOMN AMY L 32787 1200488 |04 15
FuBE1260 [ALSTOMN AMY L G/7 S8 12:00AM o7 13
FOCE128H [ROSS JASON T1ATET 12:0040 |04 15
FOF32240 [LAWREMNCE CHARLES L G/25/95 12:00408 |04 15
FOJE313L [DOE AMY G/22/01 12:00488 |08 19

Filters can be applied to summary data items using the Summary filter function in Impromptu. We have
been using detail filters, which apply one or more conditions to each row of data. If the conditions are true
for a row, that row is retrieved for the report; if the conditions are not true, the row is not retrieved.
Summary filters are applied to summary data items only. For example, if you develop a summary
calculation that counts the number of CPS reports per unique Case ID, you could then apply a summary
filter against that count to retrieve only those counts that are 3 or higher per Case ID. Summary data

items (such as counts, totals, etc.) are not available for use in detail filters.

Using the above example, the following instructions should be followed to apply a summary filter in a

report:
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1 Login to Citrix and open the Cognos Impromptu application.

2 Select Tools = Options on the menu bar.

3 On the General tab of the Options dialog box, deselect the Use the Report Wizard to create
standard reports option.

4 Click OK on the Options dialog box.

5 Click the New button on the toolbar.g

6 IntheO

pen Catalog dialog box, navigate to the OCFS

Datawarehouse/DataWarehouse/Report Catalogs directory.

7 Select an appropriate catalog in the selection window (e.g., Investigations Catalog).

8 Click the Open button.

9 Select the data items for your report (i.e., from the Investigation Fact folder — Case ID).

10 Add a summary data item to your report. For example, in the example above:

a.

Select Report ID in the Catalog window by clicking on it once.

Click the Sum button in the center of the dialog box. =

In the Summary of Report ID dialog box, click Count.
Click OK on the Summary dialog box.
(2] ]

Summary of Report ID - Invest Fact

Label:
ICount Report 1D - Invest Fact

Cancel

i

11 Click the Filter tab.

Tatal @ Average
beitirnum | Count

B
b aximLim Percentage

12 In the Filter options section of the dialog box, click the arrow ﬂ to the right of the Filter Type

window.

Filber cpticrs
Filber bype:
| Detai w| T Suspend the filter

13 Select Summary from the drop-down list.
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14 Double click Report Columns in the Available components listing.

15 Select the summary data item you created in step 10 (i.e., Count Report ID) and add it to your
filter definition.

16 Select an appropriate operator (=, <>, <, <=, >, >=) and add it to your filter.
17 Double click number in the Available components listing.
18 Type a number over the default zero in the filter definition.

19 Press the Enter key on your keyboard.

Query
Data I Sort I Gioup  Filter |
Ayailable components: Filter defirition
& + Count Report ID - Invest Fact >= 3 ;I
= -
= -
® / >
E o
E and =i
And Or Clear
~ Filler option
Filler type
Surirnary 'I ™ Suspend the filter
™ Eliminate duplicate rows
Tips:
Llze the available components to define or add to an exprezsion. ;I
=l
|

20 Click OK on the Query dialog box to run the report.

Case ID - Invest Fact | Count Report 1D - Invest Fact
3296250
11232830
162765860
24278950
30288570
36283950
42250370
472563530
43215550
A02395930
57247500
59215550
59930521
B4213520
56232410
8E260230

[ g - e R e R R A R N AN RN ]
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Appendix A:
Impromptu Catalogs

Appendix A1:
Allegations Catalog

This catalog contains all CPS investigation information with allegation details.

Geography Folder

Describes the counties associated to investigations and allegations. See Geography Folder,
page 25 for details.

Allegation Facts
Contains detailed data of actual allegations.

All Races & Ethnicity Folder
Contains details of the race and ethnicity codes and their descriptions

Role Folder
Contains descriptions of all roles played by victims, subjects, reporters, and workers

Subject Folder

Contains demographic information for the perpetrator [subject] assigned to investigations and
allegations

Unit Folder
Contains demographic details about the units associated to investigations and allegations

Child Folder
Contains demographic information on the victim in allegations and investigations
Worker Folder

Describes the individual workers assigned to investigations and allegations

Allegation Folder
Contains descriptions of specific allegations of child abuse/neglect

Reporter Relation Folder
Describes the role of the reporter of the alleged child abuse/maltreatment

Data As of Date Folder

Provides the dates on which the Allegations data mart was updated with data from the
CONNECTIONS and CCRS systems. See Data As Of Folder, page 35 for detailed information.

Subject Stage Person Folder
Contains descriptive details of the subject in each Stage of a case

Child Stage Person Folder
Contains descriptive details of the child in each Stage of a case
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Appendix A2:
Foster Home Catalog

Foster Home Agency Folder

Provides descriptive details for the agency with which the resource is associated
Foster Home Sub Agency Folder

Provides descriptive details for the sub-agency with which the resource is associated
Geography Folder

Provides descriptive details of the counties associated to foster and adoptive care. See
Geography Folder, page 25 for details.

Foster Home Fact

Contains detailed data for all resources designated as foster home care facilities
Worker Folder

Provides descriptive details for the workers associated with Foster and Adoptive Homes
Foster Home Race & Ethnicity Folder

Provides descriptive details on the race or ethnicity of the Resource
Home Member Racial Folder

Provides descriptive details on the race or ethnicity of the members of the Resource
Home Member Folder

Provides descriptive details about the members of foster homes
Foster Child Folder

Provides descriptive about the foster child
Child Placement Agency Folder

Provides descriptive details about the agency which placed the child
Worker Agency Folder

Provides descriptive details of the agency to which the worker belongs
Data As Of Date Folder

Provides the latest dates on which the data warehouse was updated with CONNECTIONS and
CCRS data See Data As Of Folder, page 35 for detailed information.
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Appendix A3:
Investigations Catalog

Geography Folder

Provides descriptive details of the counties associated to foster and adoptive care. See
Geography Folder, page 25 for details.

Worker Folder

Describes the individual worker associated with investigations
Role Folder

Contains descriptions of all roles played by victims, subjects, reporters and workers
Unit Folder

Contains demographic details about the units associated to investigations and allegations
Investigation Detail Folder

Contains detailed data for actual CPS Reports
Approval Folder

Contains the details of approvals made on CPS Reports and Stages
Stage Person Folder

Contains descriptive details of the various individuals in each Stage of a case
Investigation Fact Folder

Contains detailed data for actual CPS Reports
Reporter Relation Folder

Contains descriptive details of the individual who reported the case
Data As Of Date Folder

Provides the latest dates on which the OCFS Data Warehouse was updated with data from
operational systems. See Data As Of Folder, page 35 for detailed information.
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Appendix A4:
CCRS Related Catalogs

Admissions and Discharges Summary Catalog

This catalog can be used to obtain aggregate and child specific information on children in the custody of
the local Commissioner of Social Services admitted or discharged from foster care during a user-defined
time period. This catalog contains the last five full years of data plus the current year to date.

Summary

Total number of children whose records include an M910 for admissions (or M990, M999 for
discharges) movement code.

Case Folder

Contains current CCRS case-level information, including WMS Case address
Child Folder

Contains current information for all children
Movement Folder

Contains all movement activity (M910, M990 or M999) codes for a child
Activity Detail Fact Folder

Contains detailed data for admissions and discharges.
Geography Folder

Provides descriptive details of the counties associated to foster care cases. See Geography
Folder, page 25 for details.

Race & Ethnicity Folder

Provides descriptive details of racial origin and ethnicity.
Facility Folder

Contains detailed information on facilities from CAPS RESOURCE.
Agency Folder

Provides descriptive details of agencies associated with admissions and discharges within the
Child welfare and foster care systems. See Agency Folder, page 10 for detailed information.

Data As Of Folder

Provides the latest date on which the OCFS data warehouse was updated. See Data As Of
Folder, page 35 for detailed information.
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In Care Detail Catalog
This catalog can be used to obtain aggregate and child specific information on children currently in the
custody of the local Commissioner of Social Services.

Agency Folder

Provides descriptive details of agencies associated to admissions and discharges. See Agency
Folder, page 10 for detailed information.

Detail Folder

Contains detailed information about placements and legal activities.
Case Folder

Contains current CCRS case-level information, including address.
Child Folder

Contains one record for each child who is currently in placement.
Facility Folder

Contains detailed information on facilities from CAPS RESOURCE.
Case Individual Folder

Contains current detailed information for individuals associated to a case.
Movement Folder

Contains detailed information on movement activities.
In Care Detail Fact Folder

Contains detailed information on the placements of children.
Geography Folder

Provides descriptive details of the counties associated to placement cases. See Geography
Folder, page 25 for details.

Legal Folder
Contains legal activity details for children.
Legal Modifier A Folder

These variables contain specific information associated with each activity code. Consult your
CCRS Coding Guide.

Legal Modifier B Folder

These variables contain specific information associated with each activity code. Consult your
CCRS Coding Guide.

Legal Modifier C Folder

These variables contain specific information associated with each activity code. Consult your
CCRS Coding Guide.
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Legal Modifier D Folder

These variables contain specific information associated with each activity code. Consult your
CCRS Coding Guide.

Ethnicity Folder
Provides descriptive details of racial origin and ethnicity.
Data As Of Folder

Provides the latest date on which the OCFS data warehouse was updated. See Data As Of
Folder, page 35 for detailed information.
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In Care Summary Catalog

This catalog can be used to obtain legal and placement aggregate and child specific information on
children in the custody of the local Commissioner of Social Services during a user-defined time period.
This catalog contains the last five full years of data plus the current year to date.

Summary Folder

Contains aggregate demographic and location information for children who have been in care at
some point in the past 5 years.

In Care Summary Fact Folder
Contains child-level information on placements for the past 5 years.
Geography Folder

Provides descriptive details of the counties associated to foster care cases.) See Geography
Folder, page 25 for details.

Disposition Lookup Folder
Please consult your CCRS Coding Guide for specific information concerning these variables.
Agency Folder

Provides descriptive details of agencies associated to admissions and discharges. See Agency
Folder, page 10 for detailed information.

Facility Folder

Contains detailed information on facilities from CAPS RESOURCE.
Race and Ethnicity Folder

Provides descriptive details of racial origin and ethnicity.
Movement Folder

Contains detailed information about movements.
Case Folder

Contains current CCRS case-level information, including address.
Child Folder

Contains current information for all children.
Data As Of Folder

Provides the latest date on which the OCFS data warehouse was updated. See Data As Of
Folder, page 35 for detailed information.
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CCRS Services Report Catalog

This catalog is used to obtain all service case information concerning children who have been in
placement or are currently in placement.

Data As Of Folder
Provides the latest date on which the OCFS data warehouse was updated.

Key Dates and Derivations
This folder contains Key dates for the children in placement. These dates include Time in Care at
Discharge, Most Recent Admission, Most Recent Discharge, ASFA Time in Care etc.

Child Folder
Contains current information for all children.

Case Individual Folder
Contains current detailed information for individuals associated to a case

Case Folder
Each item in this folder contains either CCRS or WMS Case Data. This is one record per case in
this folder.

Service Assessment Folder
Contains all service assessment information for the child

Child’s Current Agency Info Folder

Contains detailed information on the Agency associated with the child’s current placement. Agency
data is from Connections. In Connections Agencies are coded ‘05’ in the CD_RSRC_TYPE column
on the CAPS Resource table.

Child’s Current Facility Info Folder
Contains detailed information on the child’s current facility from CAPS RESOURCE.

Movement Folder
Contains all movement activity ( M910, M990 or M999) codes for a child
Movement Facility Info Folder

Contains detailed information on facility associated with the Movement Code from CAPS
RESOURCE.

Movement Facility’s Owner Agency Info Folder

Contains detailed information on the owner Agency of the Facility associated with the
movement code. Agency data is from Connections. In Connections Agencies are coded
‘05’ in the CD_RSRC_TYPE column on the CAPS Resource table.

Page 19-8 OCFS Data Warehouse Reporting
rev 08/2004 Impromptu Step-by-Step Guide



Legal Folder
Contains legal activity details for children.
Legal Modifier A Folder

These variables contain specific information associated with each activity code. Consult your
CCRS Coding Guide.

Legal Modifier B Folder

These variables contain specific information associated with each activity code. Consult your
CCRS Coding Guide.

Legal Modifier C Folder

These variables contain specific information associated with each activity code. Consult your
CCRS Coding Guide.

Legal Modifier D Folder

These variables contain specific information associated with each activity code. Consult your
CCRS Coding Guide.

Adoption Folder
Contains all adoption activities.
Goal Folder

Contains all goal (G000, G100, G200, G250, G400, G600, G700, G800, G850, G900, G903, G912,
G918, G920 & G999) activities.

Geography Folder

Provides descriptive details of the counties associated to a case.
Activity Detail Fact Folder

Contains all activity details for the child

In Care Detail Fact Folder

This folder contains child specific information on children currently in the custody of the local
Commissioner of Social Services.

In Care Summary Fact Folder

This folder contains child specific information on children in the custody of the local Commissioner of
Social Services during the last five full years plus the current year.
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FOLDER DEFINITIONS
Agency Folder

Contains detailed information on all Agencies in Connections. In Connections Agencies are coded ‘05’ in
the CD_RSRC_TYPE column on the CAPS Resource table.

This folder is included in all CCRS related and Out of Home settings catalogs

Agency ID — Unique identification number assigned to the agency by New York State. This data element
from NBR_RSRC_AGENCY_ID

Agency Contact Name — Name of the agency contact person. This data element from
NM_RSRC_CONTACT

Agency Certification Date — The date on which the agency was certified (licensed). This data element
from DT_RSRC_CERT

Agency Authorization To Date — The date on which the agency’s authorization expires. The only time
an agency’s authorization will expire is when the agency is new and on probation. After the first re-
authorization then the agency remains open until closed. This data element from CD_RSRC_CERT_BY

Agency Close Date — The date on which the agency was closed. This data element from

Agency Type Code — This code indicates whether the Agency is a District (D) or Voluntary Agency (V).
This data element from CD_RSRC_AGENCY_TYPE

Agency Status Code — The operational status of the agency (active or Inactive). This data element from
CD_RSRC_STATUS

Agency Name — Name of the agency. This data element from NM_RESOURCE

Agency Address Line 1 — first line of the agency's address. This data element from
ADDR_RSRC_ST_LN_1

Agency Address Line 2 — Second line of the agency’s address. This data element from
ADDR RSRC_ST LN 2

Agency City Address — city in which the agency is located. This data element is from
ADDR_RSRC_CITY

Agency NYC Community District Code — community board district code that is generated by the geo-
coding interface on the FAD and Resource director address windows. Community district is calculated for
new York city addresses only. This data element is from ADDR_RSRC_CMNTY_DIST

Agency State Code — abbreviated code for the state in which the agency is located. This data element
is from CD_RSRC_STATE

Agency Zip Code — numeric ZIP code for the agency. This data element is from ADDR_RSRC_ZIP

Agency Address County Code — County in which the Agency is physically located. This data element
is from CD_RSRC_CNTY

Agency Phone Number — phone number for the agency. This data element is from
NBR_RSRC_PHONE
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CCRS Child Folder
This folder contains one record for each child who has ever been in placement. This folder is included in
all CCRS-related catalogs.

Child CIN ID — System-generated number that uniquely identifies an individual child in CCRS
Child Name — The name of the child.
Child Sex Code — Sex of the child.

Child Charge Indicator — Indicates the government (state or federal) assuming fiscal responsibility for
the child and why.

Child JD/PINS Indicator — Indicates a child adjudicated as a JD (Juvenile Delinquent) or PINS (Person
In Need of Supervision). The code is necessary for post-authorization claiming purposes.

Child Location Code — Indicates physical location of the child.
Child District Agency Plan ID — The district or agency with planning responsibility for the child.

Child Individual Status Code — Indicates the status of each individual who has significance to the case
(not limited to the applicant and recipients).

Child Status Code — Indicates the current status of the child.

Child Original School District ID — Identifies the school district in which the child resided at the time of
first placement.

Child Current School District ID — Identifies the child's current school district while in placement or
receiving preventive services.

Child Auth Agency 1 ID — Identifies the controlling corporate unit or entity of one or more child-care
facilities.

Unit 1 ID — Identifies the unit within the agency to which the child's case belongs.
Worker 1 ID — Identifies the worker assigned to the child's case.

Worker Function 1 Code — Identifies the casework function associated with each district or agency
worker with responsibility for the child's case.

Auth Agency 2 ID — Identifies the controlling corporate unit or entity of one or more child-care facilities.
Unit 2 ID — Identifies the unit within the agency to which the child's case belongs.
Worker 2 ID — Identifies the worker assigned to the child's case.

Worker Function 2 Code — Identifies the casework function associated with each district or agency
worker with responsibility for the child's case.

Auth Agcy 3 ID — Identifies the controlling corporate unit or entity of one or more child-care facilities.
Unit 3 ID — Identifies the unit within the agency to which the child's case belongs.
Worker 3 ID — Identifies the worker assigned to the child's case.

Worker Function 3 Code — Identifies the casework function associated with each district or agency
worker with responsibility for the child's case.

Auth Agcy 4 ID — Identifies the controlling corporate unit or entity of one or more child-care facilities.

Unit 4 ID — Identifies the unit within the agency to which the child's case belongs.

OCFS Data Warehouse Reporting Page 19-11
Impromptu Step-by-Step Guide rev 08/2004



Worker 4 ID — Identifies the worker assigned to the child's case.

Worker Function 4 Code — Identifies the casework function associated with each district or agency
worker with responsibility for the child's case.

Auth Agency 5 ID — Identifies the controlling corporate unit or entity of one or more child-care facilities.
Unit 5 ID — Identifies the unit within the agency to which the child's case belongs.
Worker 5 ID — Identifies the worker assigned to the child's case.

Worker Function 5 Code — Identifies the casework function associated with each district or agency
worker with responsibility for the child's case.

Plan Type Code — Identifies the plan type for the latest service assessment done for the child. It
expresses the relationship of a specific plan to the mandatory plan submittal sequence.

Child Facility ID — Identifies the facility where the child is currently placed.
Child Facility Type Code — Identifies the type of facility where the child is currently placed.

Child Claiming Category Code — Identifies the appropriate federal or state category denoting the
federal title or state allocation from which the cost of services is reimbursed.

Service Recipient Eligibility Category Code — Identifies the categorical relationship, income eligibility,
or financial ineligibility of an individual member of a services family unit or case designated for purposes
of services financial eligibility.

Child’s CCRS Case Status Code — Status of the CCRS case.

Service Type Code — Identifies the type of service as defined in Title XX and annual CASSP available
to eligible individuals displaying a need.

Child’s CCRS Case District ID — The state-assigned code identifying the local social services district
currently controlling the child's case.

Acct Number — The child's social security number.
Birth Date — The child's date of birth.

Plan Date — Date on which the latest service assessment plan for the child was completed, as indicated
by the current planning worker.

Individual Next Plan Date — Date on which the next service plan for the child is due.
Facility Date — Date on which the child was admitted to the facility.
Transaction Date (TID) — Date on which a specific record was entered.

Track Start Date — The date on which the child, or someone acting on his/her behalf, requested
adoptive, foster care, and/or preventive services.

Track Close Date — Date on which adoptive, foster care, and/or preventive services for the child were
closed.

Child’s Case Initiation Date (CID) — Date on which the child's case was first initiated.

Child’s Case Authorization Period Start Date — The period-from date for which the child's case has
been authorized.

Child’s Case Authorization Period End Date — The period-to date for which the child's case has been
authorized.
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Agency ID — Identifies the agency with primary responsibility for the child's case.

Child Goal Code — The current permanency-planning goal from the child's current service assessment.
Child Race Code — Identifies the racial origin of the child.

Child Ethnicity Indicator — Identifies whether the child is of Hispanic origin.

Child Current Legal Status Code — Current legal status of the child, based on legal activity.

Child Current Age Number — Child's current age in years, based on the date of birth.

Child’s Sibling Count — Number of the child's siblings in the CCRS case.

Child Siblings in Placement — Number of the child's sibling currently placed in foster care.

Child Line Number — The line number of the CCRS application on which the child is listed.

Child CCRS Case ID — The district-assigned number that uniquely identifies the child's case within the
district or responsible state agency.

Case Name — The name by which the child's case is currently identified (usually Line 1 of the CCRS
application).
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CCRS Case Folder
Each column can contain either CCRS or WMS Case Data. There is one record per case in this folder. This
folder is included in all CCRS-related catalogs

Case ID — The district-assigned, 10-digit case number that uniquely identifies the case within the district,
or responsible state agency. Can contain Alpha Characters; in counties where a case number for one
case type may be duplicated for another case type, the inclusion of an A for ADC, or H for HR, or M for
MA etc may have been used to make the number unique within the district. This data element is taken
from 01_050_CASE_NO.

Case District ID — The state-assigned district code that identifies the local social services district
currently controlling the input transactions for the case. This data element is taken from
01_010_JUR_TRNSCTNL_RESP.

Case Office ID — Identifies the office within a district that has responsibility for the case, often referred to
as satellite offices, district offices, IM centers, etc. This data element take from 01_020 local_office

Case Unit ID — Used within a district to identify the unit currently responsible for the case. This data
element taken from 01_030_resp_unit

Case Worker ID — Used within a district to identify the worker currently responsible for the case. From
01_040_resp_worker

Case CCRS Status Code — Indicates the status of the case. This data element is from
36_003 CCRS_CASE_STATUS calculation if 36_003 ccrs_case_status = 01 then “Y” else if 02 then “N”

Case CCRS Indicator — Indicates the presence of CCRS information. This data element is from
023 490 ccrs_ind

Codes
C | CCRS Involvement in Case N | Delinquent (JD) Remand
D | Day Treatment Services O | Neglect Remand (non CPS)
E | Direct Intensive Preventive Service Program | P | PINS Remand; Q= Delinquent (JD)
(PEG) Commitment/Placement
F | Home Aide From Emergency Children's Q | Delinquent (JD) Commitment/Placement

Services (ECS)

G | Home Aide From Emergency Children's R | PINS Commitment/Placement
Services (ECS)

H | Purchased Preventive Services S | Delinquent (JD) Placement NYS/DFY for
Replacement with SSC

I | Family Services (Direct) T | Court-Ordered Evaluation (docket code other
than “N” neglect)

J | Foster care Services U | Court-Ordered Investigation

K | Maternity Shelter V | Court-Ordered Supervision

L | Foster care-Emergency Children’s Services | W| Closed Case Service

M | PINS Warrant X | Home Evaluation

Y | Referral for Services to Other Community or
Social Service Agency
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Case Initiation Date (CID) — The date on which the case was first initiated. This data element from
36_183_CID

Case Transaction Date(TID) — The date on which a particular entry was made. From
36_001_TRANSACTION_DATE

Case Original WMS Application Date — Date on which application was received for assistance and/or
care, as defined by the program for which application is made. This data element is from
36_090_applctn_date

Case Name — The name by which the child's case is currently identified (usually Line 1 of the WMS
application) from 01_070_case_name

Case Street Address — Street of the residential address from the WMS case
Case City Address — City of the residential address from the WMS case
Case State Code — State of the residential address from the WMS case

Case Zip Code — Postal ZIP code of the residential address from the WMS case
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In Care Detail Fact Folder

Contains detailed information about placements. This folder is included in the In Care/Legal Summary

and Detail Catalogs
CINID

Child Name

Case ID

District ID

Current Facility ID
Worker ID

Unit ID

Office ID

Agency ID

Sex Code

Race Code
Ethnicity Ind

Goal Code

Goal Text

Child Status Code

Current Legal Status
Code

Current Facility Type
Code

Current Age Number

Current Age Group
Text

Sibling Count
Sibling Placed Count

ASFA Time In Care
Number

Foster Care Admission
Date

Facility Admission Date

System-generated number that uniquely identifies an individual child in CCRS

Name of the child.

The district-assigned number that uniquely identifies the case within the
district, or responsible state agency, associated with the child

State-assigned code identifying the local social services district currently
controlling the case.

Identifies the facility in which the child is currently placed.
Identifies the worker currently responsible for the child’s case.
Identifies the unit currently responsible for the child’s case.
Identifies the office currently responsible for the child’s case.
Identifies the agency from the most recent placement of the child.
Sex of the child.

Racial origin of the child.

Indicates whether the child is of Hispanic origin.

Code for permanency-planning goal from the child’s latest service
assessment.

Text description of the permanency-planning goal from the child’s latest
service assessment.

Child’s current status in CCRS.

Identifies the child’s current legal status.

Type of facility in which the child is currently placed.

Child’s current age in years.

Age range in which the child belongs.

Number of siblings in the child’s case.
Number of the child’s siblings who are currently in foster care.

Current length of time in months that the child has spent in care, based on
ASFA guidelines.

Date of the most recent placement for the child.

Date on which the child entered care at the current facility.
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Agency Admission Date on which the child entered care at the current agency.
Date

Birth Date Child’s date of birth.

Next Hearing Date Date scheduled for the child’s next court hearing.
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Case Individual Folder

Contains current detailed information for all individuals associated to the Services case of a child in
placement. This folder is included in the In Care/Legal detail and CCRS Services Report Catalogs.

District ID

Zip Code

Middle Initial Name
Line Number

Sex Code

WMS Individual Status
Code

CCRS Individual Status
Code

Location Code
Race Code
Religion Code
Prim Lang Code
Track Indicator

Relationship Line 1 No
Text

Relationship Qualifier 1
Code

Relationship Line 2 No
Text

Relationship Qualifier 2
Code

Relationship Line 3 No
Text

Relationship Qualifier 3
Code

Birth Date
Transaction Date
First Name
Last Name

Facility Case Name

Facility Type Code

State-assigned code identifying the local social services district currently
controlling the case.

Zip code of the individual

Middle initial of the individual’s name.

The line number of the CCRS application on which the individual appears.
Sex of the individual.

Current status of the individual in WMS.

Current status of the individual in CCRS.

Code indicating physical location of the individual.

Racial code for the individual.

Code for the religion of the individual.

The primary language, if other than English, of the individual.
Indicates that the individual is being tracked in CCRS.

Line number of each child’s mother, father, or significant other person.

The relationship of the associated line number to the child on whose line it
appears.

Line number of each child’s mother, father, or significant other person.

The relationship of the associated line number to the child on whose line it
appears.

Line number of each child’s mother, father, or significant other person.

The relationship of the associated line number to the child on whose line it
appears.

Date of birth of the individual.

Date on which a record was entered.
First name of the individual.

Last name of the individual.

If the child’s status is ‘04’ or ‘06’, then this field contains the name of the
facility in which the child has been placed; otherwise it contains the name of
the case.

If the child’s status is ‘04’ or ‘06’, this field contains the type of facility in which
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Line 1 Address
Line 2 Address
City Address
State Code

Movement Folder

the child has been placed; otherwise, it is blank.
Address line 1 for the individual.

Address line 2 for the individual.

City in which the individual resides.

State in which the individual resides.

Contains detailed information on movement activities. This folder is included in the In Care/Legal Detail,
Agency or District Admissions/Discharge Summary, CCRS Services Ad Hoc Catalogs.

CINID
Transaction Date

Activity Number

Location Code

Case ID

District ID

Activity Modifier A
Code

Activity Modifier B
Code

Activity Modifier C
Code

Activity Modifier D
Code

Agency ID

Unit ID

Worker ID

Child Status Code
Effective Date

System-generated number that uniquely identifies an individual child in CCRS
Date on which a movement activity took place.

A unique sequence number assigned to each movement activity in a child’'s
case. The oldest activity is assigned the value 1. This guarantees uniqueness
for similar movement activities being entered on the same day.

Indicates the physical location of the child associated with an activity.

The district-assigned case number that uniquely identifies the case within the
district, or responsible state agency, associated with an activity.

The state-assigned code identifying the local social services district currently
controlling the case.

These variables contain specific information associated with each activity
code. Consult your CCRS Coding Guide.

These variables contain specific information associated with each activity
code. Consult your CCRS Coding Guide.

These variables contain specific information associated with each activity
code. Consult your CCRS Coding Guide.

These variables contain specific information associated with each activity
code. Consult your CCRS Coding Guide.

Identifies the agency that entered the activity.

Identifies the unit within the agency that entered the activity.
Identifies the worker that entered the activity.

A derived status associated with each type of movement activity.

The date on which a movement activity became effective.
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Legal Dimension
Contains legal activity details for children. This folder is included in the In Care/Legal Detail and CCRS
Services Report Catalogs

CINID System-generated number that uniquely identifies a child in
CCRS.

Worker ID Identifies the caseworker that entered the activity.

Activity Date Date on which the legal activity occurred.

Activity Code The four-character CCRS activity code.

Activity Number A sequence number that uniquely identifies the separate

activities within a child’s case. The oldest activity is assigned the
value 1. This guarantees uniqueness for similar legal activities
occurring on the same day.

Update Date The date on which a record is updated.

Location Code Code identifying the physical location of the child associated with
this activity.

Case D The district-assigned number that identifies the case within the
district, or responsible state agency, associated with this activity.

District ID The state-assigned code that identifies the local social services
district currently controlling the case.

Activity Modifier A Code These variables contain specific information associated with
each activity code. Consult your CCRS Coding Guide.

Activity Modifier B Code These variables contain specific information associated with
each activity code. Consult your CCRS Coding Guide.

Activity Modifier C Code These variables contain specific information associated with
each activity code. Consult your CCRS Coding Guide.

Activity Modifier D Code These variables contain specific information associated with
each activity code. Consult your CCRS Coding Guide.

Agency ID Code identifying the agency that entered the activity.

Unit ID Code identifying the unit within the agency that entered the
activity.

Legal Modifier A Folder
(These variables contain specific information associated with each activity code. Consult your CCRS
Coding Guide.)

Activity Code These variables contain specific information associated with each activity
code. Consult your CCRS Coding Guide.

Desc Text These variables contain specific information associated with each activity
code. Consult your CCRS Coding Guide.

Activity Modifier Code  These variables contain specific information associated with each activity
code. Consult your CCRS Coding Guide.

Activity Modifier Text These variables contain specific information associated with each activity
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code. Consult your CCRS Coding Guide.

Legal Modifier B Folder
(These variables contain specific information associated with each activity code. Consult your CCRS
Coding Guide.)

Activity Code These variables contain specific information associated with each activity
code. Consult your CCRS Coding Guide.

Desc Text These variables contain specific information associated with each activity
code. Consult your CCRS Coding Guide.

Activity Modifier Code  These variables contain specific information associated with each activity
code. Consult your CCRS Coding Guide.

Activity Modifier Text These variables contain specific information associated with each activity
code. Consult your CCRS Coding Guide.

Legal Modifier C Folder
(These variables contain specific information associated with each activity code. Consult your CCRS
Coding Guide.)

Activity Code These variables contain specific information associated with each activity
code. Consult your CCRS Coding Guide.

Desc Text These variables contain specific information associated with each activity
code. Consult your CCRS Coding Guide.

Activity Modifier Code  These variables contain specific information associated with each activity
code. Consult your CCRS Coding Guide.

Activity Modifier Text These variables contain specific information associated with each activity
code. Consult your CCRS Coding Guide.

Legal Modifier D Folder
(These variables contain specific information associated with each activity code. Consult your CCRS
Coding Guide.)

Activity Code These variables contain specific information associated with each activity
code. Consult your CCRS Coding Guide.

Desc Text These variables contain specific information associated with each activity
code. Consult your CCRS Coding Guide.

Activity Modifier Code  These variables contain specific information associated with each activity
code. Consult your CCRS Coding Guide.

Activity Modifier Text These variables contain specific information associated with each activity
code. Consult your CCRS Coding Guide.
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In Care Summary Fact

Contains child-level information on placements. This folder is included in the In Care/Legal Summary

Catalog
CINID

Legal Disposition Code

Office ID
Unit ID
Worker ID
Report Date
Case ID

District ID

Facility ID

Sex Code

Race Code
Ethnicity Indicator
Goal Code

Child Status Code
Facility Type Code
Age Number

Age Group Text

Time In Care Number

Goal Text
Goal

Ethnicity

Race

Facility Type
ASFA Time In Care
Number

ASFA Group Text
Legal Status Code

System-generated number that uniquely identifies an individual in CCRS.
Legal disposition for a child as of the latest update.

Identifies the office currently responsible for the child’s case.

Identifies the unit currently responsible for the child’s case.

Identifies the caseworker currently responsible for the child’'s case.
Month-end date for which the child’s information is current.

The district-assigned number that uniquely identifies the case within the
district, or responsible state agency, associated with the child.

State-assigned code that identifies the district currently controlling the child’s
case.

Identifies the facility in which the child resided as of the Report Date.
Sex of the child.

Identifies the racial origin of the child.

Indicates whether the child is of Hispanic origin.

Permanency-planning goal from the child’s latest service assessment as of
the Report Date.

Child’s status in CCRS as of the Report Date.

Identifies the type of facility in which the child resided as of Report Date.
Child’s age in years as of the Report Date.

Text grouping based on age as of the Report Date.

Length of time the child has spent in care as of the Report Date, expressed in
months.

Text description of the permanency-planning goal.

Identifies the permanency-planning goal from the child’s most recent service
assessment as of the Report Date.

Identifies whether the child is of Hispanic origin.
Identifies the racial origin of the child.

Text description of the type of facility in which the child resided as of the
Report Date.

Length of time in months the child has spent in care based on ASFA
guidelines

Text grouping based on ASFA Time In Care Number.
Legal status of the child as of the Report Date.
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Facility Folder
Contains detailed information on all Facilities in Connections. In Connections all facilities are coded ‘06’ in
the CD_RSRC_TYPE column on the CAPS Resource table.

This folder is included in all CCRS related catalogs.

Facility/Vendor ID — Identification number assigned to each facility by New York State. This data
element is from NBR_RSRC_VID. Vendor ID is 8 characters in length and the values may contain both
alpha and numeric characters. Many of these numbers were converted from CCRS.

Facility Contact Name — Name of the contact person for the facility This data element is from
NM_RSRC_CONTACT

Facility Certification Date — The date on which the facility was certified or licensed for the current
certification period. This data element is from DT_RSRC_CERT

Facility Authorization To Date — The date on which the facility’s certification expires. This data element
is from DT_RSRC_AUTH_TO

Facility Close — date on which the FAD home or facility was closed (license cancelled). This data
element is from DT_RSRC_CLOSE_EFFECTIVE

Facility Type — This is the Level of Care (LOC) provided by the facility. The LOC is defined by who
licensed the facility, the number of clients it can accommodate, and the type of service it provides. The
type/LOC of a facility is also used to calculate the commodity codes sent to BICS. This data element is
from CD_RSRC_FACIL_TYPE

Facility Status Code — The operational or license status of the facility; active or inactive. This data
element is from CD_RSRC_STATUS and a calculation is done which changes "01" to "Y" (active), and
"02" to "N" (inactive).

Facility Owner Agency Code — Identifies the agency that “owns” or operates the facility. This data
element is from NBR_RSRC_AGENCY_ID

Facility Capacity Number — The maximum number of children to whom the facility will be able to
provide care. This data element is from NBR_RSRC_FACIL_CAPACITY

Facility Name — Name of the facility. This data element is from NM_RESOURCE

Facility Address Line — Line 1 of the primary address (physical location) of the facility This data
element is from ADDR_RSRC_st In_1

Facility Address Line — Line 2 of the primary address (physical location) of the facility This data
element is from ADDR_RSRC_st_In_2

Facility Address City — City of the primary address (physical location) of the facility This data element
is from ADDR_RSRC_CITY

Facility Address State — State of the primary address (physical location) of the facility. This data
element is from CD_RSRC_STATE

Facility Address Zip Code — Postal zip code of the primary address (physical location) of the facility.
This data element is from ADDR_RSRC_ZIP

Facility Address County Code — The county of the primary address (physical location) in which the
facility is located. This data element is from CD_RSRC_CNTY

Facility Phone Number — Telephone number of the facility This data element is from
NBR_RSRC_PHN
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Facility NYC Community District Code — Community district is calculated for New York City
addresses only. This data element is from ADDR_RSRC_CMNTY_DIST

Elements available but not currently used in any catalog.

Facility Resource ID — A unique 8-digit number that identifies a Resource. This data element is from
ID_RESOURCE

Facility Sub Agency Code — This data element is from CD_RSRC_SUB_AGENCY. Sub Agency
primarily applies to NYC (A66) created Foster or Adoptive Homes. The sub agency code is populated
with the NYC “800” level decode appropriate to the home when it is created. Sub agency allows users to
search and sort Foster or Adoptive homes by the “800” code.
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Geography Folder

(Describes the counties associated to case information. This folder is included in all CCRS, Allegation,
Investigation and Out of Home Settings Catalogs.

Upstate Downstate
Text

FIPS Code
County Code
County Name

Region Code

Region Name

State Text
Other State Agency
IAB Indicator

Comparable Group
Code

Descriptive text assigned to each county indicating whether it is part of New
York City (“Downstate”) or part of the rest of New York State (“Upstate”). Long
Island, even though it is across the river from New York City, is considered
“Upstate”.

Federal Information Processing Standards code assigned to the county.
Unique three-digit code assigned to each county in the Connections system.
Full name of the county (e.g., Albany, Montgomery, etc.)

Unique code identifying the New York State region to which the county
belongs (one of six in the state).

Full name of the region:

Buffalo Region
Rochester Region
Syracuse Region
Albany Region

Yonkers Region

New York City Region
Statewide Agencies
Regional Offices

A ON -~
0 N O O,

Name of the state to which the county belongs (New York).
Indicates whether the agency is other than an OCFS agency.

Indicates whether the county is considered a Regional Office for the purposes
of investigating IAB cases.

Indicates which of three groups of comparable counties to which this county
belongs. Counties are grouped based on how closely they relate to each
other with respect to the following variables:

Children less than 22 years old
Urbanicity (all non-rural housing units divided by all housing units)

Families with children with income less than 125% of the poverty level.
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Allegation Facts Folder

Contains detailed data of actual allegations. This folder in included in the Allegation Catalog.

Case ID

Reporter Relationship

Code
Report ID

Intake Stage ID

Investigative Stage ID

County Code

Unit ID

Unit Code
Worker ID

Worker’s Role

Intake Code

Intake Type Code

Intake Start Date

Investigation Close
Date

Report Last Update
Date

Last Updated Date
Report Status Text
Investigative Code

Invest Type Code

The unique number assigned to each case by the district that identifies the
case within the district or responsible state agency.

Identifies the role played by the individual reporting the allegation
(see Reporter Relationship Folder for codes).

Unique identification number assigned to each CPS Report in the
CONNECTIONS system.

Unique identification number assigned to the Intake stage of each CPS
Report in the CONNECTIONS system.

Unique identification number assigned to the investigative stage of each CPS
Report in the CONNECTIONS system.

Unique three-digit code assigned to each county in the CONNECTIONS
system.

Unique identification number of the unit to which the report has been
assigned.

Unique code assigned to the unit to which the report has been assigned.

Unique identification number of the worker to whom the report has been
assigned.

Code identifying the role the assigned worker is to play on this report (i.e., PR
= Primary, SE = Secondary).

Code identifying the intake stage of the report (i.e., “INT”).

Code identifying the type of report (i.e., “INI” — Initial, “SUB” — Subsequent,
“ADD” — Additional Information).

The report start date.

The date on which the investigation was closed.

The date on which the report was updated last.

The date on which the Allegation Fact table was last updated.
Indicates the status of the report (i.e., “Open”, “Closed”).
Code identifying the investigative stage of the report (i.e., “INV”).

Code identifying the type of report (i.e., “INI” — Initial, “SUB” — Subsequent,
“‘ADD” — Additional Information).
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Reason Investigation Code identifying the reason for closing the investigation.

Closed Code

5

10
15
23
25
30
35
40
45
55
60
64
65
66
67
68
69
70
71
72
73
80
81
83
84
85
86
88
97
99

Allegation(s) already investigated

Law Enforcement agreed to investigate
Preliminary investigation of an anonymous report
Assessment only

Other

Close — No credible evidence

Close — Unable to contact

Close — Service completed

Withdrawal

Subcare — Protective Placement

Close

Open — Court ordered services

Open — Court ordered services

Open — Court ordered supervision
Open — Court ordered supervision
Open — Voluntary services

Open — Voluntary services

Open — Voluntary Placement

Open — Voluntary Placement

Open — Court ordered placement
Open — Court ordered placement
Close — Refuse service/unable to take legal action
Close — No services required

Close — Lost contact

Workload constraints — Close

Close

Non-family Investigation

Close — Only child died

Closed to Merge

Reclassification
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Investigation
Classification Code

Approved
Determination Code

Allegation Code

Disposition Code

Victim Person ID

Victim Gender Code

Victim Race/Ethnicity
Code

Victim's Age at Intake

Subject Person ID

Subject Gender Code

Subject Ethnicity/Race
Code

Subject Age at Intake
Age of Report Number

Indicates the type of investigation conducted:

e CPD — CPS Report investigation involving Foster Care/Day Care
providers

o CPF — CPS Report investigation involving Family members
e CPI - CPS Report investigation involving Institutional abuse
¢ | & R —Information and Referral

e NCP — Non-CPS Report investigation

e NON — Non-Report

e SPC — Special Request

Indicates the determination made and approved on the CPS Report
(IND = Indicated, UNF = Unfounded)

Identifies the specific abuse/maltreatment being alleged (see Allegation
Folder for codes).

Indicates what determination has been made concerning the allegation of
abuse (SUB = Substantiated, UNS = Unsubstantiated).

Unique identification number assigned to all children in the CONNECTIONS
system.

Identifies the sex of the child or victim (F = Female, M = Male, U = Unknown).

Identifies the race or ethnicity of the child (see All Races & Ethnicity Folder for
codes).

Age in months of the victim on the Intake Start Date.

Unique identification code assigned to every subject (alleged perpetrator) in
the CONNECTIONS system.

Identifies the sex of the subject (F = Female, M = Male, U = Unknown).

Identifies the race or ethnicity of the subject (see Ethnicity Folder for codes).

Age in years of the subject on the Intake Start Date.

Number of days between the Intake Start Date and the Close Date of the CPS
Report. If the report is not closed, it is the number of days between the current
date and the Intake Start Date.
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Race & Ethnicity Folder

(Contains details of the race and ethnicity codes and their descriptions. This folder is included in all
CCRS, Allegation, and Out of Home Settings Catalogs.

Race Code

Code assigned to specific races.

Race Descriptive Text Description of the race or ethnicity.

Race Type

Ethnicity Indicator

AA
AC
AH
AN
AP
AS
BO
cw
HC
HL
HO
NA
OB
UN
XX

African-American
African-American-Caucasian
African-American-Hispanic
Native American/Alaskan Native
Asian/Pacific Is-Caucasian
Asian/Pacific Islander/Oriental
Black (Other)

Caucasian (White/Non-Hisp)
Hispanic-Caucasian
Hispanic/Latino/Puerto Rican
Hispanic/Oriental

Native African

Oriental/Black

Unable to Determine

Other

(Y =Yes, N =No)

Broad groupings of racial codes (American Indian or Alaska Native, Asian,
Black or African American, Other, Unknown, White).

Indicates whether the race is considered to be of Hispanic or Latino origin
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Allegation Role Folder

(Contains descriptions of all roles played by victims, subjects, reporters, and workers. This folder is

included in the Allegation Catalog.

Role Code Code identifying the role.
AB Abused Child
AS Alleged Subject
CA Confirmed Abused
CM Confirmed Maltreated
CS Confirmed Subject
HM Historical Manager
HP Historical Primary Worker
MA Maltreated Child
MG Case Manager
NA Non-confirmed Abused
NM Non-confirmed Maltreated
NO No Role
NS Non-Confirmed Subject
PC Primary Child
PR Primary
RP Reporter
SE Secondary
SR Source
SS Sustained Subject
SuU Suspect
UK Unknown
VI Victim
Role Description Text Description of the role.
All Roles Text “ALL Roles”
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Allegation Subject Folder

(Contains demographic information for the perpetrator [subject] assigned to investigations and
allegations. This folder is included in the Allegation Catalog.

Subject Person ID Unique identification number assigned to every subject in the
CONNECTIONS system.
Approximate DOB Indicates whether the subject’s date of birth has been estimated in the report
Indicator due to lack of information (Y = Yes, N = No).
Gender Code Indicates the sex of the subject (F = Female, M = Male, U = Unknown).
Status Code Not being used at this time.
Religion Code Code indicating the religion practiced by the subject (if any).
BP Protestant
CJ Jewish
DE Eastern Religion
EN None
FP No Preference
IS Islam
RC Catholic
UN Unknown
XX Other
Birth Date Date on which the subject was born. Note: If Approximate DOB Indicator is Y,
this date is an estimate.
First Name First name of the subject.
Middle Name Middle name or initial of the subject.
Last Name Last name of the subject.
City City in which the subject resides.
Street Street address of the subject.
Zip Code Postal ZIP code of the subject’s address.
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Allegation Child Folder
Contains demographic information on the victim in allegations and investigation. This folder is in the
Allegation Catalog

Child Person ID Unique identification number assigned to all children in the CONNECTIONS
system.
Child Age In Years Calculation of child’s age based on his/her date of birth.
Approx. DOB Indicator Indicates whether the date of birth for this victim is estimated due to lack of
information.
Gender Code Indicates the sex of the victim (F = Female, M = Male, U = Unknown).
Status Code Current status of the victim in the CONNECTIONS system (A = Active, | =
Inactive, M = Merged).
Religion Code Code indicating the religion practiced by the victim (if any).
BP Protestant
CcJ Jewish
DE Eastern Religion
EN None
FP No Preference
IS Islam
RC Catholic
UN Unknown
XX Other
Birth Date Date on which the victim was born. Note: If the Approximate DOB Indicator is
Y, then this is an estimated date.
First Name First name of the victim.
Middle Name Middle name or initial of the victim.
Last Name Last name of the victim.
Street Street address of the victim.
City City in which the victim resides.
Zip Code Postal ZIP code of the victim’s address.
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Allegation Folder

Contains descriptions of specific allegations of child abuse/neglect. This folder is included in the

Allegations Catalog.

Allegation Code Code assigned to a specific allegation of child abuse/maltreatment.

Allegation Text Description of specific allegations of child abuse/maltreatment.

Allegation Group Text = Groupings of specific allegations used for reporting purposes as defined by
NCANDS (National Child Abuse and Neglect Data System).

Allegation Allegation Allegation
Group Text Code Text
Medical Neglect LMED Lack of Medical Care

Neglect or deprivation of EDNG Educational Neglect
necessities IFCS Inadequate Food, Clothing, Shelter

INGD Inadequate Guardianship

LSUP Lack of Supervision

MITT Malnutrition, Failure to Thrive
Other ABAN Abandonment

CDRG Child’s Drug/Alcohol Use

INCC Inappropriate Custodial Conduct

PDRG Parent’s Drug/Alcohol Misuse

XOTH Other
Physical Abuse BURN Burns, Scalding

CHTS Choking/Twisting/Shaking

EXCP Excessive Corporal Punishment

FATL DOA/Fatality

FRAC Fractures

[INJ Internal Injuries

LABW Lacerations, Bruises, Welts

PONX Poisoning, Noxious Substances

SWDS Swelling/Dislocation/Sprains
Psychological or emotional EMOT Emotional Neglect
maltreatment ISOL Inappropriate Isolation/Restraint
Sexual Abuse SXAB Sexual Abuse
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Reporter Relationship Folder
Describes the role of the reporter of the alleged child abuse/maltreatment. This folder is included in the
Allegation and Investigation Catalogs.

CONNECTIONS code for the role of the incident reporter.

Reporter Relationship
Code

Reporter Description

Text describing the CONNECTIONS Reporter Relationship Code:

Text
AA

AD
AG
AN
AS
AT
AU
BF
cC
CO
CR
CS

CT
cw
DA
DC
DH
DI
DS
DT

NCANDS Reporter

Code

NCANDS Reporter

Type

Mandated Indicator

Substance Abuse
Counselors

Attend Teacher
Community Agency
Anonymous
Physician's Asst.
Attorney
Aunt/Uncle
Biological Father
Concerned Citizen
Cousin

Clergy

Christian Science
Practitioner

Court

Child Care Worker
Daughter/Son

Day Care Fac./Prov.
Dental Hygienist
Director

DSS Worker

District Attorney

DV
EM
FM
FP
FR
FV
GC
GN
GP
GU
IS
LA
MC
MF
MH
MO
NE
NN
NR

reporter roles.

Detective

EMS/EMT

Other Family member
Foster Parent

Friend

Family Viol. Shelter
Grandchild
Guidance Counselor
Grandparent
Guardian
Institutional Staff
Law Enforcement
ME/Coroner

Medical Fac. Staff
Mental Health Prof.
Mother

Neighbor
Niece/Nephew
Nurse

Description of the NCANDS Reporter Code.

0s
PA
PB
PH
PN
PO
PS
PY

PZ
SA
SB
sc
sw
TC
TP
UH

UK
XX

Other Shelter
Parent

Probation Officer
Public Health
Principal

Police Officer
Parent Substitute

Psychologist/
Psychiatrist

Physician

Other St. Agency
Sibling

School Personnel
Social Worker
Teacher
Therapist

Unrelated Home
member

Unknown
Other

Code used by the National Child Abuse and Neglect Data System for incident

Indicates whether this type of reporter is required by law to report incidents of
child abuse/maltreatment (Y = Yes, N = No).
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Data As Of Date Folder
Provides the dates on which the Allegations data mart was updated with data from the CONNECTIONS
and CCRS systems

This folder is included in all OCFS Data Warehouse catalogs

CONNECTIONS Date on which the data mart was updated with CONNECTIONS data.
Data As Of Date

CCRS/WMS Date on which the data mart was updated with CCRS and/or WMS data.
Data As Of Date
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Foster Home Member Ethnicity Folder
Provides descriptive details on the race or ethnicity of the members of the Resource. This folder is
included in the Out of Home Settings Catalog

Ethnicity Code Two-letter code identifying the ethnicity of the home member (refer to
Ethnicity Dim for codes).

Ethnicity Desc Txt Text describing the ethnicity of the home member.

Ethnicity Type Broad groupings of ethnicity codes (American Indian or Alaska Native, Asian,
Black or African American, Other, Unknown, White).

Hispanic Latino Ind Indicates whether the race is considered to be of Hispanic or Latino origin
(Y=Yes, N=No).

Page 19-36 OCFS Data Warehouse Reporting

rev 08/2004 Impromptu Step-by-Step Guide



Foster Home Facts Folder
(Contains detailed data for all resources designated as foster home care facilities. This folder is included
in the Out of Home Settings Catalog.

Foster Home Resource
ID

Foster Home Vendor ID

Foster Home Name

Foster Home Worker ID

Foster Home Stage ID
Foster Home Setting

Foster Home Level Of
Care

Foster Home Status

Foster Home
Authorized To Date

Foster Home
Certification Date

Foster Home Close
Date

Foster Home Original
Certification Date

Foster Home Agency
Code

Foster Home Original
Agency Code

Foster Home Inquiry
Source Code

Foster Home Close
Reason Code

Foster Home Language
Foster Home Religion

Foster Home Ethnicity

Foster Home
Emergency Program
Type Indicator

Unique identification number assigned to every resource in the
CONNECTIONS system.

Unique identification number of the facility associated to the resource. This is
the CCRS Facility ID

Full name by which the resource is known.

Unique identification number of the worker with whom the foster home is
associated.

A unique integer that identifies the resource as the stage.
Describes the type of resource (i.e., Foster Home or Congregate).

Describes the level of care provided by the resource, including Agency
Boarding Home, Approved Relative Foster Home, Certified Foster Home,
Group Home, Group Residence, Institution

Status of the home.

Date to which the resource is authorized.

Date on which the resource was certified.

Date on which the resource was closed.

Date on which the resource was originally certified.

Three-digit identification code for the agency with which the home is
associated.

The original agency code for the home.

Code which captures how the inquirer learned about the F/A Home program.

Code identifying the reason for closing the home.

Language spoken in the home.
Religion practiced in the home.

Code indicating the ethnicity of the home (please refer to Ethnicity Dim for
codes).

Indicates whether a resource provides emergency program services.
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Foster Home Hard To
Place Program Type
Indicator

Foster Home HIV AIDS
Program Type
Indicator

Foster Home Maternity
Program Type
Indicator

Foster Home Mother
and Child Program
Type Indicator

Foster Home Refugee
Assistance Program
Type Indicator

Foster Home Regular
Program Type
Indicator

Foster Home Sex
Offender Program
Type Indicator

Foster Home SILP
Program Type
Indicator

Foster Home Special
Needs Behavioral
Program Type
Indicator

Foster Home Special
Needs Medical
Program Type
Indicator

Foster Home
Therapeutic Program
Type Indicator

Foster Home
Diagnostic Reception
Center Program Type
Indicator

Foster Home RTC
Program Type
Indicator

Foster Home Capacity
Number

Indicates whether a resource provides “hard to place” program services.

Indicates whether a resource provides HIV+/AIDS program services.

Indicates whether a resource provides maternity program services.

Indicates whether a resource provides Mother/Child program services.

Indicates whether a resource provides Refugee Assistance program services.

Indicates whether a resource provides regular program services.

Indicates whether a resource provides sex offender program services

Indicates whether a resource provides Supervised Independent Living

Program services.

Indicates whether a resource provides Special Needs Behavioral program

services

Indicates whether a resource provides Special Needs Medical program
services.

Indicates whether a resource provides therapeutic program services.

Indicates whether a resource provides Diagnostic Reception Center program
services.

Indicates whether a resource provides Residential Treatment Center program
services.

Maximum licensed capacity of the resource.
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Foster Home
Unavailable Number

Foster Home Maximum
Female Month Number

Foster Home Maximum
Female Year Number

Foster Home Minimum
Female Month Number

Foster Home Minimum
Female Year Number

Foster Home Maximum
Male Month Number

Foster Home Maximum
Male Year Number

Foster Home Minimum
Male Year Number

Foster Home Minimum
Male Month Number

Foster Home Address
Line 1

Foster Home Address
Line 2

Foster Home Address
City

Foster Home Address
Zip Code

Foster Home Address
State

Foster Home Address
County

Foster Home NYC
Community District

Foster Home Phone
Number

Foster Home Phone
Extension

Foster Home Sub
Agency Code

The number of places currently unavailable in the resource.

The maximum age in months at which the resource will accept female
children.

The maximum age in years at which the resource will accept female children.
The minimum age in months at which the resource will accept female
children.

The minimum age in years at which the resource will accept female children.
The maximum age in months at which the resource will accept male children.
The maximum age in years at which the resource will accept male children.
The minimum age in years at which the resource will accept male children.
The minimum age in months at which the resource will accept male children.
First line of the home’s street address.

Second line of the home’s street address.

City in which the home is located.

Postal ZIP code for the home.

Two letter code for the state in which the resource is located.

Three-digit code for the county in which the home is located.

Community district code of the resource (New York City only).

Phone number for the home.

Phone extension number for the home.

This data element is from CD_RSRC_SUB_AGENCY. Sub Agency primarily
applies to NYC (A66) created Foster or Adoptive Homes. The sub agency
code is populated with the NYC “800” level decode appropriate to the home
when it is created. Sub agency allows users to search and sort Foster or
Adoptive homes by the “800” code.
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Foster Home Member Folder
(Provides descriptive details about the members of foster homes. This folder is included in the Out of

Home Settings Catalog.

Member ID

Member Name
Resource ID
Facility ID
Approx Dob Ind
Sex Code
Ethnicity Code

State Code
County Code
Agency Code
Birth Date

Card Sent Date

Card Recvd Date
Zip Code

Phone Number
City Address
Language Txt

Marital Status Txt

Unique CONNECTIONS identification number assigned to an individual who
is a member of a foster home.

Full name of an individual who is a member of a foster home.

Unique CONNECTIONS resource identification number of the foster home.
Unique Connections facility identification number of the foster home.
Indicates whether a foster home member’s date of birth has been estimated.
Identifies the gender of a foster home member.

Identifies the ethnicity of a foster home member (refer to Ethnicity Folder for
codes).

Identifies the state in which a foster home is located
Identifies the county in which a foster home is located.
Code assigned to that agency that owns a foster home.

Date on which a foster home member was born. Note: If the Approx Dob Ind
is “Y”, then this date is estimated.

The date on which fingerprint cards of a foster home member were sent to the
Department of Criminal Justice Services (DCJS) for a criminal background
check.

The date on which a response is received from the DCJS.
Postal ZIP code of a foster home address.

Telephone number of a foster home.

City in which a foster home is located.

Language spoken at a foster home.

Amer Sign Hindi Other
Chinese Italian Polish
Creole Japanese Portuguese
English Korean Portuguese
French Multiple Spanish
German Nat Am Lan Vietnamese
Hebrew

Indicates the marital status of a foster home:

Child, not applicable Separated Single, never MA
Widowed Unknown Divorced
Unmarried Couple Legally Separated Married
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Relation Txt

Religion Txt

Role Txt

Street1 Address
First Name

Last Name
Middle Name
Street2 Address

Identifies the relationship of individuals living in a foster home:

Absent Parent
Foster Parent
Aunt/Uncle
Grandchild
Clergy

Institutional Non-Prof.

Concerned Citizen
Neighbor
Daughter/Son
Non-relative
Other Shelter
Psychiatric Staff
Son

Unknown

Religion primarily practiced by a foster home member:

Catholic
Eastern Religion
Islam

Foster Child
Attorney

Godparent

Child Care Worker
Guardian

Mother

Cousin
Non-custodial Parent
Other Family member
Parent

School Personnel
Spouse

Step Sibling

Unrel. Home mem

Jewish
None
No Preference

Administrator
Friend

Child

Grandparent
Community Agency
Court
Niece/Nephew

Day Care Fac./Prov.
Other

Parent Substitute
Sibling

Step-Parent

Teacher

Other
Protestant
Unknown

Identifies the principal and collateral relationships in a foster home (Collateral,

Principal).

The first line of the street address of a foster home.

First name of an individual who is a member of a foster home.

Last name of an individual who is a member of a foster home.

Middle name of an individual who is a member of a foster home.

Second line of the foster home’s street address.
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CPS Investigations Approval Folder
(Contains the details of approvals made on CPS Reports and Stages. This folder is included in
the Investigation Catalog.

Report ID Unique identification number assigned to all CPS Reports in the
CONNECTIONS system.

Approval Description  Text description of the approval made to a CPS Report or Stage.
Text

Approval ID Unique identification number assigned to the individual with approval
responsibility for a case.

Case ID Unique identification number assigned to all CPS Reports in the
CONNECTIONS system.

Person ID Unique identification number assigned to the primary worker on a CPS
Report.

Approval Status Code Status of the approval on a CPS Report.
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CPS Investigations Fact Folder
(Contains detailed data for actual CPS Reports. This folder is included in the Investigation

catalog.

Report ID

Report Relation Code

Unit ID

Case ID

Worker ID
Worker Role Code
County Code

Intake ID

Intake Code
Intake Type Code
Intake Start Date

Investigation ID

Investigation Code

Investigation Type
Code

Investigation Close
Date

Investigation Reason

Unique identification number assigned to all CPS Reports in the
CONNECTIONS system.

Code identifying the relationship of the individual who reported the
case.

Unique identification number of the unit to which the primary worker on

the case is “in” assigned.

Unique identification number assigned to all cases in the
CONNECTIONS system.

Unique identification number assigned to the primary worker on a case.
Code identifying the role played by the primary worker on a case.

Code identifying the county to which the primary worker on a case
belongs.

Unique identification number assigned to the Intake Stage of a case.
Code identifying the Intake Stage of a case (i.e., “INT”).
Code identifying the type of intake for a case.

The date on which the case is opened as an Intake on the
CONNECTIONS system.

Unique identification number assigned to the Investigation Stage of a
case.

Code identifying the Investigation Stage of a case (i.e., “INV”).

Code identifying the type of investigation for a case.

Date on which the Investigation Stage of a case is closed.

Code identifying the reason an Investigation Stage is closed.

Closed Code
5 Allegation(s) already 68 Open — Voluntary services
investigated
10 Law Enforcement agreed to 69 Open — Voluntary services
investigate
15 Preliminary investigation of an 70 Open — Voluntary Placement
anonymous report
23 Assessment only 71 Open — Voluntary Placement
25 Other 72 Open — Court ordered
placement
30 Close — No credible evidence 73 Open — Court ordered
placement
35 Close — Unable to contact 80 Close — Refuse service/unable
to take legal action
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40
45
55

60
64
65
66

67

Investigation

Close — Service completed
Withdrawal

Subcare — Protective
Placement

Close
Open — Court ordered services
Open — Court ordered services

Open — Court ordered
supervision

Open — Court ordered
supervision

81
83
85

86
88
97
99

Close — No services required
Close — Lost contact

Non-family Investigation
Close — Only child died
Closed to Merge
Reclassification

Code identifying the type of investigation conducted:

Classification Code

Approved

Determination Code

Last Updated Date

Report Name

Case Open Indicator

CPD CPS Report investigation
involving Foster Care/Day
Care providers

CPI  CPS Report investigation
involving Institutional abuse

NCP Non-CPS Report

investigation

SPC Special Request

CPF CPS Report investigation

involving Family members

| & R Information and Referral

NON Non-Report

Code identifying the determination made on a case (“IND”=Indicated,

“UNF”=Unfounded).

Name of the CPS Report or case.

Date on which the CPS Report was last updated.

Indicates whether the CPS Report or case is open.
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CPS Investigations Stage Person Folder
(Contains descriptive details of the various individuals in each Stage of a case. This folder is
included in the Investigation Catalog.

Report ID Unique identification number assigned to each CPS Report in the
CONNECTIONS system.

Stage Person Link Latest date on which the CPS Report was updated.

Date

Case ID Unique identification number assigned to each case in the Connections
system.

Person ID Unique identification number assigned to the individual associated to

the CPS Report.
Person Role Code Code identifying the role played by the individual in the CPS report.
Person Relation Code Code identifying the relationship of the individual in the CPS report.
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CPS Investigations Detail Folder
(Contains detailed data for actual CPS Reports. This folder is included in the Investigation Catalog.

Report ID Unique identification number assigned to all CPS Reports in the
CONNECTIONS system.
Report Date The Intake Start Date for a specific CPS Report.

Rep Tot Open Count Total number of CPS Reports currently open in the CONNECTIONS system
(i.e., INV-stage reports with no Close Dates).

Rep Beg Open Count The total number of CPS Reports active as of midnight on the first day of the
period covered.

Rep End Open Count The total number of CPS reports that were active as of midnight on the last
day of the period covered.

Rep Last day Overdue  The total number of CPS reports that were still active at the end of period
Count where the number of days between the Intake Start Date and the Period End
Date is greater than 60 days.

Rep Tot Open Days Total number of days a CPS Reports was open at any time during the period
covered.
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CPS Investigations Reporter Relationship Folder
(Contains descriptive details of the individual who reported the CPS case. This folder is included in the
Allegation and Investigation Catalogs.

Reporter Relation Code identifying the relationship of the reporter in the case:
Code AA Substance Abuse DT District Attorney NR Nurse
Counselors
AD Attend Teacher DV Detective OS Other Shelter
AG Community Agency  EM EMS/EMT PA Parent
AN Anonymous FM Other Family PB Probation Officer
member
AS Physician's Asst. FP Foster Parent PH Public Health
AT Attorney FR Friend PN Principal
AU Aunt/Uncle FV Family Viol. Shelter PO Police Officer
BF Biological Father GC Grandchild PS Parent Substitute
CC Concerned Citizen GN Guidance PY Psychologist/
Counselor Psychiatrist
CO Cousin GP Grandparent PZ Physician
CR Clergy GU Guardian SA Other St. Agency
CS Christian Science IS Institutional Staff SB Sibling
Practitioner
CT Court LA Law Enforcement SC School Personnel
CW Child Care Worker MC Medical SW Social Worker

Examiner/Coroner
DA Daughter/Son MF Medical Fac. Staff TC Teacher
DC Day Care Fac./Prov. MH Mental Health Prof. TP Therapist

DH Dental Hygienist MO Mother UH Unrelated. Home
Member
DI Director NE Neighbor UK Unknown
DS DSS Worker NN Niece/ Nephew XX Other
Mandated Indicator Indicates whether the reporter was required by law to report a case of child

abuse and/or maltreatment.
Description Text Text description of the relationship of the reporter in the case.

NCANDS Reporter Category of reporter type according to the National Child Abuse and Neglect
Code Data System guidelines.

NCANDS Reporter Text description of NCANDS Reporter Code.
Description
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CPS Worker Folder

(Describes the individual workers associated with investigations. This folder is included in the Allegation

and Investigation Catalogs.

Worker ID

Worker Name

Unit ID

Unit Code
County Code

Agency Code
Site Code
First Name
Middle Name
Last Name

Office Name

Unique identification number assigned to the primary worker in the
CONNECTIONS system.

Full name of the primary worker associated to a case.

Unique identification number assigned to the unit to which the primary worker
is “in” assigned.

Code assigned to the unit to which the primary worker is “in” assigned.

Unique three-digit code assigned to the county to which the primary worker
belongs.

Code assigned to the agency with primary responsibility for a case.
Code assigned to the site to which the unit is associated.

First name of the primary worker assigned to a case.

Middle name of the primary worker assigned to a case.

Last name of the primary worker assigned to a case.

Name of the office to which the primary worker reports.
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CPS Unit Folder

(Contains demographic details about the units associated to investigations and allegations. This folder is
included in the Allegation and Investigation Catalogs.

Unit ID

Agency Name
Agency Code
Site Code
Unit Code
Approver ID

Approver Name

Unique identification number of the unit within the district or agency to which a
case belongs.

Name of the agency to which the unit belongs.

Code assigned to the agency with primary responsibility for a case.
Code assigned to the site to which the unit is associated.

Code assigned to the unit with primary responsibility for a case.

Unique identification number assigned to the individual responsible for
approving a case.

Full name of the individual with approval responsibility for a case.
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CPS Individual Role Folder
(Contains descriptions of all roles played by victims, subjects, reporters and workers. This folder is
included in the Allegation and Investigation Catalogs.

Role Code Code identifying the role.

Role Description Text Text description of the role:

AB Abused Child NO No Role
AS Alleged Subject NS Non-Confirmed Subject
CA Confirmed Abused PC Primary Child
CM Confirmed Maltreated PR Primary
CS Confirmed Subject RP Reporter
HM Historical Manager SE Secondary
HP Historical Primary Worker SR Source
MA Maltreated Child SS Sustained Subject
MG Case Manager SuU Suspect
NA Non-confirmed Abused UK Unknown
NM Non-confirmed Maltreated VI Victim
All Roles Text “ALL Roles”
Page 19-50 OCFS Data Warehouse Reporting

rev 08/2004 Impromptu Step-by-Step Guide



Worker Agency Folder
Contains detailed information on the Agency to which the worker belongs. In Connections Agencies are
coded ‘05’ in the CD_RSRC_TYPE column on the CAPS Resource table.

This folder is included in all CCRS related and Out of Home settings catalogs

Worker Agency ID — Unique identification number assigned to the agency by New York State. This data
element from NBR_RSRC_AGENCY_ID

Worker Agency Contact Name — Name of the agency contact person. This data element from
NM_RSRC_CONTACT

Worker Agency Certification Date — The date on which the agency was certified (licensed). This data
element from DT_RSRC_CERT

Worker Agency Authorization To Date — The date on which the agency’s authorization expires. The
only time an agency’s authorization will expire is when the agency is new and on probation. After the first
re-authorization then the agency remains open until closed. This data element from
CD_RSRC_CERT_BY

Worker Agency Close Date — The date on which the agency was closed. This data element from

Worker Agency Type Code — This code indicates whether the Agency is a District (D) or Voluntary
Agency (V). This data element from CD_RSRC_AGENCY_TYPE

Worker Agency Status Code — The operational status of the agency (active or Inactive). This data
element from CD_RSRC_STATUS

Worker Agency Name — Name of the agency. This data element from NM_RESOURCE

Worker Agency Address Line 1 --- first line of the agency's address. This data element from
ADDR_RSRC_ST_LN_1

Worker Agency Address Line --- Second line of the agency’s address. This data element from
ADDR_RSRC_ST_LN_2

Worker Agency City Address --- city in which the agency is located. This data element is from
ADDR_RSRC_CITY

Worker Agency NYC Community District Code — community board district code that is generated by
the geo-coding interface on the FAD and Resource director address windows. Community district is
calculated for new York city addresses only. This data element is from ADDR_RSRC_CMNTY_DIST

Worker Agency State — abbreviated code for the state in which the agency is located. This data
element is from CD_RSRC_STATE

Worker Agency Zip Code — numeric ZIP code for the agency. This data element is from
ADDR_RSRC_ZIP

Worker Agency Address County Code — County in which the Agency is physically located. This data
element is from CD_RSRC_CNTY

Worker Agency Phone Number — phone number for the agency. This data element is from
NBR_RSRC_PHONE
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Appendix B:

Predefined Impromptu Reports

FAD Impromptu Reports

Appendix B1:

Foster Home Reauthorization Coming Due

Report Title:

Report Purpose:

Report Prompts:

Totals:

Data:

Data Field
Home
Authorization
Will Expire

Foster Home Reauthorization Coming Due

Lists foster homes that require reauthorization for the period between the date of
the last data refresh date and the end date specified by the user.

End Date (end of time period)

Total Homes Coming Due for Period by Worker Agency ID

Data Definition
Start and End dates entered by user

Sample Values

Date of Report

Date on which the report is run

Office Name of the Office to which an agency is assigned | New Alternatives for Children
Unit Three-digit identification number for the unit to 013
which an employee is currently assigned
Worker Name First and last names of the worker assigned to the Doe, John
Foster Home
Resource ID Connections Vendor ID for the Resource 20035220
Home Name Name of the Resource Knox, Diane
Setting Describes the type of home Foster Home

Congregate Home

Home Status

Status of the Resource

Accepted — Active

Note: All current reports are formatted to include Emergency
Accepted — Active and Emergency status only.

Cert from Date Date of the original authorization or last 10/8/00
reauthorization/approval date of a Foster or
Congregate Care Home

Cert to Date Date the resource is due to be closed if the worker | 10/8/01

takes no action
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Appendix B2:

Facility Detail Report

Report Title:
Report Purpose:

Report Prompts:
Totals:

Data:

Data Field
Agency
Worker Name

Office Name

Worker Unit

Home Name

Resource ID

Facility ID

Home Status

Setting

Level of Care

Facility Detail

Provides information for Congregate and Foster Home resources in Accepted

Active and Emergency statuses.
None

None

Data Definition
Name of the agency that owns the resource

First and last names of the worker assigned to this
resource.

The name of the office to which the worker is
currently ‘in’ assigned. NOTE: In some cases, this
will be different from the Worker Agency field.

Identification number of the unit to which the worker
assigned to the resource is ‘in’ assigned in
Connections.

Name of the Foster or Congregate Home resource.

The Connections identification number for this
resource.

The Connections Vendor identification number for
this resource.

Status of the resource.

NOTE: All current reports are formatted to include
Accepted — Active and Emergency status only.

Indicates the setting of the resource

The level of care provided by the resource.

Sample Values
700

Smith, Carol

New Alternatives for Children

013

Smith, Marian

173800
00123456

Accepted — Active

Emergency

Foster Care
Congregate Care
Agency Boarding Home

Approved Relative Foster
Home

Certified Foster Home
Group Home

Group Residence

Institution
Cert From The date on which the resource was last authorized | 6/25/01
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Data Field
Cert To

Capacity

# Unavailable

Male Min Yrs &
Mos

Male Max Yrs &
Mos

Female Min Yrs
& Mos

Female Max Yrs
& Mos

Program Types

Home Location
Street Ln 1
Street Ln 2
City

County

CD

State

Data Definition

The date on which authorization for the resource

expires

The maximum number of children for which the
resource is licensed

Number of unavailable spaces in this resource

The minimum age, in years and months, of male
children that the resource is licensed to accept.

The maximum age, in years and months, of male
children that the resource is licensed to accept.

The minimum age, in years and months, of female
children that the resource is licensed to accept.

The maximum age, in years and months, of female
children that the resource is licensed to accept.

Describes the types of programs offered by the
resource. Values include:

RG — Regular

EM — Emergency

TH — Therapeutic

HP — Hard to Place

MC — Mother/Child

HIV — HIV+/AIDS

MT — Maternity

SO — Sexual Offenders

RTC — Residential Treatment Center

DRC - Diagnostic Reception Center

RA — Refugee Assistance Program

SILP — Supervised Independent Living Program
SNM — Special Needs Medical

SNB — Special Needs Behavioral

The first line of the street address of the resource.
The second line of the resource’s street address.
City in which the resource is located

County in which the resource is located.

Community district in which the resource is located.

NOTE: This field will be completed for New York
City resources. All others will be blank.

State in which the resource is located.

Sample Values
6/25/02

40

01

20

2520 Linden Blvd

Brooklyn

Manhattan

05

NY
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Data Field Data Definition Sample Values

Zip

Phone

Ext

Race
Language
Religion
Member Name

Person ID

Relationship

Role

DOB

Sex
Race

Connections As
Of Date

Date of This
Report

Fingerprint Card
Sent

Fingerprint Card
Returned

Medical Exam
Date

CCRS Child CIN
Child Name

ASFA Time in
Care

Total Siblings
Siblings Placed

Zip code of the resource’s street address.
Phone number for the resource

Phone extension number for the resource.
Race of the resource.

Language(s) spoken at the resource.
Predominant religion practiced at the resource.
Name of each member living in the resource

The Connections identification number of the
individuals living in the resource

Relationship of the individuals living in the
resource.

Identifies the principal and collateral relationships
of the persons living in the resource.

Date of birth of the individuals living in the
resource.

The gender of the individuals living in the resource.

Race of the individual living in the resource.

Date of the latest update of the OCFS Data
Warehouse

Date on which the report was requested.

Date on which fingerprint cards for this home
member were sent.

Date on which fingerprint cards for this home
member were returned.

Date on which this home member received a
medical examination.

The CIN identification number for the child.
Name of the child.

Number of months the child has been in care,
based on ASFA guidelines.

Number of siblings of this child.

Number of this child’s siblings who have been
placed in care.

11206-4555
5186732000

123

African American
English
Protestant
Jones, Carmen

12189099

Foster Parent

Principal

10/13/48

F
African American

10/05/2001

9/14/01
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Appendix B3:

Facility Summary List Report

Report Title:
Report Purpose:

Report Prompts:
Totals:

Data:

Data Field
Agency/District
Name

Agency/District
Code

Total Number of
Foster Homes

Worker Office
Name

Unit Code

Worker Name

Resource ID

Home Name

Home Member
Name

Role

Relationship

Setting

Status
Fingerprint Card
Sent

Fingerprint Card
Received

Facility Summary List Report

To provide workers and supervisors with a listing of all foster care facilities by

agency/district.

None

Total number of foster care facilities by agency/district

Data Definition
The name of the agency to which the workers is

currently “in” assigned.

Code assigned to the agency by New York State

Total number of foster homes within the
responsibility of the agency

Name of the office to which the worker is assigned.

Unique identification number for the unit within a
district that is responsible for the foster homes

Name of the worker responsible for the foster home

Unique identification number assigned to the foster
home in the Connections system

Name by which the foster home is known

Name of individual who is a member of the home

Identifies the principal and collateral relationships in
the foster home

Describe the relationship of the home member

Indicates the setting of the resource

Status of the Foster Home

Date on which a fingerprint card for the home
member was sent for a criminal background check

Date on which the results of the criminal
background check were received

Sample Values
New Alternatives for Children

700°

56

006

SMITH JOHN E
13456

Smith, Clara
Smith, Jill

Principal
Collateral

Foster Parent
Daughter/Son
Grandchild

Foster Home

Congregate Home

Accepted-Active

Emergency

1/01/2001

3/31/2001
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Data Field

Medical Exam
Date

Cert Date

Authorized to
Date

Data Definition
Date on which the home member received a
medical examination.

Date on which the foster home was last authorized.

Date on which the foster home’s certification will
expire.

Sample Values

2/28/2003
2/28/2004
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Appendix B4:

Closed Facility Report

Report Title:
Report Purpose:

Report Prompts:

Totals:

Data:

Data Field

Facilities Closed
During the Three
Months Prior To

Worker Agency
ID

Agency Name

Total Closed
Facilities

Office
Unit

Worker Name

Resource ID

Home Name

Setting

Home Status

Certification
Date

Recert Date

Closure Reason

Closed Facility Report

Provides information on facilities, which closed within three months of the last

data refresh date.

None

Total number of facilities, which closed within the three months prior to the last

data refresh date.

Data Definition
The date of the last data refresh.

The agency of the office to which the worker is ‘in’
assigned.

Name of the agency that owns the resource.

Total number of homes whose certifications will
become overdue by the date entered by the user

Name of the office to which the agency is assigned.

Code identifying the unit in which the worker is
currently active.

First and last names of the worker assigned to the
resource.

The Connections identification number for the
foster home.

Name of the foster home.
Describes the type of setting for the foster home
(i.e., relative, resource, congregate)

Current status of the foster home

The date on which the foster home was last
authorized

Date on which the home needs to be recertified.

Reason the home was closed.

Sample Values
9/30/01

A03

Chautaugua County DSS
6

Chautauqua Office Bldg
013

Smith, John E
13456789

Davis, Lynn
Foster Home
Congregate Home
Accepted-Active
Emergency

8/6/00

8/6/01

OCFS Data Warehouse Reporting
Impromptu Step-by-Step Guide

Page 20-7
rev 08/2004




CCRS Impromptu Reports

Appendix B5:

Admissions to Foster Care Summary Report

Report Title:
Report Purpose:

Report Prompts:

Totals:

Data:

Data Field
District/Agency/
Statewide

Report Period

Admissions to
Foster Care
during Period

Race

Hispanic Origin

Facility Type

Admissions to Foster Care Summary Report

To provide a summary of the number of admissions to foster care (movement

code = M910) by voluntary agency.

Start Date and End Date — for user to specify the time period for which to run the

report.

Total admissions by ethnicity, Hispanic origin, facility type, sex, age range at

admission, goal, and previous care.

Data Definition
Statewide or the name of the agency or district.

The period for which the report is run, specified by
the user in prompt response

Total number of children who have a movement
code of the most recent “M910” with a
corresponding activity date that falls within the
request report time period.

Count of the number of children admitted to foster
care by racial origin, based on present AFCARS
definitions

Count of the number of children admitted to foster
care by whether or not they are of Hispanic origin

Count of the number of children admitted to foster
care by the type of facility to which they were
admitted

SETU I EREIES
Albany

9/1/01 — 9/30/01

4745

White
African-American
Asian

American Indian or Alaskan
Native

Native Hawaiian or Other
Pacific Islander

Other
Unknown
Yes

No

Foster Boarding Home
Approved Relative Home
Congregate Care

Institution

Group Residence

Group Home

Supervised Independent Living
Agency Operated Boarding
Home

Other
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Data Field Data Definition Sample Values
Gender Count of the number of children admitted to foster Male
care by sex Female

Age Range at Count of the number of children admitted to foster 0-2
Admission care by age in years at the date of admission 3-5
6-9
10-13
14 -18
Over 18

Goal Count of the number of children admitted to foster Discharge to Parent/Legal
care by their CPS permanency planning goal Guardian

Discharge to Independent
Living
Discharge to Adoption

Discharge to Adult Residential
Care

Other Goal
No Goal

Admissions Count of the number of children admitted to foster Not previously in care

care by previous admission history Readmitted within 3 th
eadmitted within 3 months

Readmitted within 4-12
months

Readmitted within 13-24
months

Readmitted within 25 or more
months
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Appendix B6:

Discharges from Foster Care Summary Report

Report Title:
Report Purpose:

Report Prompts:

Totals:

Data:

Data Field

District/Agency/
Statewide

Discharges from Foster Care Summary Report

To provide a summary of the number of children discharged from foster care
(movement code = M990, M999, or M970) by agency

Start Date and End Date — for user to specify the time period for which to run the

report

Discharge Activity Code(s) — for user to specify the type of discharge(s) for which

to run the report.

Total discharges by ethnicity, Hispanic origin, facility type, sex, age range at
discharge, goal, final discharge reason, and time in care at discharge

Data Definition
Statewide or the name of the agency or district.

Sample Values
Albany

Report Period

Period of time for which the report is run, specified
by the user in response to prompts

9/1/01 — 9/30/01

Activity Code

Type of discharge(s) for which the report is run

M970 — Trial Discharge

M990 — Child Placement
Ended

M999 — Child Track Closed

Discharges from
Foster Care
during Period

Total number of children who have been
discharged from foster care during the specified
time period. Note: If a child has more than one
discharge during the period, the child is only

counted once, based on the most recent discharge.

100

Race

Count of the number of children discharged from
foster care by racial origin, based on present
AFCARS definitions

White
African-American
Asian

American Indian or Alaskan
Native

Native Hawaiian or Other
Pacific Islander

Other
Unknown
Hispanic Origin Count of the number of children discharged from Yes
foster care by whether or not they are of Hispanic No

origin
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Data Field
Facility Type

Data Definition

Count of the number of children discharged from

foster care by the type of facility to which they were
admitted

Sample Values
Foster Boarding Home
Approved Relative Home
Congregate Care
Institution
Group Residence
Group Home
Supervised Independent Living
Agency Operated Boarding Home
Other

Gender

Count of the number of children discharged from
foster care by sex

Male
Female

Age Range at
Discharge

Count of the number of children discharged from
foster care by age in years at the date of discharge

0-2
3-5
6-9
10-13
14 -18
Over 18

Goal

Count of the number of children discharged from
foster care by their CPS permanency planning goal

Discharge to Parent/Legal
Guardian

Discharge to Independent
Living

Discharge to Adoption

Discharge to Adult Residential
Care

Other Goal
No Goal

Final Discharge
Reason

Count of the number of children discharged from
foster care by the final discharge reason

Return to Parent
Release to Relative

Release to Own
Responsibility

Release to Primary Resource
Person

Adoption — subsidized
Adoption — not subsidized
Order of Court

Other

Time in Care at
Discharge

Count of the number of children discharged from
foster care by the average number of months they
were in care at the time they were discharged

Average Number of Months
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Appendix B7:

Legal Detail Report
Report Title: Legal Status Detail
Report Purpose: To provide agency workers and managers with details of the legal activities in a
child’s case
Report Prompts: CIN
Totals: None
Data:
Data Field Data Definition Sample Values
District The state assigned district code which identifies the | 66
local social services district currently controlling
input transactions to the child’s case
Office Identifies within a district, the office that has 070
responsibility for the case
Unit Used within a district to identify the unit currently 006
responsible for the case
Worker Used within a district to identify the worker currently | 005
responsible for the case
Child Name The name of the child SMITH JOHN E
Agency Where Unique agency identification number assigned by A43
Placed New York State to the agency responsible for
placing the child
In Care 12 of 22 Current time in care based on ASFA guidelines, 22+
Months expressed in months
ASFA In Care Date on which the child was admitted to foster care | 9/15/01
Date
CIN Unique identifying number for an individual in the BX44990J
CCRS system
Case Name The name by which the child’s case is currently SMITH DAINA
identified (usually line 1 name in the CCRS
application)
Case Number The district-assigned case number that uniquely S4934766
identifies the child’s case within the district, or
responsible state agency
Current Legal Current legal status of the child based on legal Abuse/Neglect Proceeding
Status activity
Next Hearing Date on which the next hearing on the case is to be
held
Legal Activity Date on which the activity took place 8/15/01
History: Date
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Data Field Data Definition

Sample Values

Legal Activity The description of the legal event based on Petition Filed
“Reportable Events” in the CCRS system. Anticipated Discharge

Hearing
Additional Dispositions
Revocation
Appeal
Agreement Signed
Unknown

Type of Legal Type of legal event as recorded in the CCRS Transfer of Care & Custody

Activity or system Court Action

Reason .
Court Review
Article 10 — Abuse/Neglect
1055 Court Review
Article 7 — PINS
756 Court Review (PINS)
Article 3—JD
384 — Voluntary surrender for
adoption
384b — Commitment of
guardianship and custody
651b — Refugee Assistance
Program
Violation of Disposition
Other Family Court
Other Court (non-Family)
355.3 Court Review (JD)
1055A (Court Review)

Court or Describes whether the case has been assigned to Court

Disposition the court or for disposition Disposition

Docket # or Docket number assigned to the case by the court

Anticipated or the anticipated discharge date of the case

Discharge Date

or Disposition or

Court

Hearing Date or | The date of the hearing or source of appeal.

Next Hearing

Date or Source
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Appendix B8:

In Care Detail Report

Report Title:
Report Purpose:

In Care Detail Report

To provide agency workers and managers with details of a child’'s movements to

and from foster care facilities

Report Prompts: CIN
Totals: None
Data:
Data Field Data Definition Sample Values
Child Name The name of the child SNYDER CALVIN J
In Care 12 of 22 Length of time child has been in care, according to | 22+
Months ASFA regulations, expressed in months
CiD
District The state-assigned district code which identifies the | 66
local social services district currently controlling the
case
Case Name The name by which the child’s case is currently SNYDER DAINA
identified (usually Line 1 of the CCRS application)
CIN Unique identification number assigned to the child BX44990J
in the CCRS system
Case Number The district-assigned case number which uniquely S4934766
identifies the child’s case within the district
Agency Code for the agency responsible for the case A43
Case Address The street, city, state and zip code of the residential | 41 DELAWARE ST
address for the WMS case WATKINS GLEN NY 12054
Race Code identifying the ethnicity of the child White
African American
Asian
American Indian or Alaskan
Native
Native Hawaiian or Other
Pacific Islander
Other
Unknown
Office Unique identification number of the office within a 070
district that has responsibility for the case
Gender Code identifying the sex of the child M, F
Unit Unique identification number of the unit within a 006
district currently responsible for the case
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Data Field
Legal Status

Data Definition

Current legal status of child based on legal activity.

Note: If there are multiple legal codes on the same
day, only one will be displayed, prioritized in the
order shown.

Sample Values
Abuse/Neglect Proceeding

PINS/JD Proceeding
Adoption Proceeding
Foster Care Review

Proceeding
Other
Unknown
DOB Date on which the child was born 12/19/83
Current Age Child’s current age based on the date of birth 17
Number of 3
Siblings 5
In Case Number of child’s siblings in the CCRS case
In Placement Number of the child’s siblings in the CCRS case
who are currently placed in foster care
Worker Unique identification number of the worker currently | 006

responsible for the case

Current Goal

Permanency planning goal from the latest service
assessment.

Discharge to Parent/Legal
Guardian

Discharge to Independent
Living
Discharge to Adoption

Discharge to Adult Residential
Care

Other Goal
No Goal

Case Manager

This field is populated with the known worker since
CCRS does not collect Case Manager information.

Foster Care
Admission Date

Date of the most recent activity that qualifies the
child for inclusion in this report

Agency
Admission Date

Date on which the agency accepted the child’s
case

Facility
Admission Date

Date of the child’s admission to the facility
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Data Field
Child’s
Placements:
Movement Code
Effective Date
Transaction Date

Facility Type

Facility Name/
Address

Family Contact/
Phone

Data Definition

The 4-character CDRS activity code
The date the movement took place
The date on which the movement was entered

The type of facility as defined by who licensed the
facility the number of clients it can accommodate,
and the type of service it provides.

The name and address of the facility in which the
child was placed.

Name of the individual acting as contact for the
facility. Telephone number of the facility

Sample Values

M910
1/1/2001
1/1/2001

Institution, Group Residence,
Group Home, SILP, Agency
Operated Boarding Home,
etc.

Four Winds

30 Crescent Ave

Saratoga Springs, NY 14606-
4844

Nancy Smith 5187823681

Child’s
Family/Case
Members:
Name

CIN

DOB

Line Number

Relationship

Current Address

Contains details of the child’s family members.

Full name of family member

CCRS identification number of the family member
Date of birth of family member

CCRS application line number of family member
Relationship of family member to the child

Address for the family member

JAMES PATTERSON
S0O1345X

1
Biological Father

13 Elm Street, Amstead, NY

Current CCRS CCRS child status of in care or absent Absent, In 24 Hour Care
Status

CCRS Data As Last date on which CCRS data was updated 9/31/01

Date of This Current date 10/13/01

Report
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Appendix B9:

In Care Summary Report

Report Title:
Report Purpose:

Report Prompts:

In Care Summary Report

To provide agency workers and managers with a summary of all placements for

a specified month and year.

Month/Year

Totals: Total number of children placed by Ethnicity, Hispanic Origin, Status, Facility
Type, Sex, Age Range, Goal, Time in Care, and ASFA Time in Care

Data:

Data Field Data Definition Sample Values
Year-Month Year and month for which the report was requested | 2001-08

(Prompt)

District/Agency/ | Statewide or the name of the agency or district. Albany
Statewide
Total Number of | Total number of children whose status is 04 (“in 4- | 80
Children in hour care”) or 06 (“absent”) for the period of time
Foster Care requested
Race Total number of children in foster care by racial White

origin

African American
Asian

American Indian or Alaskan
Native

Native Hawaiian or Other
Pacific Islander

Other
Unknown
Hispanic Origin Total number of children in foster care by whether Yes
or not they are of Hispanic Origin No

Status

Total number of children in foster care by their
status

In 4-Hour Care
In Absence Status

Facility Type

Total number of children in foster care by the type
of facility in which they are placed

Foster Boarding Home
Approved Relative Home
Congregate Care

Institution

Group Residence

Group Home

Supervised Independent Living
Agency Operated Boarding
Other

Gender

Total number of children in foster care by their sex

Male
Female
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Data Field

Data Definition

Sample Values

Age Range Total number of children in foster care by theirage | 0-2
in years 3-5
6-9
10-13
14 - 17
18 +
Goal Total number of children in foster care by their Discharge to Parents/Legal

permanency planning goal

Guardians

Discharge to Independent
Living

Discharge to Adoption

Discharge to Adult Residential
Care

Other Goal
No Goal

Time in Care

Average number of months the children reported
on have been in care

40

ASFA Time in
Care

Total number of children in foster care by the time
they have been in care according to ASFA
guidelines

Children in Care at Least 12
of 22 months

Children in Care Less Than
12 of 22 months

CCRS Data As The latest date on which CCRS data was updated 9/15/01

Of

Date of This Current Date 10/13/01

Report
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CFSR Program Improvement Plan Reports

Appendix B10:

AFCARS First-Time-Entry Summary Data

Report Title:
Report Purpose:

Report Prompts:
Totals:

Additional Info:

Data Item
Number of
children entering
care for the first
time in cohort
group (%= 1st
time entry of all
entering within
first 6 months)

AFCARS First-Time-Entry Summary Data

Provides districts with the capacity to review the cases that are part of the
AFCARS data submission, individually and from a systemic viewpoint. The
data items are pieces of information that link directly to the CFSR as well as to

issues that impact child welfare policy and practice.

District

None

From any text with Aqua colored shading, you may ‘Drill Through’ to a
corresponding child specific list by selecting the desired prompt values for the
Report Year and the related category such as placement type, permanency
goals, etc. The detailed report will contain key information for each child
including Office, Unit, Worker, Case Name, CIN, Child Name, and Agency Where
Placed.

Data Definition

# of children and % of children for Federal fiscal
years 1999, 2000, 2001

Sample Values

Most Recent
Placement Types

# of children and % of children for Federal fiscal
years 1999, 2000, 2001

Most Recent

# of children and % of children for Federal fiscal

Permanency years 1999, 2000, 2001

Goals

Number of # of children and % of children for Federal fiscal
Placement years 1999, 2000, 2001

Settings in

Current Episode

Reason for # of children and % of children for Federal fiscal
Discharge years 1999, 2000, 2001

Median Length
of Stay in Foster
Care

Represented in median months for Federal fiscal
years 1999, 2000, 2001
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Appendix B11:

AFCARS Point-In-Time Summary Data

Report Title:
Report Purpose:

Report Prompts:
Totals:

Additional Info:

Data Iltem
Foster Care
Population Flow

AFCARS Point-In-Time Summary Data

Provides districts with the capacity to review the cases that are part of the
AFCARS data submission, individually and from a systemic viewpoint. The
data items are pieces of information that link directly to the CFSR as well as to
issues that impact child welfare policy and practice.

District

None

From any text with Aqua colored shading, you may ‘Drill Through’ to a
corresponding child specific list by selecting the desired prompt values for the
Report Year and the related category such as placement type, permanency
goals, etc. The detailed report will contain key information for each child
including Office, Unit, Worker, Case Name, CIN, Child Name, and Agency Where

Placed.

Data Definition
Children in foster care on first day of year
(10/1/YY): # of children for Federal fiscal years
1999, 2000, 2001

Sample Values

Admissions During Year: # of children for Federal
fiscal years 1999, 2000, 2001

Discharges During Year: # of children for Federal
fiscal years 1999, 2000, 2001

Children in care on last of year (9/30/YY): # of
children for Federal fiscal years 1999, 2000, 2001

Placement Types
for Children in
Care

# of children and % of children for Federal fiscal
years 1999, 2000, 2001

Permanency
Goals for
Children in Care

# of children and % of children for Federal fiscal
years 1999, 2000, 2001

Number of # of children and % of children for Federal fiscal
Placement years 1999, 2000, 2001

Settings in

Current

Placement

Number of # of children and % of children for Federal fiscal
Removal years 1999, 2000, 2001

Episodes for
Children in Care
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Data Item
Number of
Children in care
17 of the most
recent 22
months

Data Definition

# of children and % of children for Federal fiscal
years 1999, 2000, 2001

Sample Values

Median Length
of Stay in Foster
Care

Represented in median months for Federal fiscal
years 1999, 2000, 2001

Length of Time

to Achieve Perm.

Goal

# of children and % of children for Federal fiscal
years 1999, 2000, 2001

OCFS Data Warehouse Reporting
Impromptu Step-by-Step Guide

Page 20-21
rev 08/2004




Appendix B12:

Discharge to Adoption Summary

Report Title:
Report Purpose:

Report Prompts:

Totals:

Additional Info:

Discharge to Adoption Summary

This report identifies the Length of Time to Adoption indicator defined by ACF’s
Children’s Bureau. This report is intended to help identify potential systemic
factors contributing to failure in providing safety and permanency to children in

Ccare.

None

State totals for: Children Discharged to Adoption More than 2 Years after
Removal, Children Discharged to Adoption within 2 Years of Removal, Children

Discharged to Adoption, and Rate.

Information is available by year in separate cubes.

You may ‘Drill Through'’ to a corresponding child specific list(s).

Data Item Data Definition Sample Values
Date Date of Report 04/09/2003
District Code The state assigned district code which identifies the | 099
local social services district currently controlling
input transactions to the child’s case.
District Name The local social services district currently Hudson
controlling input transactions to the child’s case.
Children This population is a unique count of children whose | 30
Discharged to adoption occurred more than two years after
Adoption more removal.
than 2 Yrs after
Removal
Children This population is a unique count of children whose | 9
Discharged to adoption occurred within two years of removal.
Adoption within
2 Yrs of Removal
Children The universe (or base population) is a count of 39
Discharged to unique (distinct) children who were adopted during
Adoption a federal fiscal year:
Children Discharged to Adoption more than 2 Yrs
After Removal
Plus
Children Discharged to Adoption within 2 Yrs of
Removal
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Data Item
Rate

Data Definition
% value of

Children Discharged to Adoption within 2 Yrs Of
Removal

Divided by
Children Discharged to Adoption

23.1

Sample Values
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Appendix B13:

Maltreatment in Foster Care Summary

Report Title:
Report Purpose:

Report Prompts:
Totals:

Additional Info:

Maltreatment in Foster Care Summary

This series of Incidence of Child Abuse and/or Neglect in Foster Care reports is
intended to help identify potential systemic factors contributing to the
maltreatment of these children by looking at the children and perpetrators in

these reports.

None

State totals for: Children with Incident, Children in Foster Care, and Rate.

Information is available by year in separate cubes.

You may ‘Drill Through’ to a corresponding child specific list(s).

Data Item Data Definition Sample Values
Date Date of Report 04/09/2003
County Code The state assigned district code which identifies the | 099
local social services district currently controlling
input transactions to the child’s case.
County Name The local social services district currently Hudson
controlling input transactions to the child’s case.
No. Children with | A unique count of children with substantiated 5
incident allegations in an indicated report for the year with
an intake start date between January and
September whose perpetrator was a foster parent
or residential facility staff.
No. Children in The universe (or base population) is a count of 835
Foster Care unique (distinct) children in foster care from
January to September taken from the Adoption and
Foster Care Analysis and Reporting System
(AFCARS) FFY submission.
Rate % value of .60
No. Children with incident
Divided by
No. Children in Foster Care
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Appendix B14:

Recurrence by District

Report Title:
Report Purpose:

Report Prompts:

Totals:

Additional Info:

Recurrence by District

This series of Recurrence Reports is intended to help identify potential systemic
factors contributing to the recurrence of these children by looking at the
allegations in the multiple reports. Because child level information is also
provided, reviewing other dynamics on a case-by-case basis is possible.

None

State totals for: Children with Recurrence, Children with Indicated Reports, and

Rate.

Information is available by year in separate cubes.

You may ‘Drill Through'’ to a corresponding child specific list(s).

Data Item Data Definition Sample Values
Date Date of Report 04/09/2003
District Code The state assigned district code which identifies the | 099

local social services district currently controlling
input transactions to the child’s case.
District Name The local social services district currently Hudson
controlling input transactions to the child’s case.
Children with A child is counted as an instance of ‘recurrence’ if 26
Recurrence the child has another substantiated allegation in an
indicated report and the date of the second oral
report is within 2 to 183 days of the oral report of
the first report.
Children with The universe (or base population) is a count of 150
Indicated unique (distinct) children with a substantiated
Reports allegation in an indicated report that was reported
in the first six months of the year.
Rate % value of 17.3

Children with Recurrence
Divided by
Children with Indicated Reports
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Appendix B15:

Re-Entry to Foster Care Summary

Report Title:

Report Purpose:

Report Prompts:

Totals:

Additional Info:

Re-Entry to Foster Care Summary

This report identifies the Re-entry to Foster Care indicator defined by ACF’s
Children’s Bureau. This report is intended to help identify potential systemic
factors contributing to failure in providing safety and permanency to children in

Ccare.

None

State totals for: Children re-entering Foster Care with no Previous Placement or
more than 1 Yr after Previous Placement, Children Re-entering Foster Care
within 1 Yr of Discharge from Previous Placement, Children Admitted during the

Year, and Rate.

Information is available by year in separate cubes.

You may ‘Drill Through'’ to a corresponding child specific list(s).

Data Item Data Definition Sample Values
Date Date of Report 04/09/2003
District Code The state assigned district code which identifies the | 099
local social services district currently controlling
input transactions to the child’s case.
District Name The local social services district currently Hudson
controlling input transactions to the child’s case.
Children re- This population is a unique count of children who at | 57
entering Foster the time of admission had no previous placement
Care with no or more than one year of discharge from a
Previous preceding placement.
Placement or
more than 1 Yr
after Previous
Placement
Children Re- This population is a unique count of children who at | 6
entering Foster the time of admission were within one year of
Care within 1 Yr | discharge from a preceding placement.
of Discharge
from Previous
Placement
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Data Item Data Definition Sample Values

Children The universe (or base population) is a count of 63
Admitted during | unique (distinct) children admitted during a federal
the Year fiscal year:

Children Re-entering Foster Care with no Previous
Placement or more than 1 Yr after Previous
Placement

Plus

Children Re-entering Foster Care within 1 Yr of
Discharge from Previous Placement

Rate % value of 9.5

Children Re-entering Foster Care within 1 Yr of
Discharge from Previous Placement

Divided by
Children Admitted during the Year
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Appendix B16:

Reunify with Parent or Caretaker Summary

Report Title:
Report Purpose:

Report Prompts:

Totals:

Additional Info:

Reunify with Parent or Caretaker Summary

This report identifies the Length of Time to Reunification indicator defined by
ACF’s Children’s Bureau. This report is intended to help identify potential
systemic factors contributing to failure in providing safety and permanency to

children in care.

None

State totals for: Children Reunified more than 1 Yr after Removal, Children
Reunified within 1 Yr of Removal, Children Reunified, and Rate.

Information is available by year in separate cubes.

You may ‘Drill Through'’ to a corresponding child specific list(s).

Data Item Data Definition Sample Values
Date Date of Report 04/09/2003
District Id The state assigned district code which identifies the | 099
local social services district currently controlling
input transactions to the child’s case.
District Name The local social services district currently Hudson
controlling input transactions to the child’s case.
Children This population is a unique count of children whose | 79
Reunified more reunification occurred more than one year after
than 1 Yr after removal.
Removal
Children This population is a unique count of children whose | 231
Reunified within | reunification occurred within one year of removal.
1 Yr of Removal
Children The universe (or base population) is a count of 310
Reunified unique (distinct) children who left foster care during
a federal fiscal year because they were reunified
with their parents:
Children Reunified more than 1 Yr. After Removal
Plus
Children Reunified within 1 Yr of Removal
Rate % value of 74.5
Children Reunified within 1 Yr. Of Removal
Divided by
Children Reunified
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Appendix B17:

Six National Indicators

Report Title:
Report Purpose:

Report Prompts:
Totals:

Additional Info:

Data Item
Safety Indicators

Six National Indicators

This report identifies the national indicators defined by ACF’s Children’s Bureau.
This report is intended to help identify potential systemic factors contributing to

failure in providing safety and permanency to children in care.

None

None

Information is available by year in separate cubes.

From the main report, you may ‘Drill Through’ to a report detailing the numbers
from each District. You may ‘Drill Through’ to a corresponding child specific

list(s).

Data Definition
The recurrence of maltreatment data rate is
derived from our NCANDS submission. The
following definition is used by the Children’s Bureau
for recurrence. The universe (or base population) is
a count of unique (distinct) children with a
substantiated allegation in an indicated report that
was reported in the first six months of the year.
From that population a child is counted as an
instance of ‘recurrence’ if the child has another
substantiated allegation in an indicated report and
the date of the second oral report is within 2 to 183
days of the oral report of the first report. Success is
considered any rate below the National Standard of
6.1%.

Sample Values

The incidence of child abuse and/or neglect in
foster care rate is derived from our NCANDS
submission. The following definition is used by the
Children’s Bureau for incidence of child abuse
and/or neglect in foster care. The universe (or
base population) is a count of unique (distinct)
children in foster care from January to September
taken from the Adoption and Foster Care Analysis
and Reporting System (AFCARS) FFY submission.
The numerator for this population is a unique count
of children with substantiated allegations in an
indicated report for the year with an intake start
date between January and September whose
perpetrator was a foster parent or residential facility
staff. Success is considered any rate below the
National Standard of 0.57%.
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Data Item

Permanency
Indicators

Data Definition

The Length of time to reunification with parents

rate is derived from our AFCARS submission. The
following definition is used by the Children’s Bureau
for length of time to reunification with parents. The
universe (or base population) is a count of unique
(distinct) children who left foster care during a
federal fiscal year because they were reunified with
their parents. The numerator for this population is a
unigue count of children whose reunification
occurred within one year of removal. Success is
considered any rate above the National Standard of
76.2%.

Sample Values

The Length of time to adoption rate is derived
from our AFCARS submission. The following
definition is used by the Children’s Bureau for
length of time to adoption: The universe (or base
population) is a count of unique (distinct) children
who were adopted during a federal fiscal year. The
numerator for this population is a unique count of
children whose adoption occurred within two years
of removal. Success is considered any rate above
the National Standard of 32%.

The Stability of Placement rate is derived from
our AFCARS submission. The following definition is
used by the Children’s Bureau for stability of
placement: The universe (or base population) is a
count of unique (distinct) children served during the
period and who on the last day had been in care
less than one year. The numerator for this
population is a unique count of children who had
two or fewer placements during that period.
Success is considered any rate above the National
Standard of 86.7%.

The Re-entry to Foster Care rate is derived from
our AFCARS submission. The following definition is
used by the Children’s Bureau for re-entry to foster
care: The universe (or base population) is a count
of unique (distinct) children admitted during a
federal fiscal year. The numerator for this
population is a unique count of children who at the
time of admission were within one year of
discharge from a preceding placement. Success is
considered any rate below the National Standard of
8.6%.
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Appendix B18:

Two or Fewer Placement Settings Summary

Report Title:
Report Purpose:

Report Prompts:

Totals:

Additional Info:

Two or Fewer Placement Settings Summary

This report identifies the Stability of Placement indicator defined by ACF’s
Children’s Bureau. This report is intended to help identify potential systemic
factors contributing to failure in providing safety and permanency to children in

Ccare.

None

State totals for: Children with More Than 2 Placement Settings and In Care Less
Than 1 Yr, Children with 2 or Fewer Placement Settings and In Care Less Than 1
Yr, Children in Foster Care Less Than 1 Yr, and Rate.

Information is available by year in separate cubes.

You may ‘Drill Through'’ to a corresponding child specific list(s).

Data Item Data Definition Sample Values
Date Date of Report 04/09/2003
District Code The state assigned district code which identifies the | 099

local social services district currently controlling
input transactions to the child’s case.
District Name The local social services district currently Hudson
controlling input transactions to the child’s case.
Children with This population is a unique count of children who 13
More Than 2 had more than two placements settings during the
Placement period.
Settings and In
Care Less Than
1Yr
Children with 2 This population is a unique count of children who 476
or Fewer had two or fewer placements during the period.
Placement
Settings and In
Care Less Than
1Yr
Children in The universe (or base population) is a count of 489
Foster Care Less | unique (distinct) children served during the period
Than1 Yr and who on the last day had been in care less than

one year:

Children with More Than 2 Placement Settings and
In care Less Than 1 Yr

Plus

Children with 2 or Fewer Placement Settings and In
Care Less Than 1 Year
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Data Item Data Definition Sample Values

Rate % value of 97.3

Children with 2 or Fewer Placement Settings and In

Care Less Than 1 Yr

Divided by

Children in Foster Care Less Than 1 Yr
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Security Reports

Appendix B19:

Assignee/Designee Report

Report Title:

Report Purpose:

Assignee/Designee Report

Allows a security coordinator to be able to track which agency workers are

assignees or designees of another worker.

Report Prompts: Agency Code
Totals: None
Data Item Data Definition Sample Values
Date of this Current Date 04/09/2003
Report
Data As Of Date of Latest OCFS Data Warehouse Update 04/02/2003

Agency Name

Name of Agency reporting

Hudson County DSS

Agency Code Code of Agency reporting A90

Staff Name Workers’ names as they appear in CONNECTIONS | Doe, John
Unit The unit code to which the worker is in assigned 063
Assignee The names of the worker’s designees Fuss, Katie
Unit The unit code of the worker’s designees 008

Date Expires The date that each assignment expires 03/15/2011

Designee

The names of the worker’s assignees

McCord, Murphy

Unit

The unit code of the worker’s assignees

009

Date Expires

The date that each designee’s assignment expires

10/09/2004
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Appendix B20:

Business Function Report

Report Title:

Report Purpose:

Report Prompts:

Totals:

Business Function Report

Allows a security coordinator to track which agency staff have a particular

business function.

Agency Code
Business Function

None

Data Item Data Definition Sample Values
Date of this Current Date 04/09/2003
Report
Data As Of Date of Latest OCFS Data Warehouse Update 04/02/2003

Agency Name

Name of Agency reporting

Hudson County DSS

Agency Code Code of Agency reporting A90

Office Type Type of office of report District

Business The business function in question ACCESS ALL DIST

Function

Site Specific Site for report 3HO

Staff Name Workers’ names as they appear in CONNECTIONS | Doe, John

Unit The unit code to which the worker is in assigned 063

Designee The names of the worker’s designees Fuss, Katie

Unit The unit code for the worker’s designees 009
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Appendix B21:

Staff Security Report

Report Title:
Report Purpose:

Report Prompts:

Totals:

Staff Security Report

Allows a security coordinator to track which agency staff is in CONNECTIONS,
what business functions each staff member has, which staff is a Unit Approver,
whether a staff person is an Assignee or Designee, and whether cases may be

assigned to a staff member.
Agency Code

None

Data Item Data Definition Sample Values
Date of this Current Date 04/08/2003
Report
Data As Of Date of Latest OCFS Data Warehouse Update 04/02/2003

Agency Name

Name and code of Agency reporting

Hudson County DSS A90

Site Specific Site for report 3HO
Unit The unit code to which the worker is in assigned 063
Name Workers’ names as they appear in CONNECTIONS | Doe, John
NT Logon Worker’s logon ID assigned through WEBSTAR XX2222
Unit Approver Ye_??or No — Is the worker a Unit Approver for any No

unit’
Staff Role The role of the worker Supervisor
Business All business functions assigned to the worker CASE/PERS SRCH
Functions
Assignee or Yes or No — Is the worker an assignee or designee | No
Designee for anyone else
Case Assignable | Yes or No — Can cases be assigned to the worker? | Yes
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Appendix B22:

Unit Approver Report

Report Title:
Report Purpose:

Report Prompts:

Totals:

Data Iltem

Unit Approver Report

Allows a security coordinator to be able to easily see who is the Unit Approver for

any unit in his or her agency.
Agency Code

None

Data Definition

Sample Values

Date of this Current Date 04/09/2003
Report
Data As Of Date of Latest OCFS Data Warehouse Update 04/02/2003

Agency Name

Name of Agency reporting

Hudson County DSS

Agency Code Code of Agency reporting A90
Staff Name Worker’'s name as it appears in CONNECTIONS Doe, John
Approver of Unit | The unit codes of units for which the worker is the SD
Unit Approver
In/Out Assigned | The type of assignment to the unit (In/Out) Out
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Appendix B23:
Consolidated Investigations

Report Title: Consolidated Investigations Summary Report

Report Purpose: To provide the number of consolidated CPS investigations for a particular month
and year.

Report Prompts: Month/Year

Totals: None

Additional Info: From any text with Aqua colored shading, you may ‘Drill Through’ to a
corresponding consolidated investigation detail list. The detailed report will
contain key information for each consolidated investigation including District,

Office, and Report ID for both the original and duplicate investigation.

Data Item
(Consolidated

Investigation
Summary Report)
Data As of Date

Data Definition

Date of the latest refresh of the OCFS Data
Warehouse.

Sample Values
6/17/04

Report Date

Date the report was run.

6/21/04

District of
Consolidated
Investigation

The agency responsible for consolidating the
duplicate investigation.

New York City

Office of Consolidated
Investigation

The office responsible for consolidating the
duplicate investigation.

Manhattan Field Office

Total Consolidated The total number of duplicate investigations 7
Investigations that were closed and consolidated into an

open, ongoing investigation.
Day“X” The number of duplicate investigations that 3

took “X” day(s) from the duplicate
investigation’s intake start date to the
consolidation approval date. “Day 7 and up”
refers to consolidations that took 7 or more
days to complete between the intake start
date and the consolidation approval date.
[Note: Although consolidations must be
processed by the caseworker within 7 days, it
is possible for the supervisor’s approval to
come after the 7-day consolidation period.]
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Data Item
(Consolidated

Investigation

Data Definition

Sample Values

Detail Report)

Data As of Date Date of the latest refresh of the OCFS Data 6/17/04
Warehouse.

Report Date Date the report was run. 6/21/04

District of The name of the agency that handled the New York City

Consolidated
Investigation

duplicate investigation.

Office of Consolidated
Investigation

The name of the office that handled the
duplicate investigation.

Manhattan Field Office

Case ID The Case ID, which is the same for both the 12345678
duplicate and original investigations.
ID of Consolidated The Report ID for the duplicate investigation. 98765432
Investigation This report has been consolidated and is now
part of the original investigation.
ID of Original The Report ID for the original investigation. 23456789
Investigation This report remains and will continue to the
investigation stage and to determination.
District of Original The name of the agency that handled the New York City

Investigation

original investigation.

Office of Original
Investigation

The name of the office that handled the
original investigation.

Manhattan Field Office
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Appendix B24:

Admission to Discharge Summary Report

Report Title:

Report Purpose:

Report Prompts:
Totals:

Additional Info:

Data Item
Report Date

Adoption Cohorts Summary: Admission to Discharge

To detail the length of time necessary for children on an adoption track to move
between admission and discharge to adoption.

District Name
None

For children to be included in any of these reports they must be considered
‘eligible’ for adoption, or ‘in the adoption track’ by virtue of having a current goal
of adoption OR they were actually discharged to adoption. If neither of these
conditions exists, the children are dropped from the population to be counted for
these reports. This report is comprised of three parts:

Summary Report Users are prompted to select a county. The length of time in
months within which a discharge to adoption was achieved is displayed in
columns broken into six-month periods ranging from 6 months or less to over 60
months. By year (1995-2001), the report identifies the total number of children
who have been discharged to adoption and a percent, which represents the
percentage of those children as compared to the total number of children eligible
for discharge to adoption for that year. The number and percent are cumulative
counts of children who have been discharged to adoption.

From the Summary Report, users will be able to drill down into the admission or
incare table by double-clicking on the highlighted cohort name above the table
(“Admission” or "Incare”). The user will then be prompted for a starting year that
will return the Cohort Trend Report.

Cohort Trend Report This report displays either the admission or in-care cohort
from the Summary Report and a graphic representation of the data for the
selected years.

The third and final report, the Child Detail List, is accessed by drilling through
on the admission (or incare) year, then choosing length of time (LOT) in months
from the selection list. This detailed report displays key pieces of information for
the children discharged to adoption, cohort and length of time to achieve the
discharge to adoption. This list will be sorted by time to achieve the milestone
and will include variables such as office/unit/worker, child specific demographic
items, milestone dates and descriptions. Security is controlled based on user
class. Districts can only see the children within their own district. Voluntary
agencies will not see any children on the child specific list.

Data Definition Sample Values
Current Date 2/10/04

CCRS Data As Of

Date of latest data update. Data is refreshed December 2003
every 6 months.

District Name

The local social services district currently with | Hudson
legal responsibility for the child.

Cohort: Admission

Children who were admitted to foster care 385
during a designated period of time.
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Data Item Data Definition Sample Values

Number Admitted Number of children who were admitted into 56
foster care during the indicated year.

Cohort: Incare Children who were in foster care at a 598
designated point in time.

Number in Care Number of children in foster care of as 222
January 1st of the indicated year.

Adoption Track Number of children with a current goal of 56
adoption or who were discharged to adoption.

Number of Children Cumulative number of children who achieved | 37
both admission and discharge to adoption
within the specified number of months.

Percent Within Cumulative percentage of children who 73%
achieved both admission and discharge to
adoption as a percentage of all children in the
adoption track.
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Appendix B25:

Adoption Cohort Summary Report

Report Title:

Report Purpose:

Report Prompts:
Totals:

Additional Info:

Adoption Cohorts Summary: Goal of Adoption Set
Adoption Cohorts Summary: Freed

Adoption Cohorts Summary: Placed

Adoption Cohorts Summary: Discharged to Adoption

To detail the length of time necessary for children on an adoption track to move
between the major adoption milestones:

Admission > Goal Set

Goal Set > Freed

Freed > Placed

Placed - Discharged to Adoption

District Name, Milestone
None

For children to be included in any of these reports they must be considered
‘eligible’ for adoption, or ‘in the adoption track’ by virtue of having a current goal
of adoption OR they were actually discharged to adoption. If neither of these
conditions exists, the children are dropped from the population to be counted for
these reports. This report is comprised of three parts:

Summary Report Users are prompted to select both a county and milestone.
The length of time in months within which a milestone was achieved is displayed
in columns broken into six-month periods ranging from 6 months or less to over
60 months. By year (1995-2001), the report identifies the total number of children
who have achieved that specific event and a percent, which represents the
percentage of those children as compared to the total number of children eligible
for a milestone for that year. The number and percent are cumulative counts of
children who have achieved the particular event or milestone.

From the Summary Report, users will be able to drill down into the admission or
incare table by double-clicking on the highlighted cohort name above the table
(“Admission” or "Incare”). The user will then be prompted for a starting year that
will return the Cohort Trend Report.

Cohort Trend Report This report displays either the admission or incare cohort
from the Summary Report and a graphic representation of the data for the
selected years.

The third and final report, the Child Detail List, is accessed by drilling through
on the admission (or incare) year, then choosing length of time (LOT) in months
from the selection list. This detailed report displays key pieces of information for
the children in that milestone, cohort and length of time to achieve milestone.
This list will be sorted by time to achieve the milestone and will include variables
such as office/unit/worker, child specific demographic items, milestone dates and
descriptions. Security is controlled based on user class. Districts can only see
the children within their own district. Voluntary agencies will not see any children
on the child specific list.

Data Item Data Definition Sample Values
Report Date Current Date 2/10/04
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Data Item Data Definition Sample Values

CCRS Data As Of Date of latest data update. Data is refreshed December 2003
every 6 months.

District Name The local social services district currently with | Hudson
legal responsibility for the child.

Cohort: Admission Children who were admitted to foster care 385
during a designated period of time.

Number Admitted Number of children who were admitted into 56
foster care during the indicated year.

Cohort: Incare Children who were in foster care at a 598
designated point in time.

Number in Care Number of children in foster care of as 222
January 1st of the indicated year.

Milestone Count for

Admission to Goal of | Number of children with a current goal of 56

Adoption Set Report adoption or who were discharged to adoption.

Goal Set to Freed Number of children who have a Goal Set to 45

Report Adoption.

Freed to Placed Number of children who are Freed for 183

Report Adoption

Placed to Discharged | Number of children who are in an Adoption

to Adoption Report Placement. 51

Number of Children Cumulative number of children who achieved | 37
both milestones within the specified number of
months.

Percent Within Cumulative percentage of children who 73%
achieved both milestones as a percentage of
all children in the milestone count.
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3-D Bar Display

ASCII

Additional Information

Associating

Calculated Column

Calculation

Catalog

Category

CCRS

Clustered Bar Display

Cognos

Appendix C:

OCFS Data Warehouse Reporting

Glossary

A graph that shows relationships between two or more variables. Use to
analyze large quantities of data that are difficult to interpret otherwise.

ASCII stands for American Standard Code for Information Interchange. This is
the code that makes it possible for just about every computer to understand
the letter “A” (and all the other letters) as a letter “A”. The ASCII text file,
although simple and limited, is understood by virtually all computers.

Information that does not constitute a report of abuse/maltreatment but
contains information pertinent to an open/active SCR case.

Linking a data item to a grouped data item to suppress duplicate data values.
There should be a one-to-one relationship between the grouped item and the
item being associated to it.

A column whose values are calculated from other columns, calculated
columns, functions, and constants to derive new data for a model.

A category created by applying an operator to one or more categories. See
also calculated category.

A file that contains all of the information necessary for Impromptu to retrieve
data from a database. The catalog does not contain all of the data, but only a
user view of the database.

Items that match a specific description or classification. Categories can be
different levels of information within a dimension. Any categories can be
grouped into more general categories. For example, a set of dates could be
grouped into a month, and months into quarter, and quarters into years.

Child Care Review Service

A graph that groups related information, compares summaries, and compares
categories.

Cognos is a software development company based in Canada. It is widely
acknowledged to be the leading provider of business intelligence applications.
Business intelligence is the term given to a category of applications and
technologies for gathering, storing, sharing, analyzing, reporting and providing
access to data to help users make better decisions.
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Cognos Common Logon

Column

Connections

Correlation Display

Crosstab Display

Cubes

Data Mart

Data Warehouse

Delimited-Field Text File

Dimension

Dimension Line

Dimension Menu

Dimension Viewer

Cognos Common Logon maintains authentication data so you can open
multiple secure data sources using different Cognos products. This means that
you only have to provide a user ID and password once, even when you
navigate from one Cognos application to another.

In reports, a category that shows related information in a vertical list.
New York State’s child welfare information system.

A graph that shows the values of two measure that are being compared. Bars
represent one measure and a line represents the other. You must have at least
two measures to use a correlation display.

A chart that shows data in tabular format.

A multidimensional representation of data. Cubes contain information
organized into dimensions to provide faster retrieval and drill down to lower-
level categories in reports.

Data marts are subsets of the larger data warehouse. They are smaller and
focused on a particular subject.

A data warehouse is a collection of data retrieved from production systems.
The data from diverse databases is combined and stored separately. The data
warehouse organizes and stores the data needed for informational and
analytical processing over a historical time perspective.

A file containing text data, where the fields in each record are separated
(delimited) by a character, such as a comma or a tab.

A broad grouping of descriptive data about a major aspect of an organization,
such as dates, geography, ethnicity, etc. Each dimension includes different
levels of categories in one or more drill-down paths, and an optional set of
special categories.

In PowerPlay for Windows, shows the categories from each dimension used to
filter on data for the current report.

In PowerPlay for Windows, a menu that appears when you select a dimension
folder. You use a dimension menu to filter on specific information. When you
select a category from the menu, the level of the dimension changes and so do
the values in the report.

An organized view of all dimensions, levels and categories in the selected
cube. Use the dimension viewer to add categories as rows, columns, or layers,
create subset definitions, format measures, filter, and define sets of categories.
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Display

Drill

Drill Down/Up

Drill-Through

Filter

Fixed-Field Text File

Functions

Grouping

Horizontal Axis

Impromptu

IAB

Indicated

Initial Report

Join

Key Fields

Label

In PowerPlay for Windows, the type of chart or graph. You can change the
display or add another display to the same report.

See Drill Down/Up or Drill-Through

Focusing a report on a lower level of detail in a particular dimension; i.e.,
looking at child categories.

Accessing more detailed information in another PowerPlay report, PowerCube,
or Impromptu report. Drill-through access is set up to match on some
combination of dimensions, measures, or data items.

Focus a report on a specific value of a data item or dimension.

A file that contains text data aligned in fixed-length columns.

A predefined formula that takes one or more values, performs an operation,
and returns a value.

Grouping data in an Impromptu serves to bring all like data together on the
report.

The X-axis on a display.

Impromptu is a user-friendly data query tool that allows the user easy access
to a database while shielding him/her from technical database terminology,
connections, and structures.

Institutional Abuse cases which are investigated by IAB investigative agencies
(Regional Offices, Office of Mental Health, Office of Mental Retardation
(OMR), or Developmental Delays (OMRDD).

A determination made by local CPS that some credible evidence exists to
support an incident of child abuse and/or maltreatment.

Information that contains a reasonable cause to suspect child abuse and/or
maltreatment that has no open or active case in the SCR.

Defines the relational links between tables in a database so that you can
retrieve information from more than one table at a time.

The data items used to join tables.

The name of a row, column, or layer.
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Layers

MDC File

Measures

Missing Value

Multidimensional Cube File
(-mdc)

Multiline Display

Another dimension, in addition to rows and columns, added to a report.
Reports can contain several layers, but you can look at only one at a time.

A Cognos file that represents a cube. The file may contain the data, or be a
pointer file to a database cube or third-party OLAP source.

Numeric data used as performance indicators. For example, measures can be
number of allegations, number of CPS Reports Indicated, number of children
admitted to foster care, etc.

A value that is not available for a category because of the context, or because
there is no data. Missing values appear in a report as zero, NA (not available),
a blank (nothing in the cell), or missing, depending on how the measure sin the
cube were designed to handle missing values.

See cube or .mdc file.

A graph that reveals and compares trends and cycles that show relationships
between variables. It also shows time series analysis and relationships
between variables.

NCANDS National Child Abuse and Neglect Data System.

Nesting Adding another dimension or dimension level to an existing row or column on a
report to provide a more detailed perspective of the data.

OCFS Office of Children and Family Services

PDF Portable Document Format. A file format developed by Adobe Systems that
captures formatting information from a variety of desktop publishing
applications, making it possible to send formatted documents and have them
appear on the recipient’s monitor or printer as they were intended. To view a
file in PDF format, you need Adobe Acrobat Reader.

Pie Display A graph that shows the relationship between the whole and the parts. For
example, a pie display can show how much of a department’s budget goes to
paper supplies.

PowerPlay PowerPlay is a data analysis tool that utilizes OLAP (On Line Analytical
Processing) technology. It allows users to easily explore data across the
organization.

Prompts Request for information when a report is opened that determines the focus or
scope of the report.
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Query

Ranking

Row

Scatter Display

Simple Bar Display

Single Line Display

Slice and Dice

Sort

Stacked Bar Display

Subsequent Report

Substantiated

A question to a database that defines what information you want from the data
source.

Assigning ordinals to values in a selected row or column of a report, to be used
to sort the values in ascending or descending order.

A category that shows related information in a horizontal list.

A graph that compares two different measures. You must have at least two
measures to use the scatter display effectively.

A graph that shows change over a specific time period, contrasts two or more
variables, and reveals trends and irregularities in a bar format.

A graph that shows change over a specific time period, contrasts two or more
variables, and reveals trends and irregularities in a line format.
To change and arrange data when you:

e Choose different categories for your report

e  Drill down or drill up

e Drag dimensions from the dimension line

e Swap rows, columns, or layers

e Filter information

For example, you have a report that shows the number of CPS Reports by
each district at the end of the last quarter. You can slice and dice information
to show CPS Report Determinations over the last two months for each worker.

To arrange values in numerical order, or labels in alphabetical order. You can
sort in ascending or descending order.

A graph or chart that shows relative proportions of parts to the whole and the
relationship between the parts. For example, the days to determination data
can be segmented into indicated and unfounded determinations as stacked
bars.

A report involving either new allegations or a new incident of the same
allegations occurring under an open SCR case number.

A finding by local CPS that credible evidence exists to support an allegation of
child abuse and/or maltreatment.
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Swapping

Unfounded

Unsubstantiated

To exchange the position of categories in a report. You can swap rows and
columns, columns and layers, or rows and layers. The terms rows and
columns change depending on the current display. For a pie display, rows and
columns are called displays and slices.

A determination made by local CPS that no credible evidence has been found
to substantiate the report of child abuse and/or maltreatment.

A finding by local CPS that no credible evidence exists to support an allegation
of child abuse and/or maltreatment.

Variable A symbol representing a value supplied by your computer or by PowerPlay for
Windows. For example, the variable Date represents today’s date. You can
add a report variable such as Date to a report title, header, or footer.

Vertical Axis The Y-axis on a display.

View In PowerPlay for Windows, a way of presenting a report: normal, page layout,
and page width. You can use a combination of views. For example, you can
use normal view for working with the report, and page layout view or page
width view to organize parts of the report. There are two types of views:
dimension views and user class views. See also Display.
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